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COMPUTER APPLICATIONS IN BUSINESS

UNIT I Introduction to SPSS Opening a data file in SPSS — Variable view —
Data view — Entering data into the data editor — Saving the data file— Table
creation — Descriptive statistics: Percentile values, Measures of central
tendency, Measures of dispersion, Distribution — Cronbach’s Alpha test —

Charts and graphs - Editing and copying SPSS output.

UNIT Il Parametric Tests in SPSS Compare means: One-sample t-test,
Independent Samples t-test, Paired-samples t-test and One-way ANOVA,
Two-way ANOVA - Correlation: Bi-variate, Partial and Multiple. Simple

linear regression.

UNIT 111 Non-parametric Tests in SPSS Chi-square test - Mann Whitney’s
test for independent samples — Wilcoxon matched pairs sample test—

Friedman’s test— Wilcoxon signed rank test — Kruskal Wallis test

UNIT IV Introduction to Tally Prime Tally Prime: Introduction — Starting
Tally Prime — Creation of a Company - Selecting company - Shutting a

company - Altering company— Creating Accounting groups and ledgers —
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Vouchers — Practical problems for a new and existing business and not-for
profit organization. Accounting reports: Introduction — Displaying Trial
balance, Profit and Loss Account, Balance sheet, Day book, Purchase
register, Sales register, Cash flow /Funds flow and ratio analysis — Practical

problems.

UNIT V Inventory and GST in Tally Prime Inventory: Introduction to
Inventory Masters — Creation of stock group — Creation of Godown —
Creation of unit of measurement — Creation of stock item — Entering

inventory details in Accounting vouchers — Practical problems. GST:

Introduction — Enabling GST — Defining tax details — Entries in Accounting

vouchers — View invoice report — Practical problems.
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UNIT I Introduction to SPSS Opening a data file in SPSS — Variable view —
Data view — Entering data into the data editor — Saving the data file— Table
creation — Descriptive statistics: Percentile values, Measures of central
tendency, Measures of dispersion, Distribution — Cronbach’s Alpha test —

Charts and graphs - Editing and copying SPSS output.

Introduction to SPSS

SPSS software is used for data analysis using statistical techniques. There

are many statistical packages are available for data analysis Minitab,

STATA, Systat. But SPSS is the most widely used software. SPSS contains
two views. They are two views in the SPSS such as data view and variable
view. Data view is used to store data and variable view is used to define

variables.

VARIABLE VIEW

Variable View contains descriptions of the attributes of each variable in the
data file. In Variable View:

* Rows are variables.

 Columns are attributes of variables.
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You can add or delete variables and modify attributes of variables, including
the following attributes:

* Variable name — this is the field that is used to provide a name for the
variable that is to be used.

« Data type — this field is used to provide the type of the data that is to be
used. It can be numeric, string, date, dollar etc.

» Number of digits or characters — this field is used to specify the length of
the data that is to be entered.

* Number of decimal places — this field is used to specify the number of
decimal places that is needed for a specific variable.

* Descriptive variable and value labels — this field is used to give an

elaborate description of the variable being used in the database.

* User-defined missing values — this field is used to specify how the missing
values are to shown in a data base.

» Column width — this field is used to specify the required size of the
column.

» Measurement level — this is used to specify whether the variable is
nominal, ordinal or a scale.

All of these attributes are saved while saving the data file.
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TYPES OF SCALES

NOMINAL SCALE:

Nominal scale is the system of assigning number symbols to events in order
to label them. Nominal scale provides convenient ways of keeping track of
people objects and events. One cannot do much with the numbers involved;

it indicates no order or distance relationship and has no arithmetic origin.

Example: The assignment of numbers to players in order to identify them.
One cannot usefully average the numbers on the back of a group of foot ball

players and come up with a meaningful value.

ORDINAL SCALE:
Measurements with ordinal scales are ordered in the sense that higher
numbers represent higher values. However, the intervals between the

numbers are not necessarily equal.

For example: on a five-point rating scale measuring attitudes toward gun

control, the difference between a rating of 2 and a rating of 3 may not
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represent the same difference as the difference between a rating of 4 and a
rating of 5. There is no "true" zero point for ordinal scales since the zero
point is chosen arbitrarily. The lowest point on the rating scale in the
example was arbitrarily chosen to be 1. It could just as well have been 0 or -
5.

INTERVAL SCALE:

On interval measurement scales, one unit on the scale represents the same
magnitude on the trait or characteristic being measured across the whole
range of the scale. Interval scales provide more powerful measurement than
ordinal scale for interval scale also incorporates the concept of equality of
interval

For example, a good example of an interval scale is the Fahrenheit scale for

temperature. Equal differences on this scale represent equal differences in

temperature, but a temperature of 30 degrees is not twice as warm as one of
15 degrees

RATIO SCALE:

Ratio scales are like interval scales except they have true zero points. Ratio
scale represents the actual amounts of variables. Measures of physical

dimensions such as height, weight, distance etc are examples. Generally all
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statistical techniques are usable with ratio scale values multiplication and

division can be used with this scale but not with other scales.

VARIABLES
METRIC VARIABLE:
A variable is metric if we can measure the size of the difference between

any two variable values. Age measured in years is metric because the size of

the difference between the ages of two persons can be measured

quantitatively in years. Other examples of metric variables are length of

education measured in years, and income measured in monetary units.

ENTERING DATA

Construct a data base using the following variables for 30 cases
1. Serial Number
2. Gender. Female ( ) Male ( )
3. Please write your age. years
4. Please tick the highest level of education completed.
() School ( ) Diploma () Graduate ( ) Post-graduate ()
Professional
5. Please select your current occupation.
( ) House-wife () Student () Self-Employed () Government Employee

() Private Sector ( ) Unemployed
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6. Tick, in which part of the city you currently reside?
() East () West () North ( ) South

7. Enter your monthly Income Rs.

8. Please write no. of visit per week do you make to shopping mall
9. Please select the type of purchase you like to make at the mall.

() FMCG ( ) Books and CDs ( ) Durables ()
Pharma ( ) Food ( ) Others
10. Please enter the total average amount you spend per week for the purchase retail
items Rs.

11. Please indicate your perception or liking of mall from where you purchase. (1-5)

1- Very Poor 2-Poor 3-Ok 4-Good 5 — Very Good

PROCEDURE:

STEP1: To start SPSS
= Start >16.0 SPSS for
windows.
STEP2: To create a data base
= File >Data
STEP3: Select variable view
Enter specified variables under name

Serial number
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Gender
Age
Education

Occupation

o Mention the type for all the variables as numeric

o Specify the width as required

Make all the decimal values 0

Under the label column mention the full form for all the variables

Under values

= Gender- 1=Female and 2= Male(mention 1 in value box and male

in value label box)

Education- 1=school, 2= diploma, 3= graduate,4= post graduate,5=

professional

Occupation- 1= house wife,2= student,3= self employed,4=

employed in govt,5= employed in pvt,6= un employed

e STEP4: The data editor appears as follows

e Please remember that data editor SPSS data editor works like excel work sheet

=] Lntitled - SPSS Data Editor

File Edit Wiew Data Transform  Analvze Graphs  Utilities  Window Help

=|@|8| &| 0| 1 |k 4] £l BEE el

Mame | Type |Wid1h|Dec:imaIs| Label ‘ Yalues ‘Missing|CnIumn|Align‘ Measure|

lsno |Mumeric |3 0 serial no |None Mone
age Mumeric |2 0 ane Mane Mane
gender |Murmetic |1 0 gender I, omh.. Mare
0
0

educatio/Mumetic |1 education {1, school}... [Mone
occup  [Mumeric |1 occupation |1, house wife| Mone

B8
B8
B8
B8
B

Right |Maminal

Right | Scale

Right |Nominal

Right | Ordinal

Right |Nominal ge 11
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=1 pra - SP55 Data Editor

File Edit ‘iew Data Transform Analyge Graphs  Ukilities  ‘Window Help

=&\ B o] L] =k @ Flr| ElEE %2

10 : ocoup 1

age | gender | edun::atin:l| occup | var
25
26
45
32
51
28
41
52
49
53

ol m| |k —
O@ oo~ o m &= W k=
Mk = = =M W kI —
= MM =Wk =3 m =

—
—_

Ten cases have been entered in the data editor

Colum represents variables and row represents cases. Cases here means respondents

ENTERING MULTIPLE TICKS

When multiple tick is possible for a given question then each and every options show

enter as separate variable

Q: Please tick the items you would normally purchase when you visit a retail outlet.

Fresh fruits and vegetables Bakery

Grocery Dairy
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Cleaning aids Beverages

General merchandise Frozen food

Processed food

For the above question one customer may tick many options. Each and every options

namely Fresh fruits and vegetables, Grocery, Cleaning aids etc should enter separately if

particular option is ticked then the value 1 may be assigned with particular options is

ticked and 0 may be assigned when it not ticked then frequency analysis may be perform.
The frequency analysis will give the following out put

Items frequently purchased by respondents

Iltems Purchase (%) | Not purchase (%)

Fresh fruits and vegetables 70 30

Bakery items

Grocery items

Cleaning aids

Dairy items

General merchandise

Beverages

Frozen food

Processed food

Interpretation for the result
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The above table indicates that 70% of the respondents purchase fresh fruits and
vegetables, 61.5% of the respondents purchase bakery items, 52% of the respondents
purchase grocery items and cleaning aids, 47.5% of the respondents purchase dairy items,
44% of the respondents purchase general merchandise, 42% of the respondents purchase
beverages, 31.5% of the respondents purchase frozen food, 24% of the respondents
purchase processed food. This indicates that high preference is give to fresh fruits and

vegetables and least preference is given to processed food.

ENTERING OF RANKING QUESTIONS

What are the reasons for investing in small savings securities like NSC and PPF, if you

have more than one reason rank them according to order of priority?

a) To save tax b) High return c) Consistent return

d)High safety e) National interest f)Easy to

operate

What are the inconvenience and discomfort do you have for investing in small savings?

And Rank them

a) Long term b) Less awareness c) Low return
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d) Poor service e) Schemes are not attractive f) Inconvenient to

operate

Reason for Investing in small saving securities

The major reasons identified from pilot study for investing small saving securities
are listed in the questionnaire and the investors are asked to rank them based on
priority attached to each reason. Based on the average score the reasons are

ranked.

REASON FOR INVESTING IN SMALL SAVING SECURITIES

S. No | Criteria Mean Value | Rank

1 To Save Tax 5.05 [

High Safety 4.33 I

Consistency of Return | 3.81

High Return 3.63

National Interest 3.63

Easy To Operate 3.58

From the above table it is very clear that people are investing in small saving
securities mainly to save tax and the average score for that reason is 5.05 in the 1

to 6 point scale. The small saving schemes are Government sponsored schemes;
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hence, there is high level of safety which is the next important reason for investing
in small savings. Some college teachers really show national interest and they
prefer small savings schemes because the fund collected from this goes to the

Government to sponsor schemes and to finance deficit budget.

Inconvenience in Small savings schemes

Small savings schemes have long maturity period and the people site that as the

major inconvenience they face in the small savings schemes. Based on the order of

priority assigned to other inconvenience by the investors is given in the table.

INCONVENIENCE IN SMALL SAVINGS SCHEMES

Long Term 3.81 |

Low Return 3.72 1

Schemes are not attractive | 3.45

Poor Service 3.22

Less Awareness 3.20

Inconvenient to operate 2.96

SORT CASE

PURPOSE:
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To sort the file in an order based on a variable. In this case the file car sales are sorted in

an ascending order of the manufacturer.
PROCEDURE:

Open the file car sales
Data—> sort cases

The sort cases dialog box appears

So by
{’a ocdel [model] E)El hanufacturer [manufau:t...|
ﬁ Sales in thouszands [sal... | ﬂ |
ﬁ 4-year resale value [res. .

& Price in thousands [price]
& Fuel efficiency [mpa] Sort Order

(3 Azcending

() Descending

ik _” Paszte || Reset || Cancel || Help

Select the ‘sort by’ variable as manufacturer and sort order as ascending.

Before sorting:

COMPUTER APPLICATIONS IN BUSINESS




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION
Manonmaniam Sundaranar University, Tirunelveli

e EM Wew Do Twslom Gy Gowhe Ulks Adbme Wdow bep
Ha @ o @ik A Ad S0E %9%

3 st o5 veraias

s [T i |
o a1 18225
Toun & Gy am s |
o nem 5@
Accant we s

s s wen  sm

Topcta Tocoma o e

bpunia i ez s

Ford Fangn me e

Ford oo nw s

ot . e

c s

ntge . oo

Py § s

Honta s

Toyms y wss

Chemoit 3 s

Missan Sonn s

Chemoit § 2250

Mitsubizhe M Frerd

Saturn BW 13

sose

Valkgwagen

After sorting:

ar_sales.sav [DataSet1] - SPSS Data Editor,
File Edt View Deta Transform  Analyze Grephs  Ltilies Addons  Window  Help

EHE § b LERF A AL BdE 508

2 | |isible: & of & ariables

‘ manufact model | sales | resale price mpg | |
1 Acura cL 14114 18.225 . 2%
Acura Integra 16.919 16.360 21,500 B[]

Acura L 39384 19.875 28.400 2%
Acura RL 8.588 287258 42,000 2
Audi Ad 20397 222655 23990 27
Audi Al 18.780 235855 33950 2
Audi AR 1.380 39.000 62.000 2
Bhivy 323 19747 26990 %
By 3280 9.231 28675 33.400 24
Bilvy 528i 17627 36.125 38.900 %
Buick Century 91.5681 12.475 21.975 25
Buick Regal 39350 13.740 25300 23
Buick LeSahre 83.257 13.360 27.885 25
Buick Park Avenue 27.851 20.190 31.965 24
Cadillac Catera 11.185 18.225 31010 2
Cadillac Eldorado B.536 287258 39.665 22
Cadillac Deville 63729 225625 39.895 2
Cadillac Seville 15.943 27.100 44,475 2
Cadillac Escalade 14765 46225 15
Chevrolet Iletro 21855 5.160 9235 45
Chevralet Cavalier 145518 9.250 13.260 e
Chesrolet Prizrm 322099 9.125 13.960 33
Chevrolet Ialiby 135.128 1.228 16.535 25
Chevrolet Lumina 24629 10.310 18.880 25
Chevrnlat Imnala 107 995 1R.R90 2 z
ENER| D

Bata View | arae Views |
o [5psS Processorfsready | || | |

TED FOP

The file car sales have been sorted in an ascending order of manufacturer’s name.
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MERGE FILES

PURPOSE:

To Merge the Files with the Same Variables and Different Cases

PROCEDURE:

e Open one of the required data files.

<2i M1.sav [DataSet1] - SPSS Data Editor
File Edit “iew Data Transform Anslyze  Graphs  Utilities Add-ons Window  Help
EHE E 00 EEF A A E4FE 506

|1  name |Rama

|V|s|b\e: 3 of 3 Yariables

Inamel subject | matks | | | |

1 Rama | HR 90.00

2 Mawveen HR 83.00
3 Wijay HR 75.00
4
5

Rahul  HR 78.00
Shan HR 70.00

Dl

e

Data View | ariable Yiew ]

SPSS Processor is resdy ‘ | | | |
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From the menus choose:

Data - Merge Files = Add Cases...

Select the data file to merge with the open data file

& *M2.sav [DataSet2] - SPSS Data Editor
Ble ESF Wew Dwa  Tansform  AnehTe  Geaoh:  ULWbes  Addons  Wndow  Hep

CcHG W o0 LElr A A D65 50

Marme Subject Marks.
n 72m
76.00
740

Merged file:
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& %M1.sav [DataSet1] - SPSS Data Editor (==
Fie Edt Wiew Data Transform Analyze Graphs Uities  Add-ons  Window Help

cHE & o0 LE5F & A SEFE 509

1: name ‘Rama |vws|b\a' 3 0f 3 variables

name subject ‘ marks | | | ‘

Rama |HR 90.00
MNaween HR 83.00
Vigy  HR 75.00
Rahul 78.00
Shan 70.00
Raj 72.00
Wenkat 76.00
Winoth 74.00

To Merge the Files with the Different Variables

PROCEDURE:

e Open one of the required data files.

File 1
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4 "m1_1 sav [Dataset2] -SPSS Data Fditar
Be Gt Uew D#n Twwom At Goehs Ukes Addans  vinde bs
CHE E o LBF A H S5 B

"

1o

e

1

2| 11200 78.00
ER| 11200 7500
4 11400 78.00
E 11500 20.00

e From the menus choose:

e Data = Merge Files = Add Cases...

e Select the data file to merge with the open data file

i *Untitled3 [DataSet3] - SPSS Data Editor
Eile  Edit Miew Data Iransform  Anslyze  Graphs  UWiites  Add-ons  Wndow  Help

cHE B b0 n=FEF A A ZtE B

1 rallum [111

|V\s\b\e 3 of 3 Variahles
| rallnum HR | Fin | | | ‘
111 78.00 7800
12 67.00 90.00
13 74.00 7800
114 80.00 Ge.00
15 34.00 56.00

4 i I DN
_Data view | variae view |
SPES Processor is ready ’_ ’_

P — [ [ [ 1
f} start ..a"l]utputl [Documen... 258 o [Data... g3 *ml_l.sav [Dataset... 28 *Untitled3 [D UE FDP Matetial - Micros. .. ’() ¥ Z2:53PM
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L Add Variables from Untitled3[DataSet3]

Excluded “variables: Mewy Lctive Dataset:

rollrumi+]

rallnumi*)
Marketing(*)
HF(+)

Fing+)

|:| Match cases on key variables in zorted files Key Varisbles:

|:| Indicate casze =ource as wariable:

[*1=Active dataset
[+)1=Untitled3[DataSetS]

ok || paste || Reset

Select the required variables and press “ok”

Merged file:
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22 *m1_1.sav [DataSet2] - SPSS Data Editor

Eile Edit  wiew Dsta Transform  Analyze Graphs  Uilties  Add-ons  Windovw Heln
cHE B o0 Bk A A EcE B9

1 HR 78

| rolinum | Marketing | HR Fin
111.00 67.00 78.00 78.00

11200 78.00 67.00 90.00

visible: 4 of 4 Variables

113.00 75.00 74.00 76.00

1400 78.00 80.00 88.00

11500 90.00 34.00 56.00|

[22 *Untitleds [Datasers... | @Y FOP Materi:

Thus the working data files are merged with the third data file.

SPLIT FILE

PURPOSE:

The primary aim of split function is to select and organize the variables in the required

order.

PROCEDURE:

e To Split a Data File for Analysis

e From the menu choose:
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Data =2 Split File...

e Select Compare groups or Organize output by groups.

*car_sales.sav [DataSet1] - SP5SS Data Editor

Filz Edit  iew Dats Transform Analyze Graphs Litiities  Add-ons WIncowy Help
CHA E 00 LBk M Hh S05E % 0%

|1 L manuisct |Mrlsub\sh| |V|S|ble. 13 01 15 Yariables

| rmanufact maodel sales | resale price engine_s horsepow | wheelbas
Mitsubishi 3000GT 0.110 20940 25.480 30 161 97.2
Dodge Wiper 0.918 55.470 B9.725 g0 450 96.2
Mercedes-Benz CLs00 0.954 . 85.500 a0 302 1136
Qldsrmobile Cutlass 1.112 11.240 18.145 31 150 107.0
Parsche Carrera Coupe 1.280 B0.B25 71.020 3.4 300 928
Audi AS 1.380 39.000 B2.000 42 310 1130
Mercedes-Benz SLK230 1.526 . 41.000 23 185 945
Parsche Carrera Cabriolet 1.866 B7.5850 74.970 34 300 928
Plymouth Prowler 1.872 . 43.000 34 253 1133
Mercedes-Benz SL-Class 3.31 45600 §2.600 a0 302 990
Lexus G3400 3.334 46,305 4.0 300 110.2
“ob c7o 3.483 45500 23 236 104.9
Walvo w40 3.545 24 400 1.9 100.5
Dodge Avenger 4734 19.045 25 103.7
Saturn SWy 5.223 14.290 1.9 102.4
Plymouth Breeze 5.240 16.080 20 105.0
wolkswagen GTI 5.596 17.500 20 959
Mitsubishi Diamante a7 24997 348 1071
Lexus L5400 B.375 54.005 40 1122
Cadillac Eldorado 5.536 39.665 46 108.0
Chrysler Sehring Coupe 7.554 19.840 25 103.7
Mercedes-Benz Sk 7.998 38.900 23 8945
Saturn L 8.472 18.835 22 106.5
CIE|

Data Wiew | ‘ariable Yiew |

W@ Wk =

00 000000000000 o0o0o0oo0o0o0oo0

[ SPSS Processor is ready |

— =
74 start | & sample_files ! ceptl-Micr... | g *Outputl [Document...
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it *car_sales.sav [DataSet1] - SPSS Data Editor E‘Elgl
File  Edit “iew Dsta Transform  Analyze  Graphs  Ulities  Addons Window  Help
CHA T 00 nHE 4 Al E460 %00

|1 manufact ‘Acura |V\sib\e. 15 of 15 Yariahles

| manufact model ‘ sales | resale price engine_s harsepour ‘ wheelhas wit
l}_xcura Integra 16.819 16.360 21800 18 140 1012 =
Acura s 39384 19.875 28 400 32 225 1081
Acura CL 14.114 18.225 . 32 25 106.9
Acura RL B.585 29725 42.000 35 210 114.6
Audi Ad 20397 22285 23.990 1.8 150 102.6
Audi AB 18.780 23.555 33.850 28 200 108.7
Audi AS 1.380 39.000 £2.000 42 310 130
BRI 3230 19.747 26,890 25 170 107.3
B 328 8231 28675 33400 28 193 107.3
B 528i 17.527 36125 38800 28 193 114
Buick Century 91.561 12.475 21.975 31 175 109.0
Buick Regal 39.350 13.740 25,300 38 240 109.0
Buick Park Avenue 27.851 20190 31.985 38 205 138
Buick LeSabre 83.257 13.360 27,885 38 205 122
Cadillac Deville 63728 22525 39.895 4B 275 5.3
Cadillac Seville 16.843 27100 44 475 4B 275 "2z
Cadillac Eldoradn £.536 25725 39 665 48 275 108.0
Cadillac Catera 11.185 18.225 31.010 30 200 107.4
Cadillac Escalade 14.785 46.225 57 255 175
Chevralat Cavalier 145.519 9.250 13.260 22 104.1
Chevrolet halibu 135126 11.225 16.535 3.1 170 107.0
Chevrolet Lumina 24528 10.310 18.890 31 175 107.5

Chevralet Iante Carla 42.593 11.525 19.380 3.4 180 106 [~
e 0

Data Wiew ‘ Variable View |

SP3S Processor is ready | | | | ‘Sp\it File On

The file is split into separate groups for analysis.

SELECT CASES

PURPOSE:

Select cases are used to select the required records from a database.

PROCEDURE:
To Select Subsets of Cases
e From the menus choose:

e Data = Select Cases...
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e Select any one of the data for selecting cases, say car sales.

e Car sales data dialogue box appears as below,

ar_sales.sav [DataSet?] - SPS5 Data Editor,
File  Ecit Wiew Data  Transform  Analyze  Graphs  Ulilties  Add-ons  Window  Help
CEHS B o LER A Hd EEE %09

|1  manufact |A:ura ‘VISIblEZ 15 of 15 Warishles

rnanufact rmodel sales | regale price engine_s horsepow | wheelbas ‘ widdt]
Bcura Integra 16.913 16.360 21.500 18 140 101.2 =
Acura TL 39.384 19.675 23.400 32 225 108.1
Acura cL 14.114 18.225 . 32 225 106.8
Acura RL 8.588 29725 42.000 348 210 114.6
Audi Ad 20,397 22,265 23.990 1.8 140 102.6
Audi AB 18.780 Z3.555 33.950 28 200 108.7
Audi A3 1.380 39.000 £2.000 42 310 13.0
By 3230 18.747 . 26.990 25 170 107.3
By 3260 9.23 20,675 33.400 28 193 107.3
Bhawy 528i 17.827 36.125 38.500 28 153 11.4
Buick Century 91.561 12.475 21.975 31 1758 109.0
Buick Regal 39.350 13.740 25300 38 240 109.0
Buick Park Avenue 27 851 20180 31.965 38 206 113.8
Buick LeSahre 03.257 13.360 27.805 38 206 122
Cadillac Deville 63.728 225825 39.895 45 275 153
Cadillac Seville 15.943 27.100 44 475 46 275 122
Cadillac Eldorada B.536 25725 39665 46 275 108.0
Cadillac Catera 11.185 18.225 31.010 30 200 107.4
Cadillac Escalade 14.785 . 48.225 87 255 175
Chevrolet Cavalier 145519 9.250 13.260 2.2 104.1
Chevrolet talibu 135128 11,225 16.535 31 170 107.0
Chevrolet Lurnina 24 523 10.310 18.890 31 175 107.5
Chevrolet tonte Carlo 42.593 11.625 19.380 34 180 105
Chevrolet Camaro 26.402 13.025 24340 38 200 101.1

Chevrolet Corvette 17.947 45705 5.7 345
|

——
12 start | FoP | B sample_files | W FOP [ Re ! e.. | D) CHAPTERIL., | @

F W Materials - ... F h e ol T Lab B-Finall... F p& manoval p... ankiban.s... | i *Outputl L., bt

e Specify the criteria for selecting cases.
e Select the cases for the price greater than & equal to 25.

e Click continues.
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Select Cases: If

% Manufacturer [manufact]
&4 Model [madel]

g& Sales in thousands [=al...
g& 4_wear resale value [res..
d:l Wehicle type [type]

‘gg& Price in thousands [price]
‘g& Engine size [engine_s]
‘g& Horsepower [horsepow]
‘5& vheelbasze [wheelhas]
&7 wictth [wicith]

& Length [length]

‘g& Curb weight [curb_wwegt]
‘g& Fuel capacity [fuesl_cap]

rice == 25

Function group:

Al

Arithimetic

CDF & Moncentral CDF
ConverEion

Current DateTime
Diate Arithmetic

-

Functions and Special VWariahles:

‘g& Fuel efficiency [mpg]
& price == 25 (FILTER) [fit...

Continue i ’

Cancel

I

*car_sales.sav [DataSet1] - SPSS Data Editor

File Edt View Data Iransform  Analyze Graphs

Utiitiss  Add-ons

Winclow

Help

CHS W o LSk A Eh BLE 500

1 : manufact |#cura

[\vistele: 15 o 15 variables

| manufact maodel

sales

resale

price

engine_s horsepow ‘ wheelbas ‘ widt

Acura

/lﬁcura Integra
2

T

Acura

Acura
Audi
Audi
Audi
By
By
By
Buick
Buick
Buick
Buick
Cadillac
Cadillac
Cadillac
Cadillac
Cadillac
Chesrolet

Chewralet
Chevrolet

Chesrolet

Chevralet

cL

RL

Ad

AR

A

3230

328i

5280
Century
Regal
Park Avenue
LeSabre
Deville
Seville
Eldorado
Catera
Escalade
Cavalier
Ialibu
Lumina
Monte Carlo
Camaro
Caorvette

16919
39.384
14114

8.588
20.397
18.780

1.380
19.747

9.231
17.627
91.561
39.350
27.851
83257
63.729
15.943

B.536
11.185
14.785
145519
135126
24 528
42,693
26.402
17.947

16.360
19.875
18.225
29725
22,255
23855
39.000

28675
36.125
12.475
13740
20.190
13360
22625
27.100
25725
18.225

9.250
11.225
10310
11.525
13.025
36.225

21.500
28.400

42.000
23.990
33.950
E2.000
26.990
33.400
38.900
21.975
25.300
31.965
27 885
39.895
44.475
39 665
31.010
46,225
13.260
16.535
18.590
19.390
24.340
45705

1.8 140 101.2 =4

32 225

108.1

32 225 106.9
35 1146
18 102.6
28 1087
42 130
25 107.3
28 107 .3
28 111.4
31 109.0
38 102.0
38 138
38 122
4B 153
46 12.2
456 108.0
30 107.4
57 1M7.5
22 104.1
31 107.0
31 107 .5
34 105
38 1011
57 104.5

Chevrolet
4

4 start [ &= FoP

[ & sample_f

[T cHAPTER TI...

[

o [ Y Lab B-Finall...
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The cases in which price less than 25 are stroked out. Thus subgroup of cases

based on criteria that include variables and complex expressions is selected.

DATA Manipulation

COMPUTE

PURPOSE:
The primary aim of compute is to perform calculations in the given data base.

For each of the following statements, please indicate your perception .

(SA- Strongly Agree; 5 Agree:4 Neither Agree Nor Disagree:3 Disagree:2 Strongly

Disagree:1

Physical Atmosphere

Parking facility provided at More outlet is adequate

. The products arrangements in More is convenient

More outlets have sufficient number of counters

. The ambience of More is pleasant.
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PROCEDURE:

Step 1: Open the required data base, say COMPUTE
Step 2: select the variables to be computed according to requirement.

Step 3: here in this example select the variables such as pal,pa2, pa3, pa4

[ COMPUTE.sav [DataSetl] - SPSS Data Editor
Fle Edt View Data Iransform  Analyze  Graphs  Utities Add-gns  Window  Help

=Ea m LEE A A4 BEGE %09

| MNarma Type ‘ “Width ‘ Demma\s‘ Label | Walugs Missing Calurmns Align ‘ Measure
pal Mumeric parking Facility. . {1, Strongly ... Mone Right & Scale
paz Mumeric The products ar.. {1, Strongly ... Mone = Right & Scale
pa3 Mumeric more outlets ha.. {1, Strongly ... Mone = Right & Scale
pad Mumeric The ambience {1, Strongly ... Mone = Right & Scale

tat MNumeric Mane Mone = Right & Scals

[

Data Yiew | Wariable View

SPSS Processor is ready

= A= :
[7Start J‘H @mm-g:ganashkm |@Down\uads é N uj chapter 3.doc [Co.. Data Entry |¥ “Outputl [Docume... ECDMPUTEW[D&., 6 |2 agy BOAM
= —

" 0l-Augl2

Step 4: From the menus choose:

Transform - Compute...

e Select the condition to be performed in the dialog box which is shown below.

COMPUTER APPLICATIONS IN BUSINESS Page 30




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION
Manonmaniam Sundaranar University, Tirunelveli

e New variable is created and condition is performed

e In this example new variable named NEW.AVG is created and the selected

variables are averaged.

E Compute Variable

Target “Yariakble:

Mumeric Expression:
[NEW 2 G

pal + paz + pad + pad] 18]

| Type & Label. . |

& parking Facility provided. ..

& The products arrangem... -
. Function group;

& mare outlets have suffic.. il

& The ambience of more i... arithmetic

& tet CDF & Moncentral COF

Canversion

Currert DatesTime

Date Arithimetic

Functions and Special ‘Yariahles:

| If... |(Dp1i|:|nal caze zelection condition)

Ol J| Paste || Reszet || Cancel || Help

The required calculation is performed in the database.
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RECODING INTO SAME VARIABLES

PURPOSE:

The primary purpose of this function is to recode the categories.

PROCEDURE:

STEP 1: Open the required data base -Recode into Same variable.sav

e From the menus choose:

e Transform - Recode = Into Same Variables...

e Select the variables you want to recode. If you select multiple variables, they must

be the same type (numeric or string).

e Variable “customer “ is selected
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B Recede into Same variable.sav [DataSetl] - SPSS Data Editor
Fle Ecit ¥isw Data Transform  Analyze  Graphs  Uiilties Addons  Window  Help
EHL B 60 L@E A EhE vo®
MNarma Type ‘ “Width ‘ Demma\s‘ Label | Walugs Missing Calurmns Align ‘ Measure
customer Mureric 8 a {1, Strongly ... Mone 8 = Right & Scale

EFH Recode into Same Variables

Numeric Wariahles:

@ customer

[«]

| ol and ew Values... |

| .. |contionsl case selection condtion)

| Resst || cancel || Hew |

[
Data Yiew | Wariable View

SPSS Processor is ready

frse| [T @Inbax-g:ganashku‘.‘ C:;;l a ﬁj :haptevidu:[tum”.|&'—" Documentl - Micro..| |\l Data Entry |ERecodeintoSame... &2 (2 a0 ufi}uﬂz ]

e Click Old and New Values and specify how to recode values.

o Optionally, you can define a subset of cases to recode.

COMPUTER APPLICATIONS IN BUSINESS




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION
Manonmaniam Sundaranar University, Tirunelveli

Old Value

() walue:

() System-missing
() System- or user-mizsing

() Range:

() all gther values

() Range, LOWEST through value:

() Range, value through HGHEST:

& Recode into Same Variables: Old and New Values

Hew VYalue

(2] walue: |

() System-missing

Old --= Mew:

1--=5
2--=4d
S3--=3
4--=2
5=

| Continue _J |

Cancel | | Help

e Then press ok

E5] Recode into Same variable.sav [DataSetl] - PSS Data Editor

fie Edt View Dota

EEHE T b mEE & HE

Transform  Analyze  Graphs

Uities  Addons  Window  Help

SEEH %9%

11 customer 2

=181

“isible: 1 of 1 Variables

‘l:usmmer war | var ‘

var ‘ var |

‘ var

var var

E]
10
"
12
13
14
15
16
17
18
18
0
2
P
3
24
i)
R

[l

Data View | Variahle View

orstn| ] elnbwgzganeshkm @ N Eﬂchapteriduc[&l...

!j Documentl - Micr...

L Data Entry
5

SPSS Processor i ready

‘ERecodeimoSame... # “Output (Docume..| B2 |8 o ) ufiduﬂz =

The code of the variables in the database is changed according to condition specified.
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RECODING INTO DIFFERENT VARIABLES

PROCEDURE

STEP 1: Open the required data base, say Recode into different variable.sav

[ *Recode into different variable.sav [DataSetl] - SPSS Data Editor =] x]

Fle Edt Wiew Dsta Transform  Anslyze  Graphs  Ufities  Addone  Window  Help

cHB B 00 85k A Ad E6F 509

1 Age 54 Visible: 2 of 2 Variables

Age
51
45
51
&0
52
54
37
36
&0
43
52
33
32
6
5
5
43
53
43
45
46
45
3
36
43
43

<]

Data View | ‘variable Wiew

SPSS Processar is ready

y - @A A [ ] . tk p o di 2 |: L BSSAM
[7start JH\ @Inbux geganeshk.. é & [t chapter3dociCo.. | HY] Documentl - Micr.. | | Data Entry Outputl [Docume... Recode into diffe... [£] A e E

From the menus choose:

Transform = Recode - Into Different Variables...

Select the variables you want to recode. If you select multiple variables, they must

be the same type (numeric or string).
Variable “age “ is selected

New variable name is given as REAGE
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A *Recode into different variable.sav [DataSetl] - SPSS Data Editor —|=] x|
Fle Edt Wiew Dsta Iransform  Analyre  Graphe  Ufities  Acdd-ons  Window  Help

EHE ® &0 2R A Bd E&E %0

1: age isible: 2 of 2 Yariables

[ Recode inta Different Variables

jumeric Yarisble -= Output Yariable:
Age =2

Output Variable
Matme:

REAGE

Label

| chenge |

| ouandnew vaies... |

| .. |¢optional case seiection consition)

| Reset || cancel || Hem

<]

Data View | ‘variable Wiew

SPSS Processar is ready

. . A A @ [ . HE - *Recode into dil A |z oa gy M
L7Start, JH @Inbux geganeshk... k‘;% a chapter3.doc [Co... | %] Documentl - Micr... | |/ Data Entry Outputl [Docume... Recode into diffe..  [+£] tll ) Gerugrlzl

e Then press “Old and New Values button”

e Then enter the values as shown below.
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&i Recode into Different Variables: Old and New Values

0ld value Hew Value

() Walue: (2] Yalue: |

() System-missing
() System-missing ,::::. Copy old valus(s)
() System- of user-missing

Ol --= Mewy:

Lowyest thru 25 --= 1
26 thru 35 --= 2
GEthruds = 3
46 thru Highest --= 4

() Range:

() Range, LOWEST through value:

(=) F’ange_, value through HIGHEST:
| | |:| Output variskles are strings

() Al other values

| Cortinue _“ Cancel ||
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[ Recode into different variable.sav [DataSetl] - SPSS Data Editor -z x|
File Edit Wiew Data Transform  Analyze  Graphs  Uities Addons  Window  Help

CHE [ oo L5 & Ah E6F 509

1 Age 54 “igible: 2 of 2 Yariables

Age reage ‘ war ‘ var ‘ var | var | var
51 300 =
45 200 i
51 300
50 300
52 300
54 300
7 1.00
36 1.00
50 300
49 200
52 300
33 1.00
32 100
b 300
55 300
55 300
43 200
53 300
48 200
45 200
46 200
45 200
58 300
e 1.00
43 200
43 200

(e

Data View | ‘Variahle View

SPSS Processor is ready

y : A A @j iw. . # L 7 |a o B5TAM
[7start JH @hm geganest | (23 B, W] chapter3dec(Co.. | F0] Documentl - Mict.. | | Data Entry Outputl [Docume... Recodeinto differ.. [ all 1) Gl-Aug-lzl

Thus the file is recoded using different variables
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UNIT II
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UNIT 111 Non-parametric Tests in SPSS Chi-square test - Mann Whitney’s
test for independent samples — Wilcoxon matched pairs sample test—

Friedman’s test— Wilcoxon signed rank test — Kruskal Wallis test

CHI-SQUARE

Chi-Square can be used for three purposes namely
1. As a test of independence
2. To test the Homogeneity

3. To test the goodness of fit

PURPOSE:

Chi-square which is available in cross tab is used to test whether there is a

significant association between two variables.

ASSUMPTION:

e The two variables that are to be applied in chi-square analysis must be of type

category.

e The total number of observation used in this test must be large i.e., n>=30.
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e Independence - The observations are always assumed to be independent of
each other. This means chi-square cannot be used to test correlated data (like:
matched pairs, panel data).

e Itis frequency based test

HYPOTHESIS:

Null hypothesis: HO- There is no significant association between the two

variables.

Alternate hypothesis: H1- There is significant association between the two

variables.

The two variables considered here are total income and total saving.

PROCEDURE:

STEP 1: Open the database, say SAVINGS.

STEP 2: To run a cross tab analysis, from the menu choose:

Analyze >Cross tabs

STEP 3: The cross tab dialog box appears as shown
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E Crosstabs

Rowe (=
| & Total Income [reinc]

[«

Columni =)
& Total Saving [retotsa]

[«]

Layer 1 0f 1

[] Display clustered bar charts

[] Suppress tables

ik | | Paste | | Resest | | Cancel | |

select total income as the row variable
select total saving as the column variable
click statistics

Select chi-square

Click continue

STEP 4: Press ok in the cross tabs dialogue box table showing Cross Tab between
total income and total saving would be generated.

Total Income * Total Saving Cross tabulation

Total Saving

upto 5000 | 5001-10000 | 10001-15000 | 15001-20000 |20001 and above

Total Income  |upto 20000 67 42 13

20001-30000 89 80 42
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30001-40000 25

32

26

15

40001-50000

21

10

11

50001 and above

19

Total

Total Income * Total Saving Cross tabulation

Total Saving

upto 5000

5001-10000

10001-15000

15001-20000

20001 and

above

Total

Income

upto 20000

Count

67

42

13

Expected Count

% within Total Saving

20001-30000

Count

Expected Count

% within Total Saving

30001-40000

Count

Expected Count

% within Total Saving

40001-50000

Count

Expected Count

% within Total Saving

50001 and

above

Count

Expected Count

% within Total Saving

Count

Expected Count
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Total Income * Total Saving Cross tabulation

Total Saving

upto 5000

5001-10000

10001-15000

15001-20000

20001 and

above

Total

Income

upto 20000

Count

67

42

13

Expected Count

% within Total Saving

20001-30000

Count

Expected Count

% within Total Saving

30001-40000

Count

Expected Count

% within Total Saving

40001-50000

Count

Expected Count

% within Total Saving

50001 and

above

Count

19

Expected Count

18.5

17.3

10.4

% within Total Saving

3.6%

4.9%

17.3%

Count

196

184

110

41

21

Expected Count

196.0

184.0

110.0

41.0

21.0

% within Total Saving

100.0%

100.0%

100.0%

100.0%

100.0%

Result Generated By SPSS

Chi-Square Tests

Value

df Sig. (2-sided)
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Pearson Chi-Square 1.287E2*| 16 .000

Likelihood Ratio 120.928 16 .000

Linear-by-Linear
100.919
Association

N of Valid Cases

The calculated value is 1.287 E2 which means 128.7 and it significant at this level of
significance 0.000 at degrees of freedom 16.

In SPSS, if the significant value is less than 0.05 then reject null hypothesis and accept
alternate hypothesis. In the above obtained result the significant value is less than 0.05 so,
reject null hypothesis.

Hence there is significant association between total income and total saving.

Calculated value (128.7) is greater than table value (39. 253) at degrees of freedom 16 in
the 0.000 level of significance in the chi-square table. so we can reject the null hypothesis

and accept the alternative hypothesis.
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0.995 0.975
.0000393 0.000932
0.0100  0.0506
0.0717  0.216
0.207 0.484
0.412 0.831
0.676 1.237
0.9a9 1.650
1.344 2.180
1.735 2.700
2.156 3.247
2.603 3.816
3.074 4.404
3.565 5.009
4.075 5.629
4.501 6.262
5.142 £.908
5.697 7.064
£.265 8.231
6.844 8.907
7.434 5.591
8.034  10.283
8.043 10.9582

e [}
Hammummawun—_n
=1

I R N R T e e e e
[ I = N ¥ = N == N B = IR B < &5 R
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Unit H1
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UNIT Il Parametric Tests in SPSS Compare means: One-sample t-test,

Independent Samples t-test, Paired-samples t-test and One-way ANOVA,

Two-way ANOVA - Correlation: Bi-variate, Partial and Multiple. Simple

linear regression.

ONE SAMPLE T TEST

PURPOSE:
The One-Sample T Test compares the mean score of a sample to a known value. Usually,
the known value is a population mean.
ASSUMPTION:
e The variable that is considered in the one sample T test must be metric.
e The dependent variable is normally distributed.
HYPOTHESES:
Null hypothesis HO: There is no significant difference between the sample mean and the
population mean.
Alternate hypothesis H1: There is a significant difference between the sample mean and
the population mean.
The test variable is Average monthly minutes and test value is 200.

PROCEDURE:

STEP 1: Open the database, say cellular.
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STEP 2: To begin the one sample T-test

Analyze >one -sample T-test

STEP 3: A one sample T- test window appears as below

~

~ :
E One-Sample T Test S <

Test Yariable(s):
6§> Serial number [sno] & Avg monthly minutes [mi...

é? sex [gender]

f Average monthly bill [bill]
659 Pct used for business [... W‘
559 Years using our service...| —
& Household income (199...
& Propensity to leave [sco...

prmm

Test value: (200 |

[ OK “ Paste H Reset H Cancel H Help

Select average monthly minutes as test variable
Type 200 as test value

click options

type 95 as confidence level

click continue

STEP 5: click ok in the one sample T-test dialogue box. Then the following tables

would be generated

One-Sample Statistics
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Std.  [Std. Error

Deviation| Mean

Avg
monthly 162.1856(46.57060| 2.94538

minutes

One-Sample Test

Test Value = 200

Mean | 95% Confidence
Sig. (2- | Differen | Interval of the

tailed) ce Difference

Avg monthly

minutes . 37.8143
43.6154
8

Here the test value is considered as 200, the mean value obtained through one sample

statistics is 162.1856 and the difference between the means is 37.81.Based on the result

generated by SPSS, the significant value is 0.00 and it is less than 0.05 so reject null

hypothesis. Hence there is significant difference between the two means i.e. population

means and sample mean.
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INDEPENDENT SAMPLE T- TEST

PURPOSE:

The Independent Samples T Test compares the mean scores of two groups on a given
variable.

HYPOTHESES:

Null hypothesis HO: The means of the two groups are not significantly different.
Alternate hypothesis H1: The means of the two groups are significantly different.

ASSUMPTIONS:

1. Independent sample t-test assumes that the dependent variable is normally
distributed.
2. Independent sample t-test assumes that the variance of the two groups is the same as

the dependent variable.

3. Independent sample t-test assumes that the two samples are independent of each

other.

4. Samples for independent sample t-test are drawn from the population at random.
5. In independent sample t-test, all observations must be independent of each other.
6. In independent sample t-test, dependent variables must be measured on an interval
or ratio scale.

PROCEDURE:

STEP 1: Open the database, say AVERAGE MONTHLY MINUTES.
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STEP 2: to begin the independent sample t-test

Analyze----> compare means----->independent sample t-test

STEP 3: Independent sample t-test dialogue box appears

@ Independent-5amples T Test

Test Variable(s):
& Serial number [zna) ﬁ Awl monthly minutes [mi...
ﬁ Avergge monthly kill [kill]
ﬁ Pct used for business [...
ﬁ Years using our service...
& Houzehald income (199,
ﬁ Propensity to leave [zco...

Options...

Grauping Yariakble:
| | |gender(1 21

| Define Groups. .. |

O || Paste || Reset || Cancel || Help |

select average monthly minutes as the test variable

select gender as the grouping variable

click define groups

Type one as the group one value and two as the group two value

click continue

STEP 5: click ok in the independent-sample T-test dialogue box.
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Group Statistics

Sex Mean Std. Deviation Std. Error Mean

Avg monthly minutes Female 1.6077E2 51.83109 4.39626

Male 1.6396E2 39.15930 3.71684

Independent Samples Test

Levene's Test for t-test for Equality of Means
Equality of

Variances

Sig. ig. Mean Std. 95% Confidence
(2- Difference Error Interval of the

tailed) Differe Difference

nce Lower Upper

Avg Equal : : . -3.18239 | 5.93657 | -14.87491 | 8.51012
monthly | variances

minutes | assumed

Equal . -3.18239 | 5.75690 | -14.52121 8.15642
variances
not

assumed
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Levene's Test for Equality of Variances (Homogenisity) result shows that significant
value that is 0.009 which means both groups are homogeneous group so t-test for equal
variance not assumed considered.

Here the mean value of average monthly minutes of female is 160.77 and that of male is

163.96.the difference between the two is 3.18 which is insignificant. Based on the result

generated by SPSS, the significant value is .581 and it is greater than 0.05 so accept null

hypothesis. Hence there is no significant difference between the two means i.e. the

average monthly minutes spoken by male and female.

PAIRED ‘T’ TEST

PURPOSE:

Paired sample t-test is a statistical technique that is used to compare two

population means in the case of two samples that are correlated

ASSUMPTIONS:

The paired t-test assumes that the differences between means are normally
distributed.

Interval scale or ordinal scale with many alternatives.

Normal Distribution(s)

No skew.

COMPUTER APPLICATIONS IN BUSINESS




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION
Manonmaniam Sundaranar University, Tirunelveli

HYPOTHESIS:

Null hypothesis Ho: There is no significance difference between the means.

Alternate hypothesis H1: There is a significance difference between the means.

PROCEDURE:

STEP 1: Open the database, say AGILITY.

STEP 2: to begin the analysis

> paired sample t-test

STEP 3: a paired sample t-test window appears as below

E Paired-Samples T Test

Paired Yatiables:
[® Pre Test. Aty [pre_ag] | Pair | ‘arisblel | ‘Wariakle2
,&) Post Test-saility [post_aa] 1 f Pre Test... y Post Tes...
&9 Pre_Test-Self esteem [p... 2
&% Post_Test-Self esteem [ ...

]

(8.4 || Paste || Reszet || Cancel || Help

COMPUTER APPLICATIONS IN BUSINESS




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION
Manonmaniam Sundaranar University, Tirunelveli

Select pre treatment and post treatment scores of agility as the first set of paired

variables
Select pre treatment and post treatment scores of self esteem as the second set of
paired variables

STEP 5: click OK in the paired t- test dialogue box

Paired Samples Statistics

Mean Std. Deviation Std. Error Mean

Pre Test- Agility 12.3792 .68525 .06255

Post Test-Agility 11.8350 .81516 .07441

Paired Samples Correlations

Correlation

Pre Test- Agility & Post Test-

Agility

Paired Samples Test

Paired Differences

Std. Std. 95% Confidence (2-
Devia | Error Interval of the tailed)

tion Mean Difference
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Lower Upper

Pre Test- 46402 .62431
Agility - Post

Test-Agility

The Pre test score of agility is 12.3792 and the Post Test score of Agility is 11.8350 and
the difference between their mean is .5442. Based on the result generated by SPSS, the
significant value is .000 and it is lesser than 0.05 so reject null hypothesis. Hence there is

a significance difference between the pretest and post test scores of agility.

ONE WAY-ANOVA

PURPOSE:

One way ANOVA is a statistical technique that is used to compare the means of more

than two groups

ASSUMPTION:
The variables must be normally distributed
Samples are independent.
Variances of populations are equal.

The sample is a simple random sample (SRS).

HYPOTHESIS:
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Null hypothesis HO- There is no significant difference between the variables.

Alternate hypothesis H1-There is significant difference between the variables.

PROCEDURE:

STEP 1: Open the database, say INCOME LEVEL.
STEP 2: to test the equality of variance
Analyze-----> compare means--->one-way ANOVA

STEP 3: A one-way ANOVA dialogue box appears as follows

(B One-Way ANOVA ) |

Dependert List:
& Total monthly saving [iot...

| Contrasts... |
| Post Hoc... |

‘7‘ | Options... |

— | Factor:
‘ W Tatal Income [reinc]

| CK || Pazte || Rezet || Cancel || Help |

¢ select total monthly saving as the dependent variable
e select total income as the factor variable

e Click post hoc > Select Duncan.
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e Click Continue.

e Click Options----->Select Mean Plot

e Click Continue.

e Click Ok.

STEP 5: Click ok in the one-way ANOVA dialogue box.

Total monthly saving

Sum of

Squares Mean Square

Between Groups 3.624E9 9.059E8

Within Groups 1.422E10 2.600E7

Total 1.784E10

Post Hoc:

Total monthly saving

Subset for alpha = 0.0

Total Income 2 3
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upto 20000 124 | 5310.48

20001-30000 219 7064.87

30001-40000 103

40001-50000 54

50001 and above 52

Means for groups in homogeneous subsets are displayed.

MEAN PLOT:

=
=
==
]
w
=
=
=
=
(=]
E
=
B
(=)
-
u—
(=]
=
[
L1}
=

T T T T T
upto 20000 20001-30000 30001-40000 40001-50000 50001 and above

Total Income

Based on the result generated by SPSS, the significant value is 0.000 and it is lower than
0.05 so reject null hypothesis .Hence there is a significance difference in the saving of
respondents with respect to their income level.

By using Duncan method the saving of respondents is separated into two groups based on

their income level.
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In the mean plot when the saving level is low when income earned by them is lower

while the saving level is high when the income earned by them is higher.

FACTORIAL ANOVA

PROCEDURE:

STEP1: Open the database, say Cust percep.
STEP2: To run a cross tab analysis, from the menu choose:
Analyze >univariate

STEP3: The univariate dialog box appears as

E Univanate

Dependent Yatiable:
& Perzonnel [PERSORMEL] |

Fized Factar(z):
& Introduced by [INTRO]
&¥ account type [ACCOUNT]

Random Factor(z]:

Covariatels):

-

WL S WWeight:

adl |

| Ok J| Pazte || Reset || Cancel || Help |

—

Tests of Between-Subjects Effects
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Dependent Variable:Personnel

Type 111 Sum

Source of Squares Mean Square

Corrected Model 2.5072 .358 3.756

Intercept 505.062 505.062| 5.297E3

INTRO 912 456 4.782

ACCOUNT .138 .069 122

INTRO *

ACCOUNT

Error 16.877 177

Total 1555.000 185

Corrected Total 19.384 184

a. R Squared = .129 (Adjusted R Squared = .095)

Personnel

Sum of

Squares Mean Square

Between

Groups
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Within Groups 17.687 182 .097

Total 19.384 184

Personnel

Sum of

Squares Mean Square

Between
.183 .091
Groups

Within Groups

Total

ANCOVA

PURPOSE:

The main purpose of ancova is test equality of group means after adjusting for the effect

of a continuous variate.
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ASSUMPTIONS:

e The covariate variable is to be unaffected by the treatment

e Parallelism.

PROCEDURE:

STEP1: Open the database, say MERGED.

STEP2: To run a cross tab analysis, from the menu choose:

Analyze >univariate

STEP3: The univariate dialog box appears as

E Uniwvariate ﬂ

— | Dependent “ariakle: |
| + | [&® Total manthly saving fot...|

Moddel. ..

| Contrasts ...
Fixed Factor(=s):

& Designation [designat] | Plots...
- & Age [reace]

| Save...

Fandom Factor(=): | Cptions...

Covariates):
f Total Income [reinc]

(<]

YNLS Wieight:

il |

| | Eeset | | Cancel | | Help
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STEP: 4 Select monthly saving as dependent variable.

STEP: 5 Select age, designation as factor variable.

STEP: 6 IN ANCOVA can select more than one category variable.

ANOVA TABLE FOR TOTAL MONTHLY SAVING

F Sig.

Age

Designation

From the above anova table it is clear that the average monthly saving of people

holding different designation varies significantly. The table also indicates that the saving

size of people changes significantly for different age category of people.

ANCOVA FOR AGE AND DESIGNATION

Source F Sig.

Corrected Model

Intercept

TOTALIN

DESIGNAT

REAGE

DESIGNAT * REAGE
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The above analysis of covariance table indicates that total income has effect on
saving size of people but designation and age have no effect on saving once the effect of
total income on saving is controlled. In the previous analysis it was stated that age and
designation have effect on saving but that is due to income of the people because the
income increases with designation. Hence, the designation and age do not have

independent effect on the size of saving of people.

MANOVA

PURPOSE:

MANOVA estimates the effects of one or more independent variables on a bundle of
dependent variables. As opposed to T test and ANOVA which examines equality of

means of single dependent variable across groups, MANOVA tests the equality of means

on multiple dependent variables across groups.

ASSUMPTIONS:
e Independent Random Sampling: MANOVA normally assumes that the
observations are independent of one another. The sample is completely random.
Level and Measurement of the Variables: MANOVA assumes that the
independent variables are categorical in nature and the dependent variables are
continues variables. MANOVA also assumes that homogeneity is present between

the variables that are taken for covariates.
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e Linearity of dependent variable: In MANOVA, the dependent variables can be
correlated to each other, or may be independent of each other. Study shows that in
MANOVA, a moderately correlated dependent variable is preferred. In
MANOVA, if the dependent variables are independent of each other, then we
have to sacrifice the degrees of freedom and it will decrease the power of the
analysis.

Multivariate Normality: MANOVA is very sensitive with outliers and missing
value. Thus, it is assumed that multivariate normality is present in the data.
Multivariate Homogeneity of Variance: Like test analysis of variance,

MANOVA also assumes that the variance between groups is equal.

HYPOTHESIS:

Null hypothesis HO: There is no significant difference between demographic variables

and values of various soaps.
Alternate hypothesis H1:  There is a significant difference between demographic

variables and values of various soaps.

PROCEDURE:

STEP1: Open the database, say SATISFY.
STEP2: To run a cross tab analysis, from the menu choose:
Analyze >multivariate

STEP3: The MANOVA dialog box appears as shown
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@ Multivariate ﬂ

Dependent Yariables:
ﬁ Age categary [agecat] S & Price satizfaction [pri...| =
& Shopping frequency [re... & wariety satisfaction [... |22
& First time reason [reasa... | — g§> Organization satisfa.. |-
f Regular reazon [reason?]
ﬁ Primary department [dept]
ﬁ Wade purchase [purcha...

Fixed Factar(s):
g‘ﬁ) Gender [gender]
g& hlethad of paymert [pay. .

& Followy-up wis [followeug)]

f Distance from haome [dis..
ﬁ Store [=stare] Covearistel=):
ﬁ Cartact with emplayee [ ..
ﬁ Owerall satizfaction [ove...

WLE Weight:

|| Reset || Cancel || Help |

STEP: 4 Select values of various soaps as dependent variable.

STEP: 5 Select family income as factor.

Shopping Satisfaction versus mode of payment and gender

Multivariate Tests

Effect Value Hypothesis df | Error df

Intercept Pillai's Trace .878 | 8.162E2* 5.000 568.000

Wilks' Lambda 122 | 8.162E2? 5.000 568.000

Hotelling's Trace 7.185 | 8.162E2° 5.000 568.000

Roy's Largest Root 7.185 | 8.162E22 5.000 568.000

Pillai's Trace .014 1.6002 5.000 568.000

Wilks' Lambda .986 1.600? 5.000 568.000
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Hotelling's Trace .014 1.600? 5.000 568.000

Roy's Largest Root .014 1.600? 5.000 568.000

Payment Pillai's Trace .040 1.147 20.000 2.284E3

Wilks' Lambda 961 1.148 20.000 1.885E3

Hotelling's Trace .041 1.148 20.000 2.266E3

Roy's Largest Root .024 2.789%° 5.000 571.000

gender * payment  |Pillai's Trace .044 1.281 20.000 2.284E3

Wilks' Lambda .956 1.284 20.000 1.885E3

Hotelling's Trace .045 1.286 20.000 2.266E3

Roy's Largest Root .030 3.416° 5.000 571.000

From the above table we can see that the value of MANOVA is greater than .05
therefore Null Hypotheses is accepted. Thus there is a no significant difference between

shopping Satisfaction versus mode of payment and gender.

Repeated measures :

Procedure
e Step 1 : open the database “Diet Study.sav” .
e Step 2 : click analyze and select “General Linear Models” —»  “Repeated

Measures” .
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@ Repeated Measures Define Factor(s) ﬁ

Within-Subject Factor Mame:
|fau:1u:ur1
MNumber of Levels: IEI

factor1(5)

Meazure Mame:

| Define _“ Reset || Cancel || Help |

Step 3 : enter the number of levels and then click on “Define”

Step 4 : Add the factors one by one to the “within-subject Variables”

f m Repeated Measures - “

Within-Subjects Yariables
& Patient D [patic] (factor! )
& ageinvears [age] + |3 tudi)
& Gender [gender] ot (2
& Finaltrigiyceride g4 | t2(3)
& wisight [vgtn] I
& 15t interim weight [wet1] R
&P and interim weight [wot2]
&P 3rd inkerim weight [wot3]
& Final weight [wot4]

Between-Subjects Factor(s):

Covaristes:

Reset || Cancel || Help
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Step 5 : click on “plots” and add the “factorl” to the horizontal axis and then click “add”
to add it to the plots and click on continue to proceed.

Step 6 : click on options and add “factor1” to the “Display means for” coloum , select the
Descriptive Statistics and Homogeneity tests and click continue.

Step 7 : click “OK ” to generate the output.

OUTPUT :

Descriptive Statistics

Std.

Deviation

Triglyceride 29.040

1st interim

triglyceride

2nd interim

triglyceride

3rd interim

triglyceride

Final triglyceride
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Multivariate TestsP

Effect Value Hypothesis df| Error df

factorl |Pillai's Trace 201 ) 4.000f 12.000

Wilks' Lambda 799 : 4.000[ 12.000

Hotelling's Trace .252 : 4.000 12.000

Roy's Largest

Root

a. Exact statistic

b. Design: Intercept

Within Subjects Design: factorl
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Estimated Marginal Means of MEASURE_1

-

L

o
1

Estimated Marginal Means

T
3

factor1

CORRELATION

PURPOSE:
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A correlation is a single number that describes the direction and the degree of

relationship between two variables.

ASSUMPTION:
e The variables must be normally distributed.

e The variables must be linear.

HYPOTHESIS:

Null hypothesis Ho: there is no significant relationship between the variables.

Alternate hypothesis H1: there is a significant relationship between the variables.

PROCEDURE:

STEP1: Open the database, say Narayanan.

STEP2: To run the correlation analysis:

Analyze > Bivariate

STEP3: The Bivariate correlation dialog box appears
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@ Bivariate Carrelations -— ™ - Li—:hJ

Wariahles:

& NEFC &7 7 Score [7]

S T [0 . l#” H scare [H] |
&P PEITIT [%2]
& PBRITICL [13] S—
&7 SalesTa (x4 | +* |
&7 -
W
& w3 | |
& g ~

Correlation Coefficients

| Options... |

Pearson |:| Kendall's tau-kb |:| Spearman

Test of Significance

() Twotailed () One-tailed

Flag significart correlations

| [8]34 | | Paste | | Reseat | | Cancel | |

STEP: 4 select the Z Score (Z), H Score (H) as variables
STEP: 5 select Pearson correlation coefficients.

STEP: 6 click ok,

Correlations

Z Score | H Score

Pearson
811"
Correlation

Sig. (2-tailed)

N

H Score |Pearson

Correlation
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Sig. (2-tailed) .000

N 124 124

**_Correlation is significant at the 0.01 level (2-

tailed).

The correlation between Z Score and H Score is r = 0.811 and significant values is 0.000.
This indicates that Z Score and H Score are not independent to each other. Here the value

of ris 0.811 so it is considered to be a strong correlation.
PARTIAL CORRELATION
PURPOSE:

Partial Correlation is the measure of association between two variables, while controlling

or adjusting the effect of one or more additional variables. Partial Correlation can be used

in many cases, like whether or not the sale value of a particular commodity is strongly

related to the expenditure on advertising when the effect of price is controlled. If the
partial correlation becomes zero, then it can be inferred that the correlation that was

computed before is false.

Correlations

Income after

Age in years| the program

Age in years Pearson
297"
Correlation
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Sig. (2-tailed)

N

Income after the

program

Pearson

Correlation

Sig. (2-tailed)

.000

N

1000

**_Correlation is significant at the 0.01 level (2-tailed).

Correlations

Agein

years

Income after

the program

Income before the

program

Age in years

Pearson Correlation

297"

526"

Sig. (2-tailed)

.000

.000

Income after the

program

Pearson Correlation

297"

589"

Sig. (2-tailed)

.000

.000

Income before the

program

Pearson Correlation

526"

Sig. (2-tailed)

.000

N

1000

**_Correlation is significant at the 0.01 level (2-tailed).

PROCEDURE:
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STEP1: Open the database, say PARTIAL CORRELATION
STEP2: To conduct the partial correlation;
Analyze----->Correlate---->Partial
STEP3: Select the variables age and income after the program under variables.

STEP4: Select income before the program as the variable whose effect is to be

controlled.

STEPS: Click OK.

& Partial Correlations

: : \_r‘arlables-: Options... |
W Marital status [marital] | f Age in years [age] _
f Level of education [ed] f Income after the progra...
ﬁ Mumber of people inhow..
& Program status [prog]

Cortrolling for:

f Income before the progr...

£

Test of Significance
(3) Twodalled () Opetaied

Display actual significance level

| L8].4 ” Paste || Reset || Cancel || Help

Correlations

Income after

Control Variables | Age in years| the program
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Income before |Age in years Correlation 1.000

the program Significance (2-tailed)

Df

Income after the |Correlation

program Significance (2-tailed)

Df

The relationship between the age and income after the program, controlling for the
income before the program is done using the partial correlation and the correlation value
is -0.019 and level of significant value is 0.551 which is greater than 0.05 so there is no

significant relationship between age and income after the program.

Correlations

GOLD GDP in Savings in %

PRICE Billions of GDP

GOLD PRICE Pearson
.959™ 639"
Correlation

Sig. (2-tailed)

N
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GDRP in Billions Pearson

Correlation

Sig. (2-tailed)

N

Savings in % of Pearson

GDP Correlation

Sig. (2-tailed)

N

**_Correlation is significant at the 0.01 level (2-

tailed).

*, Correlation is significant at the 0.05 level (2-tailed).

Correlations

Control Variables GOLD PRICE | Savings in % of GDP

GDP in Billions GOLD PRICE Correlation 1.000 -.519

Significance (2-tailed) . 102

Df 9

Savings in % of GDP Correlation

Significance (2-tailed)

Df
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REGRESSION

PURPOSE:
The general purpose of regressions is to learn more about the relationship between one
independent and one dependent variable.
ASSUMPTION:
e The variables must be linear.
e The variables must be normally distributed.

HYPOTHESIS:

Null hypothesis Ho: There is no significant relationship between the variables.

Alternate hypothesis H1: There is a significant relationship between the variables.

PROCEDURE:

STEP 1: Open the database; say Family Income and Total Monthly savings.
STEP 2: To run a linear regression analysis
Analyze =2 Regression = Linear.

STEP 3: Linear regression dialog box appears as below.
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E Linear Regression

Dependent:
¥ Tetal income [tatalin] g | Total manthiy saving {totsaw]

Block 1 of 1

Incependert(s):
¥ Total income [totalin]

Method:  |Enter

|—| Selection Variakle:

|_| Case Labels:

|
WS Weight:

EN |

QK || Paste || Reszet || Cancel || Help |

Select Total monthly saving as a dependent variable
Select Total income as a independent variable

Click plots

Select histogram and normal probability plot

Clicks Continue.

Click save in the linear regression dialogue box
Select standardize in the predicted value group

Click Continue.

Model Summary®

Adjusted R | Std. Error of

R R Square Square the Estimate

4042 163 162 5210.879
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Model Summary®

Adjusted R | Std. Error of

R R Square Square the Estimate

4042 163 162 5210.879

a. Predictors: (Constant), Total income

b. Dependent Variable: Total monthly saving

Sum of

Squares Mean Square

Regression

2.909E9

2.909E9

107.138

Residual

1.493E10

2.715E7

Total

1.784E10

Residuals Statistics?

Minimum

Maximum

Mean

Std.

Deviation

Predicted Value

4974.83

29091.34

8234.37

2297.768

Residual

-2.409E4

1.833E4

.000

5206.148
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Std. Predicted

Value

Std. Residual -4.623 3.518

a. Dependent Variable: Total monthly saving

Coefficients?

Unstandardized Standardized

Coefficients Coefficients

B Std. Error Beta

(Constant) 3281.033 527.447

Total income 161 .016

a. Dependent Variable: Total monthly saving
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Histogram

Dependent Variable: Total monthly saving

Mean =-2.26E-16
Stel. Dev. =£I.EIEIEI

1N

Frequency
[}
]
1

I
=1
1

’_r

] I
-2 0 2

Regression Standardized Residual

MNormal P-P Plot of Regression Standardized Residual

Dependent Variable: Total monthly saving

1.0

Expected Cum Prob

T T T
0.4 0.6 0.8

Observed Cum Prob
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The common regression equation is y=a + bx
The effect of Total income on total monthly saving is given by the
regression equation,
total monthly saving =3281.03 + (0.161) Total income.
Y is the total monthly saving and A is a constant value.
X Total income on.
B is the coefficient for the variable x.
’a’ 1s constant value which is the contribution made by all other factors for

determining the propensity to leave.

MULTIPLE REGRESSIONS

PURPOSE:

The general purpose of regressions is to learn more about the relationship between one

dependent and more than one independent variable.
ASSUMPTION:

e The variables must be linear.

e The variables must be normally distributed.

HYPOTHESIS:

Null hypothesis Ho: There is no significant relationship between the variables.

Alternate hypothesis H1: There is a significant relationship between the variables.

PROCEDURE:
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STEP 1: Open the database, say GOLD.
STEP 2: To run a linear regression analysis
Analyze = Regression - Linear.

STEP 3: Linear regression dialog box appears as below.

E Linear Regression &

Dependent: |
l¢¥ GOP in Bilions [GOP)] | | ™ | [ colD PRICE [GOLD] -
ﬁ Savings in % of GDP [G... Plots= ... |

Statistics. ..

Elock 1 of 1
& Inflation (GOP Deflstor) [... S Save...

f Real Interest Rate % [RIR]

f GDP per Capita (USE) [ Independent(=):

&5 Money Supply (% of GO & GDP in Bilions [GOP]
| > | & Savings in % of GOP [GDP_S]
| | inflation (GOP Deflstor) [GOP_]

COptions...

tethod: |Eriter

| Selection Yariahle:

(>
(>

| Case Labels:

|
WS Weight:

B |

(8] 4 || Paste || Eezet || Cancel || Help |

Select gold price as a dependent variable
Select GDP in Billions, Savings in percentage of GDP, Inflation,Real Interest
Rate ,GDP per Capita and Money Supply as a independent variable

Clicks Continue.
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Model Summary

Adjusted R | Std. Error of

R Square Square the Estimate

999 998|  336.22947

R is the correlation, its value is 0.999 and R square is degree of determination, its value is
0.999.The degree of determination shows the extent to which GDP in Billions, Savings in
percentage of GDP, Inflation, Real Interest Rate, GDP per Capita and Money Supply

influences the gold price. Here the gold price is determined to an extent of 99.9% by

GDP in Billions, Savings in percentage of GDP, Inflation, Real Interest Rate, GDP per

Capita and Money Supply.

Sum of

Squares Mean Square

Regression 5.040E8 8.400E7| 743.036

Residual 565251.275 113050.255

Total 5.046E8
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ANOVA table shows that the significant value is less than 0.01, which means dependent

variable that is good price is significantly predicted by independent variables namely
GDP in Billions, Savings in percentage of GDP, Inflation, Real Interest Rate, GDP per

Capita and Money Supply at 99 % of confidence level.

Coefficients?

Unstandardized Standardized

Coefficients Coefficients

B Std. Error Beta

(Constant) 9912.561 | 6296.821

GDP in Billions 11.616 1.727

Savings in % of GDP -387.496 86.602

Inflation (GDP
-112.438 197.335
Deflator)

Real Interest Rate % -239.964 204.224

GDP per Capita 11.810 902

Money Supply (% of

GDP)

a. Dependent Variable: GOLD PRICE

The common regression equation is y=a + bx
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The effect of GDP in Billions, Savings in percentage of GDP, Inflation, Real Interest
Rate, GDP per Capita and Money Supply on gold price is given by the regression
equation,

Gold Price = 9912.561+ 11.616(GDP in Billions)-387.496 (Savings in percentage of

GDP) +11.810 (GDP per Capita)

@ Linear Regression

Dependent:

|§ Propensity to leawve [soore]
Block 10f 1

é Ay morthly minutes [mi...
é Aseerage manthly bill [kil]

é Pct used for business ..
é YEars using our service...
é Houszehold income (199...

MeExt

Incependentis):
é Ayg manthly minutes [minutes]

[»]

Method  |Enter

— | Selection Variable:
E3

|_ Case Labels:

T WLSWeight:
E3

Ok

|| Paste || Reset H Cancel H Help ‘

Model Summary

R R Square

Adjusted R

Square

Std. Error of

the Estimate

.608? .369

367

10.60350

a. Predictors: (Constant), Avg monthly minutes
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ANOVAP

Sum of

Squares Mean Square

Regression 16322.916 16322.916| 145.177

Residual 27883.691 112.434

Total 44206.607

Coefficients?

Unstandardized Standardized

Coefficients Coefficients

B Std. Error Beta

(Constant) 2.434

Avg monthly

minutes

a. Dependent Variable: Propensity to leave
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@ Linear Regression
i

Dependent:

‘& Al monthly minutes [mi... - ‘& Propensity to leave [score]
ﬁ} Average morthly kill [kil] Block 1 of 1

ﬁ Pct used for business [...
& YEars using aur service. ..
ﬁ Household income (199, Inclependent;=):

- ﬁ Pt uzed for buziness [busineszs]

| * | ﬁ Years using our service [los)
— lﬁ Househald income (19958] [incorme]

Method:  |Enter

Selection Variakble:

hdll

Caze Labels:

WYL= Weight:
hdll

Ok J| Paste || Reset || Cancel || Help |

Model Summary®

Adjusted R | Std. Error of

R Square Square the Estimate

.388 375 10.53014

Sum of

Squares Mean Square
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Regression

17150.933

3430.187

30.935

Residual

27055.674

110.884

Total

44206.607

Coefficients?

Unstandardized

Coefficients

Standardized

Coefficients

B Std. Error

Beta

(Constant)

4.476

Avg monthly minutes

017

Average monthly bill

.042

Pct used for business

.088

Years using our service

1.210

Household income

(1998)

a. Dependent Variable: Propensity to leave
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Residuals Statistics?

Minimum

Maximum

Mean

Std.

Deviation

Predicted Value

21.4919

68.8849

41.5395

8.29935

Residual

2.65226E

1

27.97231

.00000

10.42388

Std. Predicted

Value

Std. Residual

-2.519

2.656

a. Dependent Variable: Propensity to leave
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Histogram
Dependent Variable: Propensity to leave

Mean =-2.33E-15
Std. Dev. =099
M =250

[
o
L

Frequency
[
=
1
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_I--F"T':
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3
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Regression Standardized Residual

Mormal P-P Plot of Regression Standardized Residual

Dependent Wariable: Propensity to leave

1.0

Expected Cum Prob

T T T
0.4 [w =] 0.8

Observed Cum Prob
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CLUSTER ANALYSIS

PURPOSE:

Cluster analysis is a technique that is used to classify objects or cases into relative groups

called clusters. In Cluster Analysis, there is no prior information about the group or

cluster membership for any of the objects.

ASSUMPTIONS:
e Representative ness of sample.

e No multi collinearity.

PROCEDURE:
STEP1: Open the database, say cluster-criteria.
STEP2: To run a cross tab analysis, from the menu choose:
Analyze >K-means cluster

STEP3: The K-means cluster analysis dialog box appears as shown.
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@ K-Means Cluster Analysis

“ariables:
ng Choice Criteria [factciu] f Convenience [facfact1]
& Risk Protection [facfact2]
& Return [facfactd]
| & ntterrate Investment [factactd]

K2

Label Cases by

Mumber of Clusters: Method

() herate and classity () Classity only
Cluster Centers

[ Read initisl:

[ wirite final:

| %4 || Paste | | Reset || Cancel | | Help |

STEP: 4 Select Convenience, Risk Protection, Return and Alternate Investment as
variables.

STEP: 5 Click save > Select cluster membership

STEP: 6 Click Options > Select ANOVA Table.

STEP: 7 Click Ok.

The investors can be classified into three categories based on choice criteria. The

investors are classified into three segments because the difference between the

coefficients is significant only on three cases on the hierarchical cluster. For the purpose

of classification of investors K-Means cluster is used.

FINAL CLUSTER CENTERS

Cluster

COMPUTER APPLICATIONS IN BUSINESS




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION
Manonmaniam Sundaranar University, Tirunelveli

Convenience 3.86 3.60 2.80

Risk Protection 4.06 4.02 2.76

Return 3.73 2.95 291

Liquidity 359 269 281

Cluster Error

Mean Square Mean Square

Convenience 51.041 .238 214.172

Risk Protection 87.004 .245 355.066

Return 43.523 216 201.316

Liquidity 48.977 232 211.487

Table-shows the mean values for the three clusters which reflect the attributes of each
cluster. For instance, the mean value of the convenience and risk protection for the first-

cluster are 3.86 and 4.06 respectively. This means that the first cluster people are more

apprehensive about risk. It is also noted from the table that no particular factor is heavily

loaded on any particular cluster segment. The rank of the clusters on every factor is also

given in the table. The description of all three clusters along with the label is given above.

Number of Cases in each Cluster

Cluster 238.000
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172.000

142.000

Valid 552.000

Missing .000

Rational Investors

The first cluster has high mean value in all the factors which are used to evaluate an
investment instruments. This cluster is ranked first in all the four factors. The average
score of this cluster is 3.81. This means that people under this segment strongly agree
with all the requirements needed for any good investment instrument. Since this segment
considers all the criteria before taking investment decision, this group can be designated

as Rational Investors.

Normal Investor

The second cluster can be designated as Normal Cluster because it has secured Il rank in
the mean values of factors like convenience, risk protection and return criteria and 111
rank in liquidity criteria. This segment of people agrees with convenience and risk
protection because their mean score is more than three in those criteria. More
particularly, this segment looks for more risk protection and less liquidity. This segment
of people is the most suited for small saving instruments, because small saving
instruments are long term in nature and the much less needed liquidity is missing and

these schemes are offered by Government which gives much needed risk protection. The
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average mean score of this people is 3.32 which means that they are just above normal in

any requirements they look from any investments.

Irrational Investor

The mean values of all the four criteria in this segment is less than three and the average
of all the criteria is also less than three. This means that this segment of people do not
consider any factor much seriously before taking any investment decision. Any rational
investor considers at least some factors before choosing any investment avenue. But this
segment of people does not consider any factor which means that they are not rational. In
the Liquidity factor, this segment has secured Il rank. The normal investors are not giving
big consideration to the liquidity factor because liquidity criteria will not add any value to

the investment.

The final cluster centers table shows that the three clusters differ in mean value of all the
four criteria. The analysis of variance (Table-12) indicates that the difference exists
among the three clusters in the mean values are significantly different. The significant
value for all the four criteria is 0.000. This means that all the four factors have significant

contribution on dividing people into three segments based on choice criteria.

Table-13 indicates that there are around 238 investors out of 552 investors in cluster I
which is the rational investor group and 172 out of 552 investors are in normal investor
group. This means that around 43 percent of investors are rational investors and 31

percent of investors are normal investors. Both rational and normal investors give high
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importance to risk protection which means around 74 percent of investors will not go to
equity market, where there is high risk component involved due to market fluctuation. As
long as there is a risk component in capital market, the major chunk of investor will not
participate in that market. This leads to the conclusion that even in future money flow
into the capital market will not increase.

AWARENESS CLUSTER

Final Cluster Centers

Cluster
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Cluster Error

Mean Square Mean Square

Level awareness in
79.905 1.022
NSC

Level awareness in

PPF

POMIS 210.539 . 258.904

KVP 154.798 . 205.399

POTD 253.922 . 706.191

POSA 258.438 . 560.532

PORD 251.625 . 505.865

Number of Cases in each

Cluster

Cluster 43.000

238.000

271.000

Valid 552.000
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Number of Cases in each

Cluster

43.000

238.000

271.000

Valid 552.000

Missing .000

DISCRIMINANT ANALYSIS
PURPOSE
To find out the variable which significantly influences the segmentation. Otherwise to
find out the variable which is the reason for such segmentation.
There should be only one dependent variable and it should be category. There can be any

number of independent variable and that should be metric.

PROCEDURE
STEP1: Open the database, say Motives Discriminate.
STEP2: To run a cross tab analysis, from the menu choose:

Analyze >Discriminate
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EE] Motive_Discriminate sav [DataSetl] - SPSS Data Ed
File Edit “iew Data Transform | Analyze | Graphs  Utiities Add-ons  Window  Help
=D o iImEE s S ERE %O W

| Mame Type | Width | Decimalsl Lakel | Walues |
motfact1 Mumeric

Mligsing ‘ Columnsl Align | heasure |
Self Support Mone Mone E) = & Scale

Family Oriented  Mone Mone 8 Right & Scale
Saving Motives {1, Highly M... MNone 5 = Right &% Mominal

motfact2 Mumeric =] 2

mocl3 Mumeric =] o

DO |0 W N[

4]

IERl M S

STEP3: The Discriminate analysis dialog box appears as shown

@ Discriminant Analysis

Grouping Variable:
mocl3e1 3)

Stetistics... |

Classify... |
ndependent s B

&¥ Self Support [motfact!]
ﬁ Family Oriented [motfact)

Save... |

'3:5‘:3' rter independents together

[ Use stepavise method
Selection Variable:

* |

Ok _” Paste || Reset || Cancel || Helg

Testing suitability of segmentation
The investors are classified into three clusters based on the level of motives they
have for savings. The three identified clusters are highly motivated clusters, self centered

clusters and least motivated clusters. Around 37 percent of investors are treated as highly
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motivated people and 25 percent of investors are least motivated people and 38 percent of
the investors are self centered people. The next primary question is whether the identified
clusters are genuine and each cluster differs from the other significantly and both motives
play a role in separating investors into three segments. For this purpose, reliability of the
cluster classification and its stability across the samples have to be verified. Several
authors have recommended the use of discriminant analysis for cross validation (Field
and Schoenfeidt 1975; Rogers and Linden 1973).

TESTS OF EQUALITY OF GROUP MEANS

Wilks' Lambda F dfl df2

Self Support 0.607 177.428 2 549

Family Oriented 0.358 492.222 2 549

Wilks' lambda is the ratio of the within-groups sum of squares to the total sum of
squares. Wilks' lambda is very small for family orientation which means that there is a
strong group difference among the three motive segmentation in a family orientated
motive. The mean values of family oriented motive are significantly different among the
three segments. Wilks’ Lambda for self support motive is comparatively high because
there is no much difference between the first segment and the third segment in the mean
values of self support motive. The F statistic is a ratio of ‘between-groups variability’ to
the ‘within-groups variability’. The value of F ratio with respect to degrees of freedom is
very significant which is indicated in the significance value. The low value of

significance indicates that there exists a significant difference in motivational levels
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among the three groups. The above two facts explain that the present segmentation is
right and there exists a significant group difference.

EIGEN VALUES

% of Cumulative Canonical
Function [Eigen value
Variance % Correlation

1.809 75.9 : 0.802

0.573 24.1 0.604

The Eigen value is the ratio of ‘between-groups sum of squares’ and ‘within-
groups sum of squares’. The largest Eigen value corresponds to the maximum spread of
the groups’ means. Small Eigen accounts for very little of the total dispersion. The Eigen
for first discriminant function is very high when compared to second function. For the
three clusters, two discriminant functions can be formed and there will be two canonical
correlations. The canonical correlation is a tool used to measure the association between
discriminant functions and the two motives. The canonical correlation between the first
function and the two motives is very high which is 0.8, but canonical correlation for the
second function is only 0.6. The Wilks Lambda table indicates that both canonical
correlations are significant.

WILKS' LAMBDA

Test of Wilks' Chi-

Function(s) | Lambda | square

1through2| 0.226 | 814.879
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0.636 | 248.443 0.000

Wilks' lambda for the first function is 0.226 which indicates that the group means
are different in the first function which is the function of family oriented motive and
Wilks lambda for second function is 0.636 which also indicates that group means are
different but not to the extent of the first function. The second function is the function of
self support motive where the group difference is less. A chi-square transformation of
Wilks' lambda is used along with the degrees of freedom to determine the degree of
significance. The significance value is small for the first function which is 0.000. It
indicates that group means differ very much significantly in the first function which is
represented by family oriented motive. The Chi-square value for the second function is
248.443 which is significant by 0.000 level.

STRUCTURE MATRIX

Function

Family Oriented

Self Support

The structure matrix indicates that two functions can be formed for the three
clusters. These two domain functions can be used separately, to describe the
characteristics of population. The two domain functions are Z1 = 0.994 * Family oriented

motive, Z2 = 0.970 * Self Support motive.
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GROUP CENTROIDS FOR MOTIVE CLUSTERS
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The above group centroids diagram shows that all the three clusters are distinctive

clusters having different group centroids and different mean values. The cluster members

are aligned separately from other group members.
EXTENT OF CORRECT CLASSIFICATION

Predicted Group Membership
Self

Saving
Least

Highly

centered

Motives
Motivated

Motivated
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Highly
Original
Motivated

Least

Motivated

Self centered

Highly

Motivated

Least
2.2
Motivated

Self centered 0.0

98.9% of original grouped cases are correctly classified.

The extent of correct classification table measures the degree of success of the
classification on the basis of motives. The number and percentage of cases correctly
classified and misclassified are displayed in the table. Here, 203 cases or 98.5 percent of
highly motivated segments are correctly classified and only 3 cases are included into self
centered segment. In the least motivated segment 134 cases accounting for 97.8 percent
are correctly classified. In self centered, it is 100 percent correctly classified. From this, it
can be clearly inferred that the segmentation of investors based on motive is correct by

more than 98.9 percent.

FACTORS INFLUENCING EFFICIENCY OF BANKS

In the earlier section, it was seen that the banks are divided into three segments

such as highly efficient, above average and below average based on their technical
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efficiency. Now, it is necessary to check whether such classification is right and all the 8
determinants such as Age of the bank, Number of branches, Business per employee, Cost
of funds, Capital adequacy ratio, Non-performing assets, Deposits and Number of
employees have influence in making such classification. For this purpose discriminant
analysis is used. All the 60 commercial banks in India are considered for the analysis.
The category of banks is considered as a dependent variables and all others are taken as
independent variables for the purpose of discriminant analysis.

STRUCTURE MATRIX

Function

1 2

Business Per Employee | .850* -0.085

COF -.596* | 0.497

Age -.180* | -0.093

No of employees -.113* | 0.092

Deposit -.108* | 0.026

NPA 0.150 410*

No of Branches -0.152 | .190*

CRAR 0.080 -.093*

As there are three categories, two linear equations can be formed. The structure
matrix table (Table 9) contains co-efficient for the variables. The two domain functions can
be written by using co-efficients in the structure matrix table. The functions are

Z1 =0.850 X1 -0.596 X2 -0.180 X3 - 0.133 X4 - 0.108X5 and

Z2=0.410 Y1+ 0.190Y2 - 0.093Y3
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Where X1 = Business per employee, X2 = Cost of funds, X3 = Age of the bank, X4 =
Number of employees, X5 = Deposits, Y1 = Non-performing assets, Y2= Number of
branches, Y3 = Capital adequacy ratio. The first function is the function of Business per
employee (0.850) and Cost of funds (-0.596).

EIGEN VALUES

Eigen | % of Cumulative Canonical

Function | value Variance | % Correlation

1 2.450° 88.7 88.7 0.843

2 0.312% 11.3 100.0 0.488

The eigen value for the first function is very high when compared to the second
function (Table 10). The first function describes 88.7 percent of variance among banks. The
eigen value for the second function is very less and it describes only the remaining 11.3
percent of variance. To understand more about discriminant function, canonical correlation
is used. The canonical correlation measures the association between the discriminant
functions and the 8 determinants. The canonical correlation between the first function and 8
determinants are very high but canonical correlation for the second function is only 0.488
but that itself is significant enough to describe the existence of relationship. As already
stated, the first function describes about 88.7 percent of the variance in efficiency among
banks. This means that these three segments differ significantly in Business per employee
and Cost of funds.

WILKS LAMBDA

Test of Wilks' Chi- df

COMPUTER APPLICATIONS IN BUSINESS Page 111




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION
Manonmaniam Sundaranar University, Tirunelveli

Function(s) | Lambda square

1 through 2 | 0.221 80.802

2 0.762 14.543

Table 11 contains Wilks’ lambda, the chi-square, its degrees of freedom and its
significance level. The small values of Wilks’ lambda indicate strong group differences
among mean values of 8 determinants. The significance value of 0.000 indicates that the

group differences are significant

TERRITORIAL MAP
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Function 2
—16.0 " # —-4.0
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From the territorial map (Figure 1) it is clear that function one distinguishes between
segments one (below average) and two (above average) and also two (above average) and
three (highly efficient). Hence, function one explains 88.7 percent of variance among
banks. The discriminant function two distinguishes between first group and third group
only.

CANONICAL DISCRIMINANT FUNCTIONS
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The discriminant diagram (Figure 2) shows that three segments are different groups
having clear demarcation and the segments differ mainly on function one. Hence, it can
be inferred that the characteristics of three segments are different with respect to their
determinants.

STEP WISE DISCRIMINANT ANALYSIS

Step wise discriminant analysis is used to find out the most significantly influencing
variable. In the procedure, instead of Enter independents together, Use stepwise method
should be selected.

By using correspondence analysis and analysis of variance, it is stated that age,
experience and tax payment have influence on determining perception of an individual.
Now it is necessary to find out which is the most significantly influencing variable on
perception from the age, experience and tax payment. For this purpose step wise
discriminant function can be used. Age, experience and tax payment are the independent
variable and perception cluster is the dependent variable.

Perception towards Small Saving
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PERCEPTION TOWARDS SMALL SAVING

Age

Range of Small
Saving Investment

Work Experience

Perception

Investment
Experience

Risk Bearing
Capacity

Tax Deduction

As there are three clusters in perception two discriminant functions can be

developed to study the level of perception of investors.

STRUCTURE MATRIX

Function

Experience

Tax Deduction

Age
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Though two functions can be formed, one function is a redundant function here
because the entire three variables are highly loaded in the first function itself. The
discriminant function which can be formed from the above structure matrix is Z1 = 0.908
* Experience + 0.791 * Tax deduction + 0.634 * Age.

VARIABLES IN THE ANALYSIS

Fto
Step Tolerance
Remove

1 Experience| 1.000 4.219

Though all the three are important variables, it is necessary to know, which is the
most important discriminating variable that decides the level of perception of individual.
This can be identified by using stepwise discriminant analysis. The discriminant analysis
shows that experience is the only important discriminating factor.

VARIABLES NOT IN THE ANALYSIS

Min. Wilks'
Tolerance F to Enter
Tolerance Lambda

Age 1.000 1.000 2.088 0.991

Experience 1.000 1.000 4.219 0.983

Tax Deduction | 1.000 1.000 3.393 0.986

Age 0.494 0.494 0.004 0.983

Tax Deduction | 0.759 0.759 1.646 0.976

To begin with, all the three variables will not be included for the analysis and in

the first step, experience is taken for analysis and other two are not included for the
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analysis. The analysis is over with the first step itself. This means that experience is the

only discriminating variable.

-7
FACTOR ANALYSIS

PURPOSE:
Factor analysis is a technique that is used to reduce a large number of variables into fewer
numbers of factors. Factor analysis extracts maximum common variance from all

variables and puts them into a common score.

ASSUMPTION:

e Factor analyses assume that there is no outlier in data.

e In factor analysis, the case must be greater than the factor.
Factor analysis is an interdependency technique. There should not be perfect
multicollinearity between the variables.
Factor analysis is also based on linearity ASSUMPTION. Non-linear variables
can also be used.

e Interval data are assumed for factor analysis.

PROCEDURE:

STEP1: Open the database, say factor data.
STEP2: To run a principal components factor analysis,

Analyze---->data reduction---->Factor
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STEP3: The factor analysis dialogue box appears

actor Analysis

Wariables:

Descriptives...

f Periodic review is n...

& Procedure for gettin... Extraction...

é) Place of investmenti..| Sooes
é) | am comfortable wit... |

|
|
& Getting capital rede... [ Rotation...
& There is no hindranc... ‘ =
|

Options...

J
|
J
|
|

é9 Sufficient small savi...

Selection Variable:

|

| OK J[ Paste H Reset H Cancel H Help l

STEP: 4 select the variables that are to be factored.

% Factor Analysis: Descriptives

Statistics

[ ] Uniivariate descriptives

Initial solution

Correlation Matrix
[ coefficients [ Jinverse
[ ] significance levels || Reproduced
[ ] Determinant [ ] anti-image
KMO and Bartlett's test of sphericity

l Continue “ Cancel H Help

STEP: 5 click descriptive > select KMO AND BARTLETT'S TEST.

STEP: 6 Click Continue.
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STEP:7 Click extraction > If required select no of factor.

STEP: 8 Click Continue.

. %% Factor Analysis: Rotation X

Method

() None () Quartimax

® () Equamax

() Direct Oblimin () Promax

Display-

[v| Rotated solution [ | Loading plot(s)

Maximum lkerations for Convergence: L2§

l Cortinue J‘ Cancel H Help ]

STEP: 9 Click rotations > select varimax rotation.

%% Factor Analysis: Options

rMissing Values -

(3) Exclude cases listwisel

() Exclude cases pairwise

() Replace with mean

Coefficient Display Format
Sorted by size

Suppress absolute values less than:

] Continue “ Cancel 7[ Help 7

STEP: 9 Click options > select Sorted by size varimax and Suppress absolute value
less than .40
STEP: 10 Click Continue.

STEP: 11 Click Ok.
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The investors use several criteria to evaluate an investment instrument. Here, for the
purpose of study 19 commonly used criteria were taken. The criteria were presented in
the form of statements with five point Likert scale to collect opinion from investors. The
factor analysis has been used to reduce the data collected on 19 variables into smaller
number of manageable variables by exploring common dimensions existing among the
variables.

KMO AND BARTLETT'S TEST

KMO and Bartlett's Test

Kaiser-Meyer-Olkin Measure of

Sampling Adequacy.

Chi-Square 3.783E3

Bartlett's Test of Sphericity df 171

Sig. 000

High value of KMO (0.873 > .05) of indicates that a factor analysis is useful for the
present data. The significant value for Bartlett’s test of Sphericity is 0.000 and is less than
.05 which indicates that there exist significant relationships among the variables (Table-
1). The resultant value of KMO test and Bartlett’s test indicate that the present data is

useful for factor analysis.

Total Variance Explained
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Initial
Eigenv

alues

Extractio
n Sums of|
Squared

Loadings

Rotation
Sums of

Squared

Loadings

Component

% of

Variance

Cumulati

ve %

Total

% of

Variance

Cumulati

ve %

Total

% of

Variance

Cumulati

ve %

32.352

32.352

32.352

32.352

22.771

22.771

9.784

42.137

9.784

42.137

11.676

34.447

7.356

49.492

7.356

49.492

10.920

45.367

6.093

55.585

6.093

55.585

10.218

55.585

4.966

60.550

4.769

65.319

4.706

70.025

4.164

74.189

3.570

77.759

3.075

80.834

2.982

83.816

2.578

86.394

2.544

88.938

2.394

91.332

2.329

93.661
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16 352 | 1.854 | 95.515

17 320 | 1.686 | 97.201

18 278 | 1.462 | 98.663

19 254 | 1.337 | 100.000

Extraction Method: Principal Component Analysis.

The next step in the process is to decide about the number of factors to be derived. The rule of
thumb is applied to choose the number of factors for which ‘Eigen values’ with greater than unity
is taken by using Principal Component Analysis method. The Component matrix so formed is
further rotated orthogonally using Varimax rotation algorithm which is the standard rotation

method (Kaiser, 1958). All the statements are loaded on the four factors.

Rotated Component Matrix

Component

1

There is no hindrance in getting information about small saving schemes

Sufficient small saving schemes are available to meet my requirement

Place of investment in small savings is conveniently located

| am comfortable with service provided by agents and post offices

Procedure for getting regular return is simple in postal schemes

Getting capital redemption is easy in postal saving

Small savings involves less procedure while making investment

Periodic review is not necessary in small saving

| am investing in small saving because it has protection from Govt
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| am investing in small saving because there is no risk

| put money in Small Savings instruments only to save tax

| am getting good return from small saving instruments

| prefer small savings because of sentimental value attached to the nations

Consistency of return is more important than earning more than market

return

Investing in small saving will help me retire more secure way

\When the equity market is uncertain, I go for small saving schemes

Problem of liquidity forces me to go for other form of Investment

If there is any capital loss in any other investment then | will switch over to

Small saving securities

| prefer long term investment over short term investment

Extraction Method: Principal Component Analysis.

Rotation Method: Varimax with Kaiser Normalization.

A Rotation converged in 6 iterations.

The total variance accounted for, by all the four factors with Eigen value greater than 1 is 55.58
percent and the remaining variance is explained by other variables. Among the four factors, the
first factor accounts for around 22 percent of variance which is the prime criteria considered by
any investor while evaluating an investment instrument

The statements are converted into 4 factors using factor analysis.

The following 8 statements are converted into a single factor. (12-19)

e Sufficient small saving schemes are available to meet my requirement

e There is no hindrance in getting information about small saving schemes
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Place of investment in small savings is conveniently located
I am comfortable with service provided by agents and post offices
Procedure for getting regular return is simple in postal schemes
Getting capital redemption is easy in postal saving
Small savings involves less procedure while making investment
Periodic review is not necessary in small saving
The following 3 statements are converted into a single factor. (1, 4, 5)
e | am investing in small saving because it has protection from Govt
e | am investing in small saving because there is no risk
e | put money in Small Savings instruments only to save tax.

The following 4 statements are converted into a single factor. (2, 3, 8, 11)

| am getting good return from small saving instrument

| prefer small savings because of sentimental value attached to the nations
Consistency of return is more important than earning more than market return
Investing in small saving will help me retire more secure way

The following 4 statements are converted into a single factor. (6, 7, 9, 10)

When the equity market is uncertain, | go for small saving schemes
Problem of liquidity forces me to go for other form of Investment

If there is any capital loss in any other investment then | will switch over to
Small saving securities

e | prefer long term investment over short term investment
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The four factor components are christened as Convenience, Risk protection, Return and
Liquidity based on the statements loaded under each factor. The descriptions of these four
factors with labels and factor loadings for various statements included as variables are
given in the tables 4,5,6 and 7. Table 3 gives particulars about number of people who are
interested (have agreed upon) and not interested (have disagreed upon) for every

investment criteria.

FACTORS AND VARIANCE EXPLAINED

Criteria % Preferred | Mean Value | % Variance Explained

Convenience 61% 35 22771

Risk Protection 67% 3.7 11.676

Return 44% 3.2 10.920

Liquidity 29% 3.1 10.218

Narayanan

Depending upon the relationship among the variables, the variables can be grouped. For
the purpose of grouping Factor analysis is performed. As KMO (Kaiser-Meyer-OlKkin
Measure of Sampling Adequacy) value is 0.694 and significant value in Bartlett’s test is

0.00, Factor analysis can be performed for the taken variables.

MO and Bartlett's Test

Kaiser-Meyer-Olkin Measure of Sampling

Adequacy.
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Bartlett's Test of Approx. Chi-Square 1.219E3

Sphericity Df 36

Total Variance Explained

Extraction Sums of Squared Rotation Sums of Squared

Initial Eigenvalues

Loadings

Loadings

% of

Variance

Cumulativ

e %

% of

Variance

Cumulativ

e %

% of

Variance

Cumulativ

e %

38.289

38.289

38.289

38.289

34.714

34.714

28.394

66.682

28.394

66.682

30.102

64.817

11.920

78.602

11.920

78.602

13.785

78.602

9.733

88.335

6.078

94.414

2.465

96.878

2.025

98.904

1.073

99.977

.023

100.000
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The factor analysis result shows that the nine Fulmer variables can be grouped into three
variables. If the nine variables are reduced into three then the total variance explained is
78 percent which is very significant. This means that the nine variables can be reduced

into two variables.

Component Matrix?

Component

2

Debt / Total Assets

Working Capital / Total Debt

Log EBIT / Interest

Sales / Total Assets

Log Tangible Total Assets

Retained Earnings / Total Assets

Current liabilities / Total Assets

Net Income before Taxes (EBIT) /

Equity

Cash Flow / Total Debt

Rotated Component Matrix?

Component
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Log EBIT / Interest

Working Capital / Total

Debt

Sales / Total Assets

Current liabilities /

Total Assets

Retained Earnings /

Total Assets

Log Tangible Total

Assets

Debt / Total Assets

Cash Flow / Total Debt

Net Income before

Taxes (EBIT) / Equity

The rotated component matrix shows that variables V9, V8 and V2 can be grouped into
first factor and variables V6, V1 and V7 and V5 can be grouped into second factor and
V4 and V3 can be put under third factor. The multidimensional scaling has also given the
same result. As the variables within the group are related, the number of variables can be

eliminated by taking one from one group. From the group one V9 can be taken which is
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EBIT/ Interest. V9 is very important variable because repaying capacity is mainly
depends upon interest coverage ratio (EBIT/Interest). In the group two V6 can be retained
which is calculated by Current Liabilities/ Total Assets. From the third group V4 (Cash
Flow/ Total Debt) can be taken. V9 and V4 are positive because rise in those ratios will
have positive impact on solvency whereas V6 is negative because increase in current
liabilities will have negative impact on solvency of the firm. The regression analysis is

performed to find new eq

CORRESPONDENCE

PURPOSE:
Correspondence analysis is a statistical technique that factors the categorical variable and

shows the dimensions or association of the categorical variable to each other.

ASSUMPTION:

Category assumption: In correspondence analysis, it is assumed that the discrete data
has many categories.

Negative values: In correspondence analysis, negative value is not considered.
Continuous data: In correspondence analysis, discrete data is used. If we are using

continuous data, then the data must be categorized into range.

HYPOTHESIS:

Null hypothesis HO- There is no significant association between two category variables.
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Alternate hypothesis H1- There is significant association between two category variables.

PROCEDURE:

STEP 1: Open the database, say REINC-RETOTSA.
STEP 2: To run a cross tab analysis, from the menu choose:
Analyze >correspondence analysis
STEP 3: The correspondence analysis dialog box appears as below
STEP 4: Select reinc as the row value and define its range depending upon the
number of categories that it has.
STEP 5: select retotsa as the column value and define its range depending upon the

number of categories that it has.

@ Correspondence Analysis

Rlosn:

¥ Jreincgt 5)

| Define Range...

Calumn:
|retntsa(1 5)

| Define Range...

Ok || Paste || Reset || Cancel || Help
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@ Total Income
# Total Saving

20001 and above
[

L ]
20001 and above

upto 5000 1 DDI;I'1 -15000

upto 200008° o

20001-30000
30001 -40000

5001-10000 .

40001-350000
® 15001-20000
L]

The correspondence diagram illustrates that people who have higher level of income
group and their respective saving is high. people who have low level of income group

and their respective saving is low
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OPTIMAL SCALING

PROCEDURE:

STEP 1: Open the database, say MERGED.
STEP 2: To run a cross tab analysis, from the menu choose:
Analyze >optimal scaling
STEP 3: Click define
STEP 4: The optimal scaling dialog box appears as below
STEP 5: Select education and salary as the variables and define their range based on
the number of category that each variable has.

STEP 5: Click ok.

B Homogeneity Analysis (HOMALS)

@ o 2 Wariables: 0K
@ Institution [institut] educatio[1 4]

& Type of institution [t E salary(l 4] sl
& Department [depart] Reset
@ [Drezignation [desigh =

#» Experience in prese Cancel
@ Experience in thiz oo | =
@) Total teaching expe P
@ E=penence [reexp] Label Object Scores Plat(z] by:

C@) Induztny experience E
& Age in years [age] |

@ Age [reage)
#r Gender [sex] .
> Religion lrefigion] % Dimensions in Solution: |2_ Dptions...
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Optimal scaling:

D00-25000

M.Phil
a

18500-23000

D-18000 Ph.D

Ph.D pursuin 25000-36500 Salary
a

Y Educational Qualific

ation

In the above optimal scaling diagram the educational qualifications and salary are
grouped. It shows the relation between the various educational qualifications and the

salary that is earned by people having that educational qualification.

MULTI DIMENSIONAL SCALING

PURPOSE:
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In general, the goal of the analysis is to detect meaningful underlying dimensions that
allow the researcher to explain observed similarities or dissimilarities (distances) between

the investigated objects.

PROCEDURE:
STEP 1: Open the database, say Narayanan.
STEP 2: To run a cross tab analysis, from the menu choose:
Analyze >multi dimensional scaling
STEP 3: The multi dimensional scaling dialog box appears as below

STEP 4: select the various saving forms as the variables.

E Multidimensional Scaling ﬂ

“ariables: |T|
& Interest [INT] - i

& Retained Earnings [RE] & va |Qp1|T|
&7 Cash Flaw [CF] - & W5 -
& Total Assets [T4)] | Py | & B
& Total Sales [T5] ) [T
gé} Profit Before Interest... | .. ‘@9 Y8
& Equity [EQUITY] 7 & va
& Current Azsets [C4)]
& Profit Befors Tax PET)[w| | ¥ | |

Distances
(3) Dgta are distances

Shape... Sguare symmetric

() Create distances from data

| O || Paste || Eezet || Cancel || Help

STEP 5: click create distance from data
STEP 6: click measure and fix range 0 to 1 in standardize option and continue
STEP 7: click options and select group plot then continue

STEP 7: click ok.
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MULTIDIMENSIONAL SCALING DIAGRAM FOR CRITERIA

Multidimensional scaling diagram shows association among different instruments based
on factors considered while choosing different instruments. From the diagram it is clear

that v6 and v3, v1 and v7 are similar instruments preferred for similar reasons.
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CHI-SQUARE

URPOSE:

The main purpose of using a chi-square test for homogeneity

ASSUMPTION:

The two variables that are to be applied in chi-square analysis must be of type
category.

The total number of observation used in this test must be large i.e., n>=30.
Independence - The observations are always assumed to be independent of
each other. This means chi-square cannot be used to test correlated data (like:
matched pairs, panel data).

HYPOTHESIS:

Null hypothesis: HO- There is no significant association between the two variables.
Alternate hypothesis: H1- There is significant association between the two variables.

PROCEDURE:

STEP 1: Open the database, say Alice Current.
STEP 2: To begin the analysis from the menus choose

Analyze - Nonparametric Tests = Chi-Square
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STEP 3: The chi-square test dialog box appears
STEP 4: Select level of education as test variable

STEP 5: Click ok

B chi-Square Test x|

Te=t “ariable List:

W Auge @9 Reazonfortaking |
ﬁ Gender |
é Department
ﬁ Educsation
g? Plootyrs
ﬁ brandname
ﬁ recommend
é piolicies

£ stitfdeadines

Exact. . |

Options . . |

(=)

Expected Range
() Get from data

() Use specified range

Expected values
(@) &l categories equal

() Walues:

Cancel | |

Reason for taking

Observed N [Expected N| Residual

Pay benefits 16.7 -9.7

Designation 16.7
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Brand Image 16.7 -13.7

Career

Development

Job profile

Others

Total

Test Statistics

Reason for taking

Chi-Square [179.600a

df

Sig.

Null hypothesis is all reason are equally important for taking a job in a particular
company, In test statistics table significant value is less than 0.01 hence null hypothesis is
rejected so all reason are not equally important for taking a job in a particular company.
From the above table it is clear that career development is important criteria to taking a

job in a particular company.
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KOLMOGROV - SMIRNOV TEST

PURPOSE:

The Kolmogorov-Smirnov test is used to decide if a sample comes from a population

with a specific distribution.

HYPOTHESIS:

Null hypothesis Ho: The data follow a specified distribution

Alternate hypothesis H1: The data do not follow a specified distribution

PROCEDURE:

STEP 1: Open the database, say KS.
STEP 2. To begin the K-S, from the menu choose,
Analyze - Nonparametric Tests = 1-Sample K-S...

STEP 3: The Kolmogrov-Smirnov test window appears as follows.
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E One-5ample Kolmogorov-Smirnov Test

Test Yariable List:
f brandname

f recarmmend

f Reputation

f WorklifeBalance

g& Training

Test Distribution

Mormal [ | Unifarm
[]Poisson [ ] Exponential

| 0K || Paste || Reset || Cancel ||

Select the test variable.
Select Normal as the test distribution.

Click continues.

STEP 4. Click Ok in the Kolmogrov-Smirnov test dialog box.

One-Sample Kolmogorov-Smirnov Test

Brand |recommen |Reputatio| Work life | Trainin

name d n Balance

N 100 100

Normal Parameters® |Mean 3.61 . . 17.90

Std. Deviation .863 . 2.630

Most Extreme Absolute 244 . . 125

Differences Positive 190 : : 125
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Negative -.244 -.256 -.162

Kolmogorov-Smirnov Z 2.443 2.562 1.622

Asymp. Sig. (2-tailed) .000 .000 .010

Kolmogrov-Smirnov test, if the significance value is greater than 0.05 means the test
distribution is normal. In the above table work life balance and Training are normal
distribution because significant value is greater than 0.05. The distribution of Brand
name, recommend and Reputation are not normal distributed because significant value is
less than 0.05 hence for these variables we may use nonparametric techniques should be

employed to further analyze this variable.

OTHER NON-PARAMETRIC TEST

Non-Parametric tools Parametric tools

Man-Whitney U test Independent Sample t-test

Kruskal —wallis H ANOVA

Wilcoxon Paired t-test

Frierdman Repeated measures ANOVA

COMPUTER APPLICATIONS IN BUSINESS Page 141




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION
Manonmaniam Sundaranar University, Tirunelveli

RELIABILITY

PURPOSE:

Reliability is consistency of a measurement items. A measurement items are
high reliability if it produces consistent results under consistent conditions.

PROCEDURE:

STEP 1: Open the database, say Alice Current.
STEP 2: To begin the analysis from the menus choose
Analyze - scale - Reliability analysis

STEP 3: The reliability analysis dialog box appears

B Reliability Analysis PX

tems:

y brandname
y recommend
& policies
—— | stitideadines
f cooperation
& tranzparent
y grapevine

Statistics. ..

Modek | &lpha |

Scale label: |

STEP 4: Select measurement variables as items
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STEP 5: Select statistics and in descriptive select scale if item deleted

@ Reliability Analysis: Statistics 2

L Iv'\

Descriptives for Inter-ltem

[ tem [ ] correlstions
[ =cale [ ] covariances
Scale if item deleted

Summaries ANOVA Table

[ ] Means (3 pone

[ ] warisnces () Ftest

[] covariances () Friedman chi-zguare

[ ] correlstions () Cochran chi-square

|:| Hoteling's T-sguare |:| Tukey's test of additivity

|:| Imtraclass carrelation coefficient

Cortinue || Cancel ||

STEP 6: Continue

Before item removed

Reliability Statistics

Cronbach's

Alpha N of Items

516
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Item-Total Statistics

Scale Mean if

Item Deleted

Scale

Variance if

Item Deleted

Corrected

Item-Total

Correlation

Cronbach's
Alpha if Item

Deleted

brandname

21.43

8.672

293

461

recommend

2151

8.212

316

448

policies

21.39

8.745

.203

499

stiffdeadlines

21.83

9.456

041

577

cooperation

20.95

8.937

.283

467

transparent

21.40

8.404

393

425

grapevine

21.73

8.199

310

450

After item removed

Reliability Statistics

Cronbach's

Alpha

N of ltems

577

Item-Total Statistics
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Scale Mean if

Item Deleted

Scale

Variance if

Item Deleted

Corrected

Item-Total

Correlation

Cronbach's
Alpha if Item

Deleted

brandname

18.22

6.961

384

.502

recommend

18.30

6.354

443

469

policies

18.18

8.270

.037

.656

cooperation

17.74

7.366

.340

523

transparent

18.19

6.883

451

478

grapevine

18.52

6.899

309

535

Reliability Statistics

Cronbach's

Alpha

N of ltems

.656

Item-Total Statistics

Scale Mean if

Item Deleted

Scale

Variance if

Item Deleted

Corrected

Item-Total

Correlation

Cronbach's
Alpha if Item

Deleted

brandname

14.57

5.702

442

.588

recommend

14.65

5.119

.505

.553
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cooperation

14.09

6.103

393

transparent

14.54

5.766

475

grapevine

14.87

6.054

.259
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CANNONICAL CORRELATION USING STATA

Simple regression can be used when we have one dependent variable and one
independent variable and multiple regression can be used when we have one dependent
variable and more than one independent variable. If we have more than one dependent

variable and more than one independent variable then we can use cannonical correlation

1-Click the data in tool bar then data editor

[ Stata/SE10.0 - [Results]

2-Copy and paste the data in data editor and click preserve option
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[ Stata/SE10.0 - [Results]
@ File Edit Data Graphics User Window Help

Summaries, tables, and tests

Linear medels and related
Binary outcomes

Ordinal outcomes
Categerical outcomes
Count outcomes

Exact statistics

Endogenous covariates

Sample selection models
Multilevel mixed-effects models
Generalized linear models
Nonparametric analysis

Time series
Multivariate time series

Longitudinal/panel data

Survival analysis
Epidemiology and related

Survey data analysis

MANOVA
Cluster analysis Multivariate tests after MANOVA
Discriminant analysis Wald test after MANOVA

Resampling Factor and principal compenent analysis Hetelling's generalized means test

Power and sample size

Multidimensional scaling (MDS)
Correspondence analysis
Other Biplot

Postestimation Multivariate regression

Procrustes transformations

Procrustes overlay graph

Cronbach's alpha
Command

| Orthoganal and oblique rotations of a matrix

Postestimation reperts and statistics

Frstart @PutmyaTha\a\mura\.” CJ\ a Lj CANNONICAL COR... J ado Subashini ‘Eﬁas““’“w‘o'[“"" & |5 igim -

4-enter variables in first set of variable and second set variable and finally click ok

[ Stata/SE10.0 - [Results]
=
B-B6-68&-

canen - Canenical correlations

Model | byt/n | Weights | Reporting |

First set of variables

Second set of variables

—] First #of linear combinations to be displayed

I Do not subtract means when calculating comelations

@9 C o | G

Command

C:\Program Files\Stata SE 10

Frstart @PutmyaTha\a\mura‘.. / B9 cannonicaL co... | y . Subashini ‘Eg—ulstata:sno.o-mes.” 7 canon - Canonica .. & |5 a0 égiim -
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Final analysis out put of cannonical correlation in STATA

B Stata/SE 10.0 - [Results]

B File Edit Data Graphics Statistics User Window

B-E8-68 - O-68a

arg varlo) (varll wvarlz2)

-044B128

- 06856
-1324145

1.172844
290501
125

-4117528

- 7952205

correla
0.1419

Command

. 001
. 000

. 000
. 000
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- 5175109
-1.235406

—. 2400041

—-. 2043835

Prob=F
Q. 0000
Q. 0000
0. 0000
0. 0000
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STRUCTURAL EQUATION MODEL (SEM)

It contains measurement model and structural model. In measurement model relationship
between item and construct is measured. Item means statement. Construct means heading
under which the statement is placed. In structural model relationship between two

construct is measured.

To perform SEM analysis different software can be used such as LISREL (Linear
Structural Relations), AMOS (Analysis of Momentum Structures), PLS (Partial Least

Square), EQS (Equations), CALIS etc.

Different estimation techniques (Mathematical Programs) are used to estimate SEM
model are MLE-Maximum Likelihood Estimation, OLS-Ordinary Least Square, WLS-
Weighted Least Square, GLS- Generalized Least Square etc. MLE is considered as the
most efficient and unbiased estimation technique. But to apply MLE, Data should

confirm to normality assumption.

Confirmatory Factor Analysis (CFA).

CFA is used to find out the statements used are related to the construct. The CFA is

otherwise called measurement model because it measures relationship between item and
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construct. CFA is also called as reflective model because the arrow is going from

construct to item.CFA can be explained by using following examples

For each of the following statements, please indicate the degree which you are
comfortable.
(SA- Strongly Agree; A- Agree; NAND- Neither Agree nor Disagree; DA- Disagree;

SDA- Strongly Disagree)

1) Technology

a) My bank offers efficient core banking system

b) My bank has wide spread ATM networks

c) My bank offers secured net banking services

d) My bank offers effective Phone banking

e) My bank offers user friendly services

COMPUTER APPLICATIONS IN BUSINESS Page 152




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION
Manonmaniam Sundaranar University, Tirunelveli

2) Personnel SA A

a) The bank has knowledgeable personnel

b) Front line employees are responsible

c) Bank executives are courteous towards the

Customer

Top Management is easily accessible

Personal bankers update the new products

My bank offers prompt service

My bank offers customer friendly environment

In the above example, Five statements are placed under the construct TECHNOLOGY
and seven statements are placed under the construct PERSONNEL. The person who
designed the questionnaire may feel that the five statements are relevant to technology
which has motivated him to put those five statements under technology. But the
respondent may have different perception. Therefore it necessary to check whether those

five statements are relevant to technology or not for that purpose CFA is used.

STRUCTURAL MODEL

In the structural model, the relationship between constructs is measured. To find out the
influence of one statement on another statement the simple regression can be used. But,
to find out the influence of one construct on another construct the regression can’t be

used, because the constructs don’t have any values For example in the above
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questionnaire the information are collected only for the statements not for constructs. At
the same time the construct can’t be treated as additions of all the items (Statements)
because some statements are more relevant to constructs than some other items in this

cases Structural Equation Model is used.

1. SUPPLY CHAIN CONCERNS:

Rate the following supply chain issues that prevent your organization from
achieving the full potential of supply chain management?

Please mark your response by rounding off the number

Slightly Low Moderate Slightly High High

2 3 4 5

Lack of sophisticated information system

Lack of ability in managing Supply chain

inventories

Lack of cooperation among supply chain members

Lack of trust among supply chain members

2. SUPPLY CHAIN PRACTICES:

To what extent the following Supply Chain Management (SCM) practices

were implemented in your organization?
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Please mark your response by rounding off the number

Not at all

Implemented

Somewhat

Implemented

Half-way

Implemented

Mostly

Implemented

Fully

Implemented

1

2

3

4

5

Close partnership with

suppliers

Close partnership with

customers

Just in time (JIT) supply

Strategic planning

3. SUPPLY CHAIN PERFORMANCE:

Rate the following supply chain performance of your organization over the

past 3 year?

Please mark your response by rounding off the number

Low

Slightly Low

Moderate

Slightly High

High

1

2

3

4

5

Improvement in Lead time

Improvement in inventory turns
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Improvement in level of inventory write

off

Improvement in Time to market

In above questionnaire it is clear that there are three constructs namely supply chain
concerns, supply chain practices and supply chain performance each constructs having

four statements so CFA can be performed if we look at the construct closely

USING A PATH DIAGRAM -A MEASUREMENT MODEL

PROCEDURE:
- Use the Import Data option from the File menu of the main window of LISREL for
Windows to load the Open dialog box.

—> Select the SPSS data file (*.sav) option from the Files of type drop-down list box.

Open E]@

Lack ir: | 23 SEM-Demo

ESupply Chain.sawv

Filez of type: SPSS Data File[*. zav] Cancel

I DOpen as read-only
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—> Browse for the file Supply Chain.sav from SEM-Demo folder and select it.
—> Click on the Open button to load the Save As dialog box.
—> Enter the name CFA.PSF in the File name .

—> Click on the Save button to open the following PSF window.

5 LISREL Windows Application - [snap.pf] [
[JFile Edit Data Transformation Statistics Graphs Multilevel SurveyGLIM View Window Help _[=]x
Dje|es|m| w8 »|¥| S[A|7|

0 & i

conl con2 | con3 ‘ cond
2,000 3.000 3000
4.000 2.000 1.000
1.000 1.000 1000
2,000 1.000 1.000
4000 3.000 5.000
4.000 2.000 2.000
5.000 3.000 2000
4000 4.000 3000
3.000 4.000 .o
4000 3.000 4000
2,000 1.000 2000
3.000 4.000 4.000
1.000 1.000 1.000
1.000 2.000 1.000
2.000 1.000 1000
5.000 2000 1.000
4000 3.000 2.000
2.000 4.000 J.oon
2,000 2000 2000
5.000 4.000 3000
3.000 3.000 1000
3.000 4.000 3000
3.000 2.000 2,000
5.000 3.000 J.oon
4000 4.000 4000
4.000 3.000 2,000
5.000 3.000 2.000
3.000 3.000 5.000
2.000 5.000 4000
4.000 5.000 J.oon
1.000 1.000 1.000
2.000 4.000 1000
2.000 2.000 1000
5.000 5000 5000
3.000 3.000 4.000
4000 4.000 4000
1.000 2.000 3000

-> Select the New option on the File menu to load the New dialog box.

-> Select the Path Diagram option in the New list box.

DK

PRELIS Data
SIMPLIS Project Cancel
LISREL Project _—
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—> Click on the OK button to load the Save As dialog box.
—> Enter the name CFA.PTH in the File name string field.
—> Click on the Save button to open the empty PTH window for CFA.PTH

Lis}
L7 Fie Draw View Inage Oulput Window Help
Das(ep|@| &% %] ]| Sl@|R]
Broups

—>Select the Variables option on the Setup menu to load the Labels dialog box.
—>Click on the Add/Read Variables button to load the Add/Read Variables dialog box.
-> Select the PRELIS System File option from the drop-down list box.

-> Click on the Browse button to load the Browse dialog box.

-> Browse for the file SUPPLY CHAIN.PSF in the SEM subfolder and select it.

-> Click on the Open button to return to the Add/Read Variables dialog box.

—>Click on the OK button to return to the Labels dialog box.

-> Click on the Add Latent Variables button to load the Add Variables dialog box.

-> Enter the label CON in the string field.

—>Click on the OK button to return to the Labels dialog box.

—>Click on the Add Latent Variables button to load the Add Variables dialog box.

COMPUTER APPLICATIONS IN BUSINESS Page 158




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION
Manonmaniam Sundaranar University, Tirunelveli

—>Enter the label PRA in the string field.

—>Click on the OK button to return to the Labels dialog box.

—>Click on the Add Latent Variables button to load the Add Variables dialog box.
—>Enter the label PER in the string field.

—>Click on the OK button to produce the following Labels dialog box.

- Click on the OK button to return to the PTH window for SCM.PTH.

Labels

Obzerved Wariables Latent % ariables

M ame M ame | |

- COM .
] PEA < Prewious

COMST
cat]
can? FER

cond Mest >
cand
pral
praz
prad
prad Cancel
u] perl -

k.

= e 2 | e i [ L P | —

Add/Read Yariables | Add Latent W ariables |

Preszsz the Down Arrows bo insert one rove at a time once a label haz been typed in the
presvious row

Freszs the Inzert key to inzert emply rowes or the Delete key to delete selected rows

-> Click, drag and drop the observed variable labels one at a time into the empty PTH
window.
- Click, drag and drop the latent variable labels one at a time into the empty PTH
window.

- Click on the Arrow button on the drawing toolbar.
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—>Click and drag 5 paths from CON to CON 1, CON 2, CON 3 and CON 4.

[J Eile Edit Setup Drow Vi I o
DR (%] 2] S|

Groups: | = | Models: [=Madel

CONST

o o o
o o o
H 8 5
o o
g o o
B || B

\gnuu
b e DD

2

o o o o c o o o o
5 o b b 5 b & o o

2 8 8 8 5 85 5 2 5

o b=l ‘o h=] o

22 |5 == ||= ||= g

= AR A &

Ready

-> Click and drag 4 paths from PRA then PRA 1, PRA 2, PRA 3, and PRA 4.

—> Click and drag 3 paths from PER the PER 1, PER 2, PER 3 and PER 4

—>Click on the Build SIMPLIS Syntax option on the Setup menu to open the SPJ window
for SCM.SPJ.

—>Click on the Run LISREL button to produce the following PTH window.
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Chi-Square=111.30, df=51, P-value=0.00000, RMSER=0.068

RESULTS OF GOODNESS OF FIT TEST FOR SEM

Chi- Df Normed | P- GFI | AGFI
square Chi-

Value Square

Study model 111.30 2.18

Recommended Below 3

value

USING A PATH DIAGRAM -A STRUCTURAL MODEL

PROCEDURE:
- Use the Import Data option from the File menu of the main window of LISREL for
Windows to load the Open dialog box.

- Select the SPSS data file (*.sav) option from the Files of type drop-down list box.
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- Browse for the file Supply Chain.sav and select it.

—> Click on the Open button to load the Save As dialog box.

—> Enter the name SEM.PSF in the File name string field to produce the following dialog
box.

—> Click on the Save button to open the following PSF window.

—> Select the New option on the File menu to load the New dialog box.

—> Select the Path Diagram option in the New list box.

—> Click on the OK button to load the Save As dialog box.

—> Enter the name SEM.PTH in the File name string field.

—> Click on the Save button to open the empty PTH window for SEM.PTH
—>Select the Variables option on the Setup menu to load the Labels dialog box.
—>Click on the Add/Read Variables button to load the Add/Read Variables dialog box.
—> Select the PRELIS System File option from the drop-down list box.

-> Click on the Browse button to load the Browse dialog box.

-> Browse for the file SUPPLY CHAIN.PSF in the SEM subfolder and select it.
-> Click on the Open button to return to the Add/Read Variables dialog box.
—>Click on the OK button to return to the Labels dialog box.

-> Click on the Add Latent Variables button to load the Add Variables dialog box.
-> Enter the label CON in the string field.

—>Click on the OK button to return to the Labels dialog box.

—>Click on the Add Latent Variables button to load the Add Variables dialog box.
—>Enter the label PRA in the string field.

—>Click on the OK button to return to the Labels dialog box.
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—>Click on the Add Latent Variables button to load the Add Variables dialog box.
—>Enter the label PER in the string field.

—>Click on the OK button to produce the following Labels dialog box.

—> Click on the OK button to return to the PTH window for SCM.PTH.

—> Check the Y observed boxes for all measured items.

- Click the Eta for all boxes of dependent variable that is PRA (PRA to PRA 1, PRA 2,

PRA 3, and PRA 4.) and PER(PER 1, PER 2, PER 3 and PER 4).

i LISREL Windows Application - [cfa. pth]
[ File Edit Setup Draw wWiew Image OUtput  ‘Window Help

D = (%5 =1 |

-> Click, drag and drop the observed variable labels one at a time into the empty PTH

window.

- Click, drag and drop the latent variable labels one at a time into the empty PTH

window.
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—> Click on the Arrow button on the drawing toolbar.

—> Click and drag 5 paths from CON to CON 1, CON 2, CON 3, and CON 4

- Click and drag 4paths from PRA to PRAto PRA 1, PRA 2, PRA 3, and PRA 4.
—> Click and drag 4 paths from PER to PER 1, PER 2, PER 3 and PER 4.

- Click and drag 2 paths from CON and PRA to PER.

—> Click and drag a path from PRA to PER to produce the following PTH window.

8 LISREL Windows Application - [cfa.pth]
[JFie Edt Setup Draw View uty

Imags O Window Help
m)[=31-3 S8 %
G

| Models: [Basic Model

n
.
X
X
X
E‘ cond
D

¥t & > GO
iy start & 7 ¥ > [ ) cal for Papers i: Thr..

- Click on the Build SIMPLIS Syntax option on the Setup menu to open the SPJ
window for depress2.SPJ.

-> Click on the Run LISREL button to produce the following PTH window.
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LISREL Windows Application - [sem.PTH]
[7J File Edit Setup Draw View Image Output Window Help

Des(es|@| %% 2] S0 e)
Groups: | =] Models: [Basic Model >|  Estimates: [Estimates -

Observed | ¥

pral |—-G,32
a_7a
0.15 2
@
0.66

XX XXX X (X

0.4z

-0.08

Latent |Fta
x
x

Chi-Square=111.30, df=51, P-value=0.00000, RMSEA=0.068

Chi—-S8guare—111.30, df=51, P—-raluwue=—0. 00000 , PMISELA—O.O0s2

COMPUTER APPLICATIONS IN BUSINESS Page 165




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION
Manonmaniam Sundaranar University, Tirunelveli

RESULTS OF SIGNIFICANCE TEST FOR SEM

Path t-value | p-value significant

Coefficient

0.16 ) Greater than

0.01

Greater than

0.01

Less than

0.01

Structural Equation model is used to determine the strength of the relationship
between unobserved variables (Latent variables). The above Figure displays the path
diagram resulting from the structural modeling analysis from LISREL. The findings for
the structural equation model shows that the strength of the relationship between the three
latent or unobserved variables, here there is dependence relationship are shown in the
diagram. First relationship between Supply Chain Concerns (Exogenous Variable) and
Supply chain practices (Endogenous Variable) is 0.16 (Covariance) and it is greater than
significant level value. Theoretically, it means that supply chain concerns are not having
an impact on supply chain practices. Second relationship between Supply Chain
Concerns (Exogenous Variable) and Supply chain performance (Endogenous Variable) is
-0.09 (covariance) and it is greater than significant level value. Theoretically, it means

that supply chain concerns are not having an impact on supply chain performance and
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final relationship between Supply Chain practices (Exogenous Variable) and Supply
chain performance (Endogenous Variable) is 0.66 (covariance) and it is less than
significant level value . Theoretically, it means that supply chain concerns are having a

positive impact on supply chain performance

STRUTURAL EQUATION MODEL (SEM)
The first step is to launch AMOS. Select the Start menu from the Windows taskbar, then
select Programs, then choose the AMOS 4 program set, then select AMOS Graphics. You

will now see a blank AMOS Graphics diagram page that looks like is:

£ Unnamed project: Group rurmBer TR -—

File Edit View Diagram Analyze Tools Plugins Help

s 041 | |
= 31.07-2012
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You will also see a floating toolbar appear. The toolbar may partially obscure the
AMOS drawing area, but you can move it out of the way by dragging it to the side of
your computer screen. Select the toolbar by single-clicking on it with your mouse pointer.
If you place your mouse pointer over any tool icon with the toolbar selected, AMOS
displays the name and function of the tool.

1. MEASUREMENT MODEL STEPS

Step 1: Click File->Data File.

Step 2: Click Filename and Select the (RAMSEM.sav) file. Click Open and then OK.

£y Unnamed project : Group number 1: Input
File Edit View Diagram Analyze Tools Plugins Help

2= | Data Files

«
Gop e [ Fie [V Va1 SIS [ Users » Keshav b Desktop b pondy univ

Group number 1 <working>

Organize v Mew folder
W0 Favorites Name

&1 Recent Places =

car
B Desktop A carp
File Name el B ram 5w

4 Libraries

8 Computer
& os(cy
= Removable Disk (E:)

- New Volume (F)

€ Network

ile name: [T LAY EEY ~ |IBM SPSS Statistics (*.sav)

10:49 g

N
PR g

Step 3:Click Diagram - Draw Indicator variables . Click the path diagram screen and

click number of times based on the number of measurement ltems.
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£y Unnamed project : Group number 11 Input D -

file Edit View Diagr

O
“—

lyze Tools Plugins Help

@

=
=
@l

Bl Ooicm]

Unstandardized sstimatss
Standardized sztimates

AERER O 28 =

-

DA F
BOLALEIE & X Moo

SFBR

10:56 g

EN . e 0 e
PR g

Step 4: Click View > Object Properties and name the unobserved variables.

) Unnamed project : Group number 1:Input "D

File Edit View Diagram

lyz= Tools Plugins

Help

£t Object Properties

D

L] . (]
Tet | Parameters | Colors | Fomat | Visbity |

Font size Font style

I8 ~ Reguar =

Varizble name

r

Variable label

B Odaml

Set Default

i

DA F
BECANVETOE @ XG mlo off

B
£

sFoAF@BmO e R TN

Not estimating any user-defined estimand.
) T o 2 | I T e ST TP

7 m A 1057

P EN . [mr 0 o
- ) . 858 B
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Step 5: Click View - Variable in Dataset and drag the observed variables to the square
boxes in the path diagram.

Step 6: Click View - Object Properties and name the unique variables for all observed
variables.

Step 7: Click Diagram - Draw Covariance and connect all the unobserved variables.

£ Pum: Group number 1 gt P -

File Edit View Diagram Analyze Tools Plugins Help

[us1] [us2 ] [usa | [ usa | [sn] [ se][sa][se]

dn
B
o]

23 P F

Y
LS

]
BEANEME S HXC

SFRM

[(act | [(ac2 | [(aca | [(Act ] [er1 ] [er2 ] [EPa ] [ P |
. ; - . - : - :

© & ©

s 1059 | |
=N 31.07-2012

Step 8: Click Analyze->Calculate Estimates.

Step 9: Save the output in a folder.
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Step 10: Use the button shown below to generate output path diagram to get the estimate

- Wheaton : Group number|

FI|E Edit

Values Group number 1

£y Pum : Group number 1 : OK: Default model " D

File Edit View Disgram Tools Plugins Help

[os1 ] [us2 ] [usa ] [ usa] [sn ] [se][sa][sua]

&

OK: Defsuit modal

g
%
+

BB Ed 4 @

il

IDAFHESE O 1
EeHLLMESH <

Fop

B
£

[[act | [(ac2 | [acs | [ace | er1 | [ er2 | |EP3||EF’4‘

O o o

11:02 g

EN . [mr 0 o
PR g

Click the view text to show the text output
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8: Amos Output ‘_
REWUE B E 3 - -0 -FOEm :w

Estimates (Group number 1 - Default model)

Scalar Estimates (Group mumber 1 - Default model)
Maximum Likelihood Estimates

Regression Weights: (Group number 1 - Default model)

Estimate SE CR P Label

184 =<-- 1.000
I8 <--- 1010 086 11.760
Wirimization Hi J82 < 1113 091 12257
- Model Fit JS1 < 1083 089 12223
Execution Time S <. 2 1.000

SI3 <-- F2 917 054 16906

S22 =<--- F2 917 044 20793

SI1 <--- F2 856 045 19.112

EPl =<--- 1.000

EP2 <--- 1.023 073 14073

EP3 < 816 059 13.763

EP4 < 910 063 14384

AC1 < F 1.000

AC2 = F 1237 067 18410

AC3 =--- FH 1036 055 18.838

AC4 <--- FA 1144 063 18203 ===

Standardized Regression Weights: (Group number 1 - Default model)

Estimate
184 =<-- A
I8 <--- 697
J82 < 738
JS1 < 735

- (é EN . [me b g :
= EJ ol C mj =~ || PR g |

1. STRUTURAL MODEL STEPS

Step 1: Click File->Data File.

Step 2:Click Filename and Select the same file. Click Open and then OK.

Step 3:Click Diagram - Draw Indicator variables . Click the path diagram screen and
click based on the number of measurement Items.

Step 4: Click View > Object Properties and name the unobserved variables.

Step 5: Click View - Variable in Dataset and drag the observed variables to the square
boxes in the path diagram.

Step 6: Click View - Object Properties and name the unique variables for all observed
variables.

Step 7: Click Diagram ->Draw Unique Variables for the endogenous variables and

mention the error number.
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Step 8: Click Diagram - Draw Paths and connect it from AC->JS and EP—> JS and

JS->SI

8y Pus : Group number 1 : Input
File Edit View Diagram Analyze Tools Plugins Help

-

AV EETE

P Lope
A FHISE. OfaEs
3@@29“%3?355%%@

By
=1

ating any user-defined estimand.
ey £ | I M T2z T e . oo
EN . e 0 e
= m_l O] e m@ R T

Step 9: Click Analyze->Calculate Estimates.
Step 10: Save the output in a folder.

Step 11: Click on the button as shown below to get the results.
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£y Pus: Sroup number 1: OK: Default madel L. h i

file Edit View Diagram Analyze Tools Plugins Help

Group numbsr 1

e

OK: Defauit modsl

3
be

Unstandardized sstimatss
Standardized sztimates

BisEGE0O 1 =

BA .
SCLHLETME S

i

Default model
Minimization
Iteration §
Minimum was achieved
Writing output
Chi-square = 1135, df = =
" »

29
£

pUM
pus

11:07 g

EN . |m w
A 31-07-2012

Click the view text

8 Amos Output =
REWNS BT 3 -0 -FOEm :w
£} Notes for Model
&~ Computation of degrees of freedom Model Fit Summary
- Result
£} Estimates CMIN
Scalars

Matrices -
- Modification Indices Model CMIN
Minimization History Default model 113.541
i) Samrated model 2000

Independence model 3300.645

- Bassiine Comparisons

- Parsimony-Adjusted Weasures RMR, GFI
SNep
S FMIN
- RMSEA Model

+AIC Default model

L-ECVI Saturated model
HOELTER

Tndependence model
Baseline Comparisons

NFI

Deltal

Default model 966
Saturated model 1.000
Independence model 000

Model

Group number 1
Parsimony-Adjusted Measures

Model PRATIO
Default model 817

Samrated model 000
Independence model 1.000

- Defautt model

mes | |
31-07-2012
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Goodness of fit statistics
Chi-square value (p>.05)
Absolute fit measures
Goodness of fit index>.9
Root mean square error of approximation<.07
Root mean square residual<.08
Standardized root mean residual<.08
Normed chi-square<3
Incremental fit indices
Normed fit index>.9
Non normed fit index
Comparative fit index>.9
Relative fit index>.9
Parsimony fit indices
Parsimony normed fit index>.9
Adjusted goodness of fit index>.9
Convergent validity
Loading value more than .7
Average variance extracted .5
Discriminant validity
AVE>squared inter construct correlation

Insignificant loading with other constructs
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Nomological validity
Correlation between constructs should reflect theory
Standardized regression estimates —hypothesis testing based on significant level
Standadised residuals should not be more than 2.5
Modification index not more than 4
-11
CONJOINT ANALYSIS
The first step in a conjoint analysis is to create the combinations of factor levels that are
presented as product profiles to the subjects. Since even a small number of factors and a
few levels for each factor will lead to an unmanageable number of potential product
profiles, you need to generate a representative subset known as an orthogonal array.
The Generate Orthogonal Design procedure creates an orthogonal array—also referred to
as an orthogonal design—and stores the information in an SPSS data file. Unlike most
procedures, an active dataset is not required before running the Generate Orthogonal
Design procedure. If you do not have an active dataset, you have the option of creating
one, generating variable names, variable labels, and value labels from the options that
you select in the dialog boxes. If you already have an active dataset, you can either
replace it or save the orthogonal design as a separate SPSS data file.
To create an orthogonal design:
» From the menus choose:
Data
Orthogonal Design

Generate
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@ Daine Duies.
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1R ssermy Duptcate cases
T ity Unisud Cases.
b, S0 Cases
o1
B ramsposs
5 Restructure
Mg Pl
Bl zogreguee
Critgsgansl Desion
i Copy Doinet
5 e
T3 Seect Cases
e ot cae,

EE %

Decimals Labe! Valugs Missing | Golumns

Algn

Measure

™ e cLUClmT

» Enter brand in the Factor Name text box, and enter brand in the Factor Label text box

B8] Untitied! [DataSet0] - SPSS Data Editor D

b

fie Edt Vew Dela Transfom  Analyze Graphs  Utities Addons  Window  Help

CHA E 00 =B A s S0E S0

Name Typs | Wdth | Decimals|  Label | Values | Missing | Columns

Align

[ Generate Orthogonal Design

Factor Labiet [gyang]

ad |

Data File

() Replace working data file

[ Reset ranciom number sesd to

(3) Create new data file \ File-

| CiMJs. JORTHO.sav

| options.

Reset || cancel || Hel

(|

» Click Add.
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F) Untitled! [DataSet0] - SPSS Data Editor L s

fie Edt Vew Dela Transfom  Analyze Graphs  Utities Addons  Window  Help

CHA E 00 =Bk A Mg S0E 09

Name Type | Wdth | Decimals|  Label |  Values | Missing | Columns Align Measure

[ Generate Orthogenal Design

Factor hame:

Factor Labe. |

Data File

(5) Create rsw data il | Fie. | @Ms.iORTHOsav

() Replace working data file

[ Reset ranciom number sesd to | options... |

Reset || camcel || Hem |

(|

SPSS Pracessor s ready
13:02

C 3 pm

This creates an item labeled brand 'brand’ (?). Select this item.

» Click Define Values
Enter the values 1, 2, and 3 to represent the brand. Enter the labels maruti, Hyundai and
Toyota as well.

» Click Continue.
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B Untitied1 [DataSet0] - SPSS Data Editor i D "

Fle Ecit View Data Iransform  Analyze Graphs  Utities Addons  Window  Help
cHA B o0 B8R A i SEH ¥00
| ame Typs | Width | Decimals|  Labsl |

[2 Generate Design: Define Values

“alues and Labels for Brand

Luto-Fill

From 1 to

i

| contiwe |[ concel |[ e

You'll now want to repeat this process for the remaining factors, brand, price, seal, and
money. Use the values and labels from the following table, which includes the values
you've already entered for package.

Factor Values Labels

brand 1, 2, 3 Maruti, Hyundai, toyota

model 1,2  Sedan, non sedanl

version1,2  Petrol, diesel

Metallic, non metallic
color 1,2
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) Untitled! [DataSet0] - SPSS Data Editor "

Fie Edt Yew Data Transform Analyze Graphs  Uiities  Addons  Window  Help
CHA E 00 =Bk A Mg S0E 09
Name Type | Wdth | Decimals|  Label |  Values | Missing | Columns Align Measure

[ Generate Orthogenal Design

Factor hame:

Factor Labe. |

[Brand ‘Brand’ (1 Marut 2 Hyundsi 3 ‘Toyata’)
version 'version' (1 petrol' 2 diesel)
leolor ‘colar (1 ‘metalic' 2 'cthers')

Data File

(5) Create rsw data il | Fie. | @Ms.iORTHOsav

() Replace working data file

[ Reset ranciom number sesd to | options... |

| ok || paste || Reset || concal |[ Hew |

(|
Dsta View | Variable View

SPSS Pracessor s ready

13:08
S 31-07-2012

Once you have completed the factor specifications:
» Select Replace working data file in the Data File group in the Generate Orthogonal

Design dialog box. The generated design will replace the active dataset

B Untitied! [DataSet0] - SPSS Data Editor D "

File Edt View Dasta Transform  Andlyze Graphs  Uiies  Add-ons  Window  Hel
CHA E 00 =Bk A dd S6E %00
Name Type | Wdth | Decimals|  Label | Values | Missing | Columns Align Measure

[ Generate Orthogonal Design

Factor Labe. |

[Brand ‘Brand (1 Marut 2 Hyundai 3 ‘Toyata’y
IMostel Madef (1 ‘sectant 2 'non sedan’)
iversion 'version' (1 petrol' 2 'dieser)

leolor ‘colar (1 ‘metalic' 2 'cthers')

Data File

() Create new data file
() Replace veorking dats file]

[ Reset ranciom number sesd to | options... |

| ok || paste || Reset || comcel |[ Hew |

(|

Data View | Variable View

SPSS Processor s ready

13:08

B e
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Select Reset random number seed to and enter the value 2000000
» Click Options.
» In the Minimum number of cases to generate text box, type 18

» Select Number of holdout cases and type 4.

) Untitled! [DataSet0] - SPSS Data Editor D L s

fie Edt Vew Dela Transfom  Analyze Graphs  Utities Addons  Window  Help

CHA ® 00 =Bk A A E6E %29

Name Type | Wdth | Decimals|  Label |  Values | Missing | Columns Align Measure

[ Generate Orthogenal Design

Factor Labe. |

B Generate Orthogonal Design: Optio.. S

| Minimum numiser of cases to generate:

Holdout Cases

Number of holdout cases: El

] Randomty mix with oth

| comue || concel || Hew |

[T Reset ranciom number seed to |_options.

[ ok || paste || Reset || concal |[ Hew |

(|

SPSS Pracessor s ready

1311

C 3

» Click Continue in the Generate Orthogonal Design Options dialog box.

» Click OK in the Generate Orthogonal Design dialog box.
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] “Untitled2 [ - SPSS Data Editor T

File Edt “iew Data Transform  Analyze Graphs  Utiiies  Add-ons  Window  Help
EHE E b0 5k & M8 S0E 509
Label | Values

Brand

{1.00, Maru

Maodel {1.00, seda... Mone
{
{

Murneric version 1.00, petrol... Mone = & Scale
1.00, metal . Mone = & Seale
{0, Design}... MNone =R & Scale

Numeric hone None = & Scale

Nurneric color

(|

c 13:12 gl
S 307012 |

The orthogonal design is displayed in the Data Editor and is best viewed by displaying
value labels rather than the actual data values. This is accomplished by choosing Value
Labels from the View menu.

The variables in the data file are the factors used to specify the design. Each case
represents one product profile in the design. Notice that two additional variables, CARD _
and STATUS , appear in the data file. CARD_ assigns a sequential number to each
profile that is used to identify the profile. STATUS _indicates whether a profile is part of
the experimental design (the first 18 cases), a holdout case (the last 4 cases), or a
simulation case (to be discussed in a later topic in this case study).

The orthogonal design is a required input to the analysis of the data. Therefore, you will
want to save your design as an SPSS data file. For convenience, the current design has

been saved in car.sav (orthogonal designs are also referred to as plans).
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Once you have created an orthogonal design, you'll want to use it to create the product
profiles to be rated by the subjects. You can obtain a listing of the profiles in a single
table or display each profile in a separate table.

To display an orthogonal design:

» From the menus choose:

Data

OrthogonalDesign

Display...

[ -Untitied2 (1 - SPSS Data Editor " B .

Ele Edft Vew |Dala Iransiorm Anebyze Graphe  Lhites Addons Window Help

[ values
{100, Mant.. None
(1.0, seda
{1.00, petrol.. None
0

{

1.00, metal... None
=

BB Identity Duplicate Cases (0. Design}.
[ ity Hane

B cgregste.

Ortfagans Design

1 copy Dataset e

5 Snit Eile.
[ Select Cases
4% weioht Cases.

S 3107-2012
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P Select Listing for experimenter in the Format group. This results in displaying the
entire orthogonal design in a single table.

» Click OK.

Card List

Brand Model | version color

Hyundai |[Sedan  |petrol others

non
Hyundai diesel metalic
sedan

Maruti |Sedan diesel metalic

Toyata |Sedan  |petrol others

Maruti |Sedan diesel metalic

non
Maruti petrol others
sedan

Hyundai |[Sedan  |petrol metalic

Maruti |[Sedan |petrol others

non
Hyundai diesel others
sedan

Hyundai |[Sedan  |petrol metalic

non
Maruti petrol metalic
sedan
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12 12 Hyundai [Sedan  |petrol metalic

13 13 Maruti |[Sedan |petrol metalic

14 14 Toyata |Sedan |diesel metalic

15 15 Toyata |Sedan  |petrol metalic

16 non
Toyata petrol metalic
sedan

non
petrol metalic
sedan

Sedan diesel others

non
diesel metalic
sedan

non
others
sedan

non
Hyundai others
sedan

non
Hyundai metalic
sedan

a. Holdout

The preference data collected from the subjects is stored in carpet_prefs.sav.
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CONJOINT PLAN="file specification’
/DATA="file specification'
/SEQUENCE=PREF1 TO PREF22
/SUBJECT=ID
/FACTORS=brand model version color (DISCRETE)

/PRINT=SUMMARYONLY.

Utilities

Utility

Estimate

Std. Error

Maruti

1.036

.550

Hyundai

162

.550

Toyata

-1.798

.550

Sedan

295

413

non sedan

-.295

413

version |Petrol

-.132

413

Diesel

132

413

Metallic

-.821

413

non metalic

821

413

(Constant)

9.920

456
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Importance

Values

Brand 42.086

Model 19.701

Version 16.681

Color 21.531

Averaged

Importance Score

Correlations?

Value

Pearson's R 778

Kendall's tau 482

Kendall's tau for

Holdouts

a. Correlations between observed and

estimated preferences
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Analytical Hierarchy Process

DATA Collection: The data has been collected from the Annual General Reports from

2004-2011 for the following companies- Tata Consultancy Services, Infosys Ltd., Wipro
Ltd., Mphasis, Mahindra Satyam, HCL Infosystem , Tech Mahindra and HCL
Technologies Itd . The average value of 8 years data has been used to do the pair-wise
comparison.

The basic procedure to carry out the AHP consists of the following steps:

1. Structuring a decision problem and selection of criteria

The first step is to decompose a decision problem into its constituent parts. In its simplest
form, this structure comprises a goal or focus at the topmost level, criteria (and sub
criteria) at the intermediate levels, while the lowest level contains the options. Arranging
all the components in a hierarchy provides an overall view of the complex relationships
and helps the decision maker to assess whether the elements in each level are of the same
magnitude so that they can be compared accurately.

In this process, we have taken 5 most important criteria to understand the financial health
of the companies- the criteria’s are - Current Ratio, Debt Equity Ratio, Return on
Equity (ROE), Debtors Turnover Ratio and Operating Profit Margin.

2. Priority setting of the criteria by pair wise comparison (weighing)

For each pair of criteria, the decision maker is required to respond to a question such as
“How important is criterion A relative to criterion B?” Rating the relative “priority” of
the criteria is done by assigning a weight between 1 (equal importance) and 9 (extreme

importance) to the more important criterion, whereas the reciprocal of this value is
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assigned to the other criterion in the pair. The weighing are then normalized and averaged
in order to obtain an average weight for each criterion.

Intensity of

Importance Definition Explanation

Equal importance | Two factors contribute equally to the objective

Somewhat more | Experience and judgement slightly favour one

important over the other.

Much more Experience and judgement strongly favour one

important over the other.

Experience and judgement very strongly favour
Very much more | one over the other. Its importance is

important demonstrated in practice.

Absolutely more | The evidence favouring one over the other is of

important. the highest possible validity.

Intermediate

values When compromise is needed.

Table 4.1 : Rating Priority table
2. The ranking is done as per the Ranking Table and its corresponding opposite
relationship is filled with the reciprocal of the parent relationship. The following

table uses the 9 point scale of Saaty’s rating scale .
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HCL
Technolog Tech HCL

Company ies Mabhindra | Infosystems

TCS 2 1/7

Infosys 4 1/5

Wipro 1

HCL
Technologi

€s

Satyam

Mphasis

Tech

Mahindra

HCL
Infosystem

S /7 7 8 5

Table 4.2: Option Performance Matrix
This matrix, which we call the Option Performance Matrix (OPM), summarises the
respective capability of the 8 companies with respect to one another in terms of what the
firm wants. Reading down each column, it somewhat states the obvious. Now if one of

the performance criteria of Wipro is “Much more important” than the same performance
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criteria for overall evaluation of Infosys under consideration then, Wipro will be assigned

5 against Infosys and Infosys will be assigned the reciprocal value - 1/5 against Wipro.

AHP - Microsoft Excel

= t 1 Z Autosul :
| | Siwrap et General - e
ARE b 3 3 z
- Fill -
Paste A\l A = EMerge & Center - (S~ % 9 |[%3 %] Conditional Fomat  Cell | Insert Delete Format Sort & Find &
- }Fom t Painter £ Merg =% 9 >9)/| Formatting - as Table - Styles~ ||~ 2 Clea Filter - Select -
Clipboard & on . Alignment 5 Number u Styles Celis Editing

11 -

B C G H 1 L M

Debtors Debtors [Operating
i Turnover Operating Current Turnover |Profit
Current Ratio |rati Ratio Profit Margin NORMALIZED  [IET Debt Equi Ratio Margin

1.000 .. 5 0.295 0.115 Current Ratio 1.000 0.295 x 0.295 0.115
0.705 X K 0.295 0.295 Debt Equity ratio | 3.390 | 1.000 X 0.295 0.295
0.885 X . 0.895 0.695 ROE 8.696 8.696 . 0.895 0.695
Debtors Turnover
Ratio

Operating Profit
Margin

0.705 : 2 1.000 0.695 3.390 3.390 % 1.000 0.695

0.885 3 . 0.305 1.000 8.696 3.390 . 1.439 1.000

3. PAIR WISE COMPARISION MATRIX - Debtors Turover Ratio | ]

HCL
TCcS Infosys | Wipro [T gies |Satyam Mphasis i HCL company TCS _ |infosys  |[Wipro |HCL Tech|Satyam |Mphasis

0.3333333 2

0.14286 TCS 0.078534 | 0.0274295 | 0.410156 | 0.123711 | 0.130435 | 0.173077 | 0.083333 | 0.

1 0.2

0.2 Infosys 0.235602 | 0.0822884 | 0.041016 | 0.185567 | 0.173913 | 0.115385 | 0.166667 | 0.

5 1

1 Wipro 0.039267 | 0.411442 |0.205078 | 0.123711 | 0.130435 | 0.115385 | 0.208333 | 0.

.2| 0.1428571| 0.333333

0.11111 Satyam 0.015707 | 0.0117555 | 0.068359 | 0.020619 | 0.043478 | 0.115385 | 0.083333 | 0.

3
2|
2
.5| 0.3333333 0.5 2| 0.11111 HCL T 0.039267 | 0.0274295 | 0.102539 | 0.061856 | 0.130435 | 0.115385 | 0.125
2|
1
3]

0.2 0.5 0.11111 Mphasis 0.026178 | 0.0164577 | 0.102539 | 0.030928 | 0.021739 | 0.057692 | 0.125

.2| 0.1428571) 0.2 .5| 0.33333

0.11111 0.015707 | 0.0117555 | 0.041016 | 0.020619 | 0.021739 | 0.019231 | 0.041667 | 0.

5| 0.142857 5| 1 HCL Infosystems | 0.549738 | 0.411442 | 0.029297 | 0.43299 | 0.347826 | 0.288462 | 0.166667 | 0.

4 4 » ¥ | cCalculations . Sheetl -~ Ranking Consistency Ratios Sheet2 ,“%J 0

m 3
Ready [EEEFTTe)

elujo @ Bm[r=]e]m] ] 2BEA0Y
CRISP Score and Normalized table for parameters
4. Normalize the table by dividing each cell value by root mean square value of the

corresponding column.

HCL HCL
Technologi i Infosyste

Company es i ms

0.123711 0.083333 | 0.051253

0.185567 0.166667 | 0.071754
Infosys

Wipro . . . 0.123711 . . 0.208333 | 0.35877
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9267

1442

5078

0435

5385

HCL
Technolog

ies

0.03

9267

0.02

7429

0.10

2539

0.061856

0.13

0435

0.11

5385

0.039863

0.01

5707

0.01

1755

0.06

8359

0.020619

0.04

3478

0.11

5385

0.083333

0.039863

Mphasis

0.02

6178

0.01

6458

0.10

2539

0.030928

0.02

1739

0.05

7692

0.039863

Tech

Mahindra

0.01

5707

0.01

1755

0.04

1016

0.020619

0.02

1739

0.01

9231

0.041667

0.039863

HCL
Infosystem

S

0.54

9738

0.41

1442

0.02

9297

0.43299

0.34

7826

0.28

8462

0.166667

0.35877

Table 4.3: Normalized table of Option Performance Matrix

5 . The square of the normalized table is calculated and Eigen values are obtained by

finding its respective weights. The above process is repeated until the Eigen values

obtained are steady and do not change further. The Step 2&3 are repeated for all the

criterion under consideration.
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0n) ) d 9 - =E)+ AHP - Microsoft Excel
ert

Home | Ins Pagelayout  Formulas  Data  Review  View

=5 % cut T = H ) 3 e T 35 || Z AutoSum >
Calibri - - [ | | Siwrap et General - J : [ 7 ﬁ
#] |& FEIE: - B s S G- A
B A $IMerge & Center - |G~ o, 5 ||%8 298| Conditional Format Cell || Insert Delete Format Sort & Find &
J Format Painter = : EadMerg 2% 00 >0) | Eormatting ~ as Table - Styles ~ - - - 2 Clear~  Fijter~ Select~

Clipboard £l nf ) ment ] Number ] Styles Cells Editing

53 Copy
Paste

Ad4
A
2nd Set
of Eigen
31 values Weight
32 5| 29 0.7590016| 0.945418| 0.601975, 5 2.979830508 0.759] 0.945418| 0.601975 161.29523| 83.89733| 19.0159| 26.42893| 17.38397| 308.0214 0.038521
33 11.34488| 5| 1.3738999| 2.117385| 1.264781 11.34488| 5| 1.3739 2.117385| 1.2647805 320.88989| 169.475( 38.28041| 52.55901| 34.66991| 615.8742 0.077022
34 55.94547| 25.34635225 5| 7.920435| 5.577242 55.94547 25.34635225 7.920435| 5.5772424 1374.6046| 726.5056( 166.8483| 228.8801| 149.6757| 2646.514 0.330975
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Calculation of Eigen Values
6. Pair wise comparison of options on each criterion (scoring)
Perfect consistency rarely occurs in practice. In the AHP the pair wise comparisons in a
judgment matrix are considered to be adequately consistent if the corresponding
consistency ratio (CR) is less than 10%. The CR coefficient is calculated as follows.
First, the consistency index (Cl) needs to be estimated. This is done by adding the
columns in the judgment matrix and multiply the resulting vector by the vector of
priorities (i.e., the approximated eigen vector) obtained earlier. This yields an
approximation of the maximum eigen value, denoted by Amax.
Then, the CI value is calculated by using the formula:

CI = (Amax - n)/(n - 1).
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‘n’ is the number of parameters under consideration. Next the consistency ratio CR is

obtained by dividing the CI value by the Random Consistency index (RCI) as given in

following table.

RCI values for different values of n.

If the CR value is greater than 0.10, then it is a good idea to study the problem further

and re-evaluate the pairwise comparisons.

7. Based on the Eigen values and the Consistency Index, the ranking done for one of the

parameter below. The value depends on the criterion. For example, the higher the

Operating Profit Margin, the better it is. However in case of Debt to Equity Ratio, the

lower values are preferable.

Eigen values

Company

0.310662493

HCL

Infosystems

0.236418329

Wipro

0.153314966

TCS

0.107832098

Infosys

0.065208618

HCL
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Technologies

0.052200677 Mphasis

0.044037054 Satyam

0.030325765 techMahindra

Table 4.4: Eigen Values
8. The Step 3-7 are repeated for the weighted matrix of parameters against which the

companies are evaluated and the ranks are obtained for the points under consideration.

Weights Parameters

0.331735431 | ROE

0.324484226 | Operating Profit Margin

0.228619911 | Debtors Turnover Ratio

0.076792825 | Debt Equity ratio

Parameters 0.038367606 | Current Ratio Ranking

9. In a final step the option scores
are combined with the criterion weights to produce an overall score for each option. The
extent to which the options satisfy the criteria is weighed according to the relative
importance of the criteria. This is done by simple weighted summation. The two matrices
are multiplied and the raking of each company is obtained. The Parameter Value’s are
multiplied with the Eigen values of the corresponding parameter of the companies.

Finally, after judgements have been made on the impact of all the elements and priorities
have been computed for the hierarchy as a whole. The combination weight of all the

criterion is considered and the value of Eigen value is calculated.
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Parameters

Current

Ratio

Debt
Equity

ratio

ROE

Debtors

Turnover

Ratio

Operating

Profit Margin

Parameter

Value

0.038367

6

0.0767928

2

0.33173543

1

0.228619911

0.324484226

0.273133

3

0.0217484

1

0.30790970

4

0.153314966

0.124596089

Infosys

0.087968

1

0.3211312

1

0.18422527

4

0.107832098

0.420779287

Wipro

0.093194

1

0.1502836

8

0.12713843

5

0.236418329

0.202101922

HCL

Technologie

S

0.079165

0

0.0781830

4

0.11012520

7

0.065208618

0.050933576

0.092267

3

0.1302374

5

0.04366997

9

0.044037054

0.03472112

Mphasis

0.182503

2

0.1289837

5

0.05343728

7

0.052200677

0.074069427

Tech

Mahindra

0.133886

4

0.0916267

2

0.08165390

2

0.030325765

0.05806333

HCL

Infosystems

0.057882

2

0.0778056

9

0.09184021

1

0.310662493

0.034735249

Overall Weighted Eigen Values
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10. The average value of all the parameters are calculated and the final Eigen values are

obtained to find the arrive at the ultimate ranking matix.

Company Name Data Ranking

Infosys 0.250338559 1

TCS 0.189774471 2

Wipro 0.176921491

HCL Infosystems | 0.120957047

HCL Technologies | 0.077008835

Mphasis 0.070602755

Tech Mahindra 0.065034378

Satyam 0.049362464

TOPSIS

TOPSIS is a multiple criteria method to identify solutions from a finite set of alternatives
based upon simultaneous minimization of distance from an ideal point and maximization
of distance from a nadir point. TOPSIS can incorporate relative weights of criterion
importance. The acronym TOPSIS stands for Technique for Preference by Similarity to
the Ideal Solution.

TOPSIS was initially presented by Hwang and Yoon, Lai et al. TOPSIS is attractive in
that limited subjective input is needed from decision makers. The only subjective input
needed is weights.

There are several applications of TOPSIS using different weighting schemes and
different distance metrics, and compares results of different sets of weights applied to a

previously used set of multiple criteria data. Comparison is also made against SMART
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and centroid weighting schemes. TOPSIS was not found to be more accurate, but was
quite close in accuracy. Using first-order and second-order metrics were found to be quite
good, but the infinite order was found to decline in accuracy.
TOPSIS has been applied to a number of applications, although it is not nearly as widely
applied as other multi attribute methods. A variant of TOPSIS was used for selection of
grippers in flexible manufacturing. In other manufacturing applications, it has been used
in a case selecting a manufacturing process and in an application selecting robotic
processes. Neural network approaches to obtain weights for TOPSIS have been applied,
and fuzzy set extensions implemented. TOPSIS has also been used to compare company
performances and financial ratio performance within a specific industry. TOPSIS was
applied to financial investment in advanced manufacturing systems.
2. TOPSIS METHOD
Step 1. We usually transform the cost criteria into benefit criteria, by using crisp score
rating,
The ratios are allotted the value based on the preference of each ratio based on the
perception and the importance of each ratios. Allot the crisp score only to the
higher or the important side while the opposite sided is allotted the value as X _ij

=1-Xji

Current | Debt Equity Debtors Turnover | Operating Profit

Ratio ratio Ratio Margin

TCS 0.895 0.115 0.695 0.695

Infosys 0.495 0.895 0.895 0.895
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Wipro

0.495

0.295

0.695

0.495

HCL

Technologies

Satyam

Mphasis

Tech

Mahindra

HCL

Infosystems

0.115

0.295

0.495

0.895

0.115

Step 2. The weights of the ratios or the priority vectors are calculated by using the root

mean square to get the weights of the ratios

Step 3. Then the normalized matrix is generated by dividing each element of the crisp

score matrix by the root mean square value of the column. This generates the

normalized matrix.

Company

TCS

Current

Ratio

0.572449128

Debt Equity

ratio

0.076053943

0.554799

Debtors

Turnover

Ratio

0.406690132

Operating
Profit

Margin

0.401231689

Infosys

0.316605942

0.591898078

0.430822

0.523723263

0.516694046

Wipro

0.316605942

0.195094897

0.430822

0.289657

0.516694046

HCL

0.188684349

0.327362624

0.306844

0.289657

0.170306976
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Technologies

Satyam

0.188684349

0.459630351

0.071287

0.172623869

0.170306976

Mphasis

0.444527535

0.459630351

0.182867

0.289657

0.401231689

Tech Mahindra

0.444527535

0.195094897

0.306844

0.067294051

0.285769333

HCL Infosystems

0.073554916

0.195094897

0.306844

0.523723263

0.066390855

Step 4. Next we need to generate the weighted matrix, which is obtained by multiplying

the normalized matrix with the weights of the respective ratios

PMARK*WT=WEIGTED MATRIX

Debtors  Operating

Current Turnover | Profit Geometric

Weights

Current

Ratio 0.25834969 | 0.100263522

Debt
Equity
0.37128397

ratio 0.144092445

ROE 0.86604184 | 0.336104162

Debtors

Turnover 0.51512244 | 0.199915046
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Ratio

Operating
Profit

Margin 0.56590876 | 0.219624824

Step 5. Generate the best and the worst score of the ratios by finding the maximum and

the minimum value of each ratio.

SUB CRITERIA BEST WORST

Current Ratio 0.057395766 0.007375

Debt Equity ratio 0.085288041 0.010959

ROE 0.186470399 0.02396

Debtors Turnover

Ratio 0.10470016 0.013453

Operating Profit

Margin 0.074451709 0.009566

Step 6. Next generate the positive score by finding the root mean square value of the
difference between the beat score and the score and the respective element of the
normalized matrix, similarly generate the negative score using the worst value.
The net score is generated using the formulae

Net score = Negative score/ (negative score +positive score)
POSTIVE NEGATIVE

SCORE SCORE

COMPUTER APPLICATIONS IN BUSINESS Page 201




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION

0.079680859

0.18932328

Manonmaniam Sundaranar University, Tirunelveli

0.703793185

0.04893207

0.182366126

0.788445949

0.339218253

0.15168998

0.308998648

0.120663255

0.099564268

0.452097299

0.188868362

0.062094089

0.247423822

0.11898143

0.121046505

0.504301738

0.140755817

0.094578567

0.401890134

0.130102526

0.12201812

0.483967188

Thus, the net score is used to rank the companies with the highest score being the best

and so on

COMPANY

Infosys

SCOR

0.788445949

TCS

0.703793185

HCL Infosystems

0.483967188

HCL

Technologies

0.452097299

Tech Mahindra

0.401890134

Wipro

0.308998648

Satyam

0.247423822

Mphasis

0.134171427
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The above table shows that the ranks of software company performance evaluation. Infosys score
is highest than other software companies. Followed by Tata Consultancy Services rank is second,
third rank is HCL Info system. Fourth rank is held by HCL Technologies. Fifth rank is Tech
Mahindra and sixth rank is Wipro. The last two ranks are held by Satyam and Mphasis

respectively.
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Determine the alternative and
criteria

}

Linguistic Data from decision maker

|

Build pair-wise comparison
matrices for alternatives and
criteria using Scrip’s Score

'

Check the normalization

v

Normalize the
matrices

Is the miatrices
Normalyzed??

Build a non linear programming motet—]
for each value in the matrices

\4

Calculate the fuzzy closeness
vector

A 4

Calculate differences between the best
score and worst score

v

Rank the alternatives by relative
value

COMPUTER APPLICATIONS IN BtSINESS Page 204




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION
Manonmaniam Sundaranar University, Tirunelveli

Flowchart for TOPSIS

ANALYSIS OF TECHNICAL EFFICIENCY
The technical efficiency of insurance companies can be measured in terms of input and
output variables. The technical efficiency means efficiency of insurance companies in
utilizing input to generate output. The main aim of insurance companies is to collect
premium from policy holders. The strength of insurance companies can be judged in
terms of premium collected by them. Therefore premium collected is taken as output
variable. The premium is collected by using agents, branches and employees. The input
variables taken for the study are no. of agents, no. of policy, no. of employees, no. of
clients, no. of branches and no. of schemes. The technical efficiency is measured by
taking all companies and by taking life insurance companies alone.
TABLE 1: TECHNICAL EFFICIENCY SCORE OF ALL INSURANCE

COMPANIES IN INDIA FOR THE YEAR 2009-2010

Technical Technical
Insurance companies Rank
Efficiency Efficiency

LIC (Life Insurance Corporation of

India)

HDFC Standard Life Insurance Co Ltd
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Birla Sun Life Insurance Co Ltd 0.123 11

Max New York Life Insurance Co Ltd 0.014 23

Kotak Mahindra Old Mutual Life
0.16
Insurance

Aviva Life Insurance Company India 0.087

Aegon Religare 0.052

Canara HSBC 0.582

DLF Pramerica 0.101

India First 0.02

IDBI Fortis 0.017

ING Vysysa 0.369

Sahara 0.08

Met Life 0.459

Star Union Diachi 0.114

Average

ICICI Prudential Life Insurance Co Ltd

Bajaj Allianz Life Insurance Co Ltd

SBI Life Insurance Co Ltd

Reliance Life Insurance Co Ltd

Bharti AXA

Future generali

Shriram
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Tata AlG 0.801

Average 0.228

Around 23 insurance companies are taken for the study. The technical efficiency is
measured by using DEA method. Table 1 contains technical efficiency score for different
insurance companies. The rank for the insurance companies is derived based on technical
efficiency score. From the table 1 it is clear that LIC (Life Insurance Corporation of
India) is the most technically efficient insurance company in India for the year 2009-
2010. Tata AIG performs at 80 percent efficiency though its parent company in US has
faced some difficulties during subprime crisis. The other insurance companies which are
in the order of efficiency are Canara HSBC (58%), Metlife (46%) and SBI life (41%).
This shows that only three companies have efficiency more than 50 percent. Many
companies have efficiency score less than 10 percent. The average technical efficiency
score of all insurance companies is 0.228. Though there are many leading insurance
companies their rank for technical efficiency are much lower. The main reason behind
poor efficiency is due to high level of efficiency of LIC. The efficiency score is relative
to top performing company. This indicates that the new insurance companies should find
out ways by which the efficiency can be improved.

The insurance companies can be divided into life assurance companies and general
insurance companies. Though all are called as insurance companies and controlled by
IRDA, there is basic difference in operation between life insurance and general insurance.
Therefore separate analysis required for life insurance companies and general insurance

companies. From the table 2 it is clear that LIC (Life Insurance Corporation of India) is
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the most efficient life insurance company in India for the year 2009-2010. There is no
much difference in efficiency score obtained in the earlier analysis (table 1) and present
analysis (Table 2). Among the life insurance companies LIC and Canara HSBC are doing
good. There is a vast difference in the technical efficiency score of different companies.
The average technical efficiency score of all life insurance companies is 0.214. This
average efficiency is less than overall average efficiency obtained in the previous
analysis.

From the table 3 it is clear that ICICI Prudential Life Insurance Co Ltd, Bajaj Allianz
Life Insurance Co Ltd, SBI Life Insurance Co Ltd and Tata AIG are most efficient
general insurance companies in India for the year 2009-2010. Their dominance shows
that the other insurance companies have performed relatively much lower. The efficiency
of shriram and future generali are very less. The lagging companies must work on
effective utilization of resources to improve their efficiency. The average technical

efficiency score of all general insurance companies is 0.696.
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PROJECT TITLE

FINANCE
1. Performance evaluation of commercial banks in India using camel model
2. A study on influence of locus of control on investment behaviuor of individual
investor
Predicting solvency of it companies in India
. A study on the effectiveness of technical indicators and candlestick patterns in
predicting the share price movement with special reference to it sector
. Astudy on the performance of sectoral funds
. A study of investor’s preference towards wealth management with reference bajaj
allianz.
Study the effect of economic growth on the real estate industry in major cities of
India
. A study on the impact of dividend announcements on share price
. Working capital management
. Performance appraisal using Ratio analysis, fund flow and cash flow statements
11. Predicting solvency of company using Z score
12. Determinants of PE Ratio
13. Factors influencing FIl investment
14. Performance of IPO's
15. Industry analysis - may be Telecom industry

16. Impact of economic factors on share price - may be inflation, Balance of payment
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17. Stock market system in BRIC Nations

18. Comparison of Performance of Bank shares

19. Performance evaluation mutual funds using sharpe, Jensen and Treynors, Fama
20. Performance of Banks after Merger

21. Receivables management

22. Investors preference towards

23. Determinants of Risk bearing capacity of investors

24. Post purchase behaviour of policy holders

25. Investment behaviour of mutual fund investors

26. Investor preference for credit cards

27. Investor perception about services provided by banks

28. Investors perception about e-banking services

29. Apprising performance of banks using CAMEL model

30. Application of EKB model for investment decision making

31. Opinion of investors about operations of Fll's

32. Effectiveness of Technical tools

33. Determinants of EPS or Anatomy of EPS

34. Effectiveness solvency prediction models in predicting solvency of banks
35. Predicting share price of ICICI, HDFC and Axis Bank using valuation Models
36. Effectiveness of valuation models in predicting share price of ICICI bank
37. Life style of Chennai Investors

38. Personality characteristics of Stock market investors

39. Impact of Locus of control on investment practices

COMPUTER APPLICATIONS IN BUSINESS Page 210




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION
Manonmaniam Sundaranar University, Tirunelveli

40. Mapping Mutual fund schemes

41. Characteristics and perception of house loan borrowers

42. Need and importance of Food security

43. Applicability of Random walk theory to Indian Stock Market

44. Information efficiency of Indian Stock market

45. Indian Stock Market Reaction to the Quarterly Earnings Information

46. Analytical Study on Interim Reporting and its Impact on Share Prices

MARKETING
1. A study on mandi owners perception about branded rice in Chennai
2. A study on satisfaction and loyalty of customers of more super market in
Chennai
. Assessment of marketing feasibility to locate a retail store
Perceptual mapping of different customers loans offered in Indian overseas
bank
. A study on women consumer attitude of purchasing car

. A study on market potential of float glasses in Chennai region

. A study on lifestyle and environmental changes and coping strategies of
migrant workers at saint Gobain glass Ltd. Sriperumbudur

. A study on organizational citizenship behavior and its impact on job
satisfaction of the employees at TNPL

. Training effectiveness among managerial staff in Chennai port trust
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4. A study on employer branding

5. Gap analysis using Job analysis

SYSTEMS AND OPERATIONS

1.

8.

9.

Relative effects of design, integration and information sharing on supply chain

performance

. Quality management practices in wheels India.

Benchmarking the operational efficiency of third party logistics providers using
data envelopment analysis

Implementing supply chain management in a firm

. The linkage between supply chain integration and manufacturing improvement

programmes

. An investigation of supply chain performance measurement in the Indian

automotive sector

. The impact of ERP systems on firm and business process performance

An AHP approach in benchmarking logistics performance of the postal industry

Electronic commerce strategy, operations, and performance in

10. Performance measurement in agri-food supply chains in

11. A data envelopment analysis approach to measuring vendor performance
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FORMAT OF A PROJECT REPORT

Acknowledgement
Abstract

Contents

List of tables

List of figures

Abbreviations

(INTRODUCTION)

1.1 Introduction to the project
1.2 Company

1.3 Product

1.4 Need for the study

1.5 Objectives

1.6 Scope of the Study

1.7 Significance of the Study

1.8 Limitation

(REVIEW OF LITERATURE)

2.1 Introduction-operational definition
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2.2 Review relating concepts

2.3 Review relating to variables

--3 (RESEARCH METHODOLOGY)

3.1 Research Design
3.2 Nature and sources of data
3.3 Questionnaire design and development
3.4 Pilot study
3.5 Reliability and validity of the questionnaire
3.6 Sample design
Sample unit
Sample frame
Sample size
Sampling technique
3.7 Period of the study
3.8 Tools, techniques and formula used

3.9 Software packages used
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--4 (DATA ANALYSIS AND INTERPRETATION)

4.1 Profile of the respondents

4.2 Concept or variable wise analysis

-5 (SUMMARY OF FINDINGS, RECOMMENDATIONS, SCOPE FOR

FURTHER STUDIES, IMPLICATION OF THE STUDY AND CONCLUSION)

. General findings and Specific findings
Recommendations
Educational and societal implications
Directions for future research

. Conclusion

Bibliography (Follow either APA or Harvard Style)

Books

Published articles
. Secondary sources
. Working papers

Reports
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Appendix / Annexure
Questionnaire
Sample frame

Big Table
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ABSTRACT

An abstract is a brief summary of a project, it should have need for the study, objectives,
research methodology and tools used for the study and finding. One sentence may be

devoted for each of the above stated things

SCOPE OF THE STUDY

It is like boundary of the research, it refers to the parameters in with the study will
be operating in. Here you have to state the aspects you have covered in the research
including variables, area and model.

REVIEW OF LITERATURE

Punithavati Pandian (1997) consolidating the views of economists, says that
Investment is the employment of funds on assets with the aim of earning income or
capital appreciation. The investment has two attributes namely time and risk. Present
consumption is sacrificed to get return in the future. The sacrifice that has to be borne is
certain but the return in the future may be uncertain. This attribute of investment
indicates the risk factor. The risk is undertaken with a view to reap some return from the

investment. For a layman, investment means some monetary commitment.

QUESTIONNAIRE
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Profile of the respondents

Try to collect data in metric form

Try to use statement wherever possible

Convert yes or no question into statement form of question

Different scale

Break variables into construct and every construct use some statement otherwise called

items

HYPOTHESIS

Chi-square- HO: There is no significant association between income and saving of the

respondents

ANOVA- Ho: There is no significant difference among different income categories with

respect to their saving

Correlation - Ho: There is no significant relationship between income and saving of the

respondents
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If significant value is less than 0.05 then

For Chi-Square analysis “there is significant association between income and saving of

the respondents”

For ANOVA analysis “there is significant difference among different income categories

with respect to their saving”

For Correlation analysis “there is significant relationship between income and saving of

the respondents”

Sampling Technique

Convenience, Random, Multi stage

ANALYSIS INTERPRETATION

4.1 Profile of the Respondents
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Profile means the demographic characteristics of the sample respondents. The
demographic characteristics include, age, sex, educational qualification and marital status
of the respondents. The study is conducted among teachers of Government Colleges,
Aided Colleges and Universities in Tamil Nadu. The following table shows break up of
respondents from each segment of the population.

TABLE 4.1.1:TYPE OF INSTITUTION

Institution Frequency | Percentage

Government 114 20.7

Aided 295 53.4

University 143 25.9

Total 552 100.0

From the above table 4.1.1 it is clear that around 20 percent of the sample respondents are
working in Government Colleges and 53 percent of them are working in Government
Aided Colleges and 26 percent of the sample respondents are working in universities. As
the number of teachers working in Government Aided Colleges are more than that of
Government Colleges, more number of Aided College teachers are included in the
sample size.

Table 4.1.2: Age of respondents

Age Frequency Percent

31 31.0

66 66.0
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39-48 3.0

Total

The above table indicates that 31% of the respondents fall under the age group category

18-28 years, 3% under the category of 39-48 and 66% under the category 29-38.Thus a

majority of the ex-employee respondents fall in the age group 29-38, and are in the

transition of the Early earning stage and Established earning stage of the Financial

planning cycle.

Points:

Every table should have number and name

Unnecessary rows and columns should not be there in the table

First interpretation for the table and then inference should be written. Inference means

what you infer from the table or what is the conclusion derive from the table

The analysis should be in present tense

Don’t give unnecessary space before and after the table
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Table No. 4.2.1: Chi-Square Test

Asymp. Sig.

Value (2-sided)

Pearson Chi-Square 39.5882 .000

Likelihood Ratio 16.978 .075

Linear-by-Linear

Association

N of Valid Cases 100

a. 14 cells (77.8%) have expected count less than 5. The

minimum expected count is .03.

For example in the above table, We will not using Likelihood Ratio, Linear by linear
association and N of valid cases values for analysis purpose so above thing should be
avoided in the table. Then under the table there is a statement “a. 14 cells (77.8%) have
expected count less than 5. The minimum expected count is .03.” which is warring so that

should be removed

Normally if you copy the SPSS table it will be in Arial so convert into Times new roman

or whatever form your body is in
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Whenever you copy a table there will not be any rows for the table but it always better to
put lines for rows then table should be in centre and values inside the cell should be in
centre

After making above correction the table is displayed below

Table: 4.3.30: Association between Age and the reason for taking up a job at Hurix

Value Asymp. Sig. (2-sided)

Pearson Chi-Square| 39.588? 0.000

Don’t not give - name with tools name

For example if you use correlation to find out relationship of age and satisfaction the -
should be relationship between age and satisfaction and not correlation between age and

satisfaction or simply correlation

Avoid we and | in the project report

Analysis should have different sub -s for example

4.1  Profile of the Respondents

4.2  Respondent’s outlook about Hurix System:

4.3 Brand Perception of the Respondents

If you paste figure from SPSS it will be like this
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Row and Column Points

Symmetrical Normalization

Dimension 2

We WE & Training
™ 18-28 ™
[ ]
29-38
Training M
[ ]

T
1

Dimension 1

M ige
@ Employer Branding Factor

We will not be using row and column points, symmetrical normalization and dimension.

so those things should be removed. To remove this select the picture you will you get

crop function in the menu bar. By using crop function remove unnecessary space and

unnecessary wo rds
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Figure 4.3.4 Correspondence analysis of the Employer branding variables

W ige
@ Employer Branding Factor

WB WE & Training
e 1828 ™
|
28-38

Training M
]
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To find out the association between income and savings

1. Monthly Income

a) Below 10000 b) 10000-20000 c) 20000-30000

d) 30000-40000 e) 40000-50000 f) Above 50000

1. (I). Which of the following do you use to purchase family requirement things?

(a) Only Maligai kadai (road corner shop).

(b) Only Retail Store.

(c) More of retail store and less of Maligai kadai (road corner shop).

(d) More of Maligai kadai (road corner shop) and less of retail store.

To find out the significance difference among different income categories on the level of
satisfaction towards the services provided by the retail stores

2. Monthly Income

a) Below 10000 b) 10000-20000 c) 20000-30000

d) 30000-40000 e) 40000-50000 ) Above 50000

2(I1). Kindly state your level of satisfaction towards the following services provided

by your frequently visited retail store. [Please tick]

Description High Satisfaction | Neutral Satisfaction | No Satisfaction

Parking

Availability of Products

Staff Co-operation

Discounts and Offers
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Home delivery

Location

To find out the relationship between the level of satisfaction and frequency of stores

visited

Kindly state your level of satisfaction towards the following services provided by

your frequently visited retail store. [Please tick]

Description

High Satisfaction

Neutral Satisfaction

No Satisfaction

Parking

Availability of Products

Staff Co-operation

Discounts and Offers

Home delivery

Location

Which organized retail store do you visit :( Kindly select the below)

Description

Most visited

Visited

Least Visited

Never visited

Spencer’s daily
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More

Heritage Fresh

Reliance fresh

To find out the difference between pre and post treatment scores of agility (categorize the pre
and post agility scores into two levels)

To find out the difference between pre and post announcement of quarterly results

The population mean of ‘average monthly minutes' spoken is 200. Test the hypothesis that
sample mean of average monthly minutes' does not differ significantly from the population

mean.

Gender : (a) Male (b) Female
Kindly state your level of satisfaction towards the following services provided by your

frequently visited retail store. [Please tick]

Description High Satisfaction | Neutral Satisfaction | No Satisfaction

Parking

Availability of Products

Staff Co-operation

Discounts and Offers
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Home delivery

Location

What is your level of satisfaction on products of HUL?

FACTOR Highly Highly
Satisfied | Undecided | Dissatisfied
Satisfied Dissatisfied

Price
Features

Quality
Product

How likely have you recommend HUL products to others?

' '
Always | Not at all

5 1

5- Always, 4 — Often, 0 — Can’t say, 2 — Never, 1 — Not at all

Calculate the effects of the following independent variables on propensity to leave:
 Average monthly bill
Avg monthly minutes
Pet used for business
Years using our service

Household income
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Using the 5 point scale shown below, indicate how uncharacteristic or characteristic each of the
following statements is in describing you. Place your rating in the box to the right of the

statement.

1 = Strongly Disagree, 2= Disagree, 3 = Undecided, 4 = Agree, 5 = Strongly Agree

SI. No. Questionnaire for Bank Employees Disagree

Agree

Are you satisfied with the current performance evaluation system of

your bank?

When compared to other banks your banking performance level is

high.

Number of Accounts/transactions performed.

Number of Business generates performed.

Introducing new financial products or services as a result of

customer requirements.

Achievements of performance evaluation will help in my personal

growth.

Overall, how do you feel about the benefits you receive from this

bank?

Our benefits are as good as or better than the benefits in other

banks.

I am satisfied with the priorities & directions of my department.

In my opinion, the bank does a good job of promoting the most
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competent people.

Is the bank provides training facility to the customers use the ICT

(Information and Communication Technology)

I am encouraged to think independently.

I am setting my own Goals.

I have a better idea of my job responsibilities.

I am confident I can achieve my personal career objectives with this

bank.

Managers in this organization are held accountable for their

performance.

| feel I have been sufficiently well trained to deal effectively with

our customers/investors.

My working conditions and environment enable me to do my job

well.

Is the bank adopted the latest technology and standards for the

banking.

Do they feel secure when performing transactions through Bank

website?

Are the customers satisfied by the infrastructure of the internet

provided to them by the Internet Service Provider?

Customer is satisfied by the Quality of Services (QoS) provided by

the Bank.

My coworkers care about the quality of services and programs we

provide.
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I am proud that | work in the bank.

According to me, the Plastic money usage can be improved if Knowledge about usage of Plastic

cards is given and it will help in

Actions Strongly Neither Agree | Disagree Strongly

Agree nor Disagree disagree

Managing instable

income

Reduce malpractices by

outlet owners

Reduce malpractices by

bankers

Using safety measures

Demanding for low cost

cards or zero fee cards.

Demand for lower

interest rates on cards

and loans.

Removing fear about

Credit Card usage.
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Variable 1

Variable 2

Tool

Category

Category

Chi Square

Metric (Dependent)

1 Category variable

ANOVA

2 Category variable

Factorial ANOVA

1 or More Factor variable

1 or More Controlling

ANCOVA

More dependent variable

More factor variable

MANOVA

Metric

Category (Only 2 groups)

Independent- samples T test

Metric (Pre)

Metric (Post) Same variable

Paired — Samples T test

Metric

Metric (Repeated many

times) Same variable

Repeated measures

ANOVA

Metric

Metric

Correlation

Metric (Dependent)

Metric (Independent)

Regression

Dependent variable 1

Many independent variables

Multiple-Regression

1 Dependent

1 or More Independent

variables (Panel Data)

Panel data regression

More than one metric variable (Grouping the variables)

Factor Analysis

More than one metric variable (Segmenting the

respondents)

Cluster Analysis

Category (1 Dependent)

Metric (many Independent)

Discriminant

Dependent 1 variable (with

2 group)

Many Independent variable

Binary Logistics
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More than 1 dependent
variable either Category /

Metric

More than 1 independent
variable either Category /

Metric

Cononical Correlation

To find out the cause and effect relationship

Granger Casuality

To forecast the time series data

ARIMA

To find out the relationship between highly volatile data

ARCH

To find out the efficiency of using input in generating

output

Validity(Item, Construct, Convergent, Divergent)

Checking

CFA

To know any number of relationship

SEM

To find out the overall best considering the many criteria

TOPSIS/AHP

To find out the combination of attributes for the products

Conjoint Analysis
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SPSS — STATISTICAL PACKAGE OF THE SOCIAL SCIENCES (Practical Notes)
1) Generating a Frequency Table
2) Generating a Bar Chart
3) Generating a Pie Chart
4) Generating a Histogram
5) Generating Arithmetic Mean, Median,
6) Standard Deviation and Range
7) Generating Chi — Square Test Correlation Analysis
8) Generating Regression Analysis

9) Generating Analysis of Variance (ANVO) [One— Way]

GENERATING A FREQUENCY TABLE

How to Produce a Frequency Table?

SPSS Commands:

STEP 1 : Data Entered into a data file in SPSS
STEP 2 : Click the button Analyze on the SPSS menu bar [-> Descriptive
Statistics = Frequencies] and opens the frequenties dialog

box.
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STEP 3 : On the dialog box, select variable(s) for analyze and clicking on the
right arrow to send selected variable(s) into Variable(s) List.
STEP 4 : Click OK, the table will appear in the Output Viewer.

Note that in the Frequencies dialog box, variables that have been assigned
lables will appear in terms of their variable lables, but those that have not been
assigned lables will appear in terms of their bariable names. This is a feature of
all dialog boxes produced via Analyze and Graphs.

Consider the following set of 15 scores which were obtained by asking a class

of students their shoe size, shoe width, and sex (male or female).

Shoe Size 10.5 95|85|75|105|85|65|95

Shoe

Width

Gender

Solution:

STEP : 1 Data entered into a data file in SPSS appears as follows:

COMPUTER APPLICATIONS IN BUSINESS Page 236




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION
Manonmaniam Sundaranar University, Tirunelveli

Er! *Untitled1 [DataSet0] - IBM SPSS Statistics Data Editor

File Edit View Data Transform

14 - Gender

&b Size  §a Width 4 Gender
11 B "
6 B F
10 "
9 F
7 F
1 "
9 F
7 "
1 F

M

F

"

"

0o N o s N

=
>»00WOO0®mO000®D >0

N3

<

Overview Data View Variable View

Analyze Graphs  Utilities

[+
]

Extensions

=
=

Window Help

{ A\'r
= [d @

IBM SPSS Statistics Processor is ready

Unicode:ON

STEP : 2 Click the Analyze on the SPSS menu bar [-> Descriptive statistics

3 “Untitled! [DataSet0] - [BM SPSS Statistics Data Editor
Ei

le Edit View Data
i =
== g

& Size  §nWidih & Gender
11 B M
5 F
10 u
9 F
7 F
11 u
9 F
7 M
1 F
M
F
u
M
F

Transform

<

Overiew Data View Variable View

Frequencies -

-> Frequencies] and open the frequencies dialog box.

Power Analysis
Meta Analysis
Reports
Descriptive Statistics
Bayesian Statistics
Tables
Compare Means and Proportions
General Linear Model
Generalized Linear Models
Mixed Models
Correlate
Regression
Loglinear
Neural Networks
Classify
Dimension Reduction
Mapping
Scale
Nonparametric Tests
Forecasting
Survival
Multiple Response
Missing Value Analysis._
Multiple Imputation
Complex Samples
B Simulation...
Quality Control

Qnatinl and Tamnnaral Madalinn

Window  Help
19
===kl @

[ Erequencies...

[Z] Descriptives
Population Descriptives
[Nl Percentiles

£ Explore__

[EZ TURF Analysis

8 Crosstabs_

[Z] Ratio. ..

[ B-P Plots...

[E3 Two-Variable or Group Q-Q Plat
B QQ Plots...

IBM SPSS Statistics Processor is ready F

Unicode:ON
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STEP : 3 On the dialog box, select variable(s) for analyze and clicking on the

right arrow to send selected variable(s) into Variable(s) List.

Edit View Data Transform Analyze Graphs Utilities Extensions Window Help
[ - = | B i =0 2
H& 0 = = 04 9

& size  §aWidth & Gender var var ar var var v v v v v
1" B ] =
6 B F
10 "
9 F
7 F

" M
9 F Variable(s)

§a Width
rmat... |

Visible: 3 of 3 Variables

1
[
F ;

[
" yle
F

>0 0®DO®O0O0T >0

Display frequency tables [[] Create APA style tables

Paste Cancel || Help

Data View Variable View

IBM SPSS Statistics Processor is ready ¢4 Unicode:ON | Classic B

STEP 4 : Click OK, the table will appear in the Output Viewer.
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i@ *Output! [Document1] - IBM SPSS Statistics Viewer

File Edit View Data
i
= X
2 {& output
{8 Log
&-{&] Frequencies
([ Title
& Notes
L Statistics
&--{&] Frequency Table
[ Title
L8 Size
L@ Width
(8 Gender

Transform

N0

Insert

Format

]

Analyze

Graphs

Utilities
L]

Extensions ~ Window  Help

SET Printback=0ff.

= Frequencies

Statistics

Size

Width

Gender

Valid
Missing

14
1

15
0

15
0

Frequency Table

Size

Frequency

Percent

Valid Percent

Cumulative
Percent

Missing  System
Total

1
5
1
3
4
1
5

333

20.0
133
133
933
6.7
100.0

6.7 71

357

6.7 71

214
143
143
100.0
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50.0
74
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100.0

Width
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IBM SPSS Statistics Processor is ready £

Unicode:ON
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GENERATING A BAR CHART

How to Produce a Bar Diagram?

SPSS Commands:

Data Entered into a data file in SPSS - Click the button in Graphs
options.

Select the Graph - Click Bar chart.

Select variable(s) for analyze - Clicking on the right arrow to send
selected variable(s) into Variable(s) List.

Clicking the titles button and enter the Footnotes and Head notes.

Click OK, the table will appear in the Output Viewer.

Draw the bar chart from the following data:

Production
A
Units

Total No. of

Production

Solution :
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STEP 1 : Data Entered into a data file in SPSS - Click the button in Graphs

options.

3 *Untitled? [DataSet0] - IBM SPSS Statistics Data Editor
File Edit View Data Transform Analyze Graphs Utilities Extensions Window Help
= 'L;-j g = i 5l Chart Builder___
Graphboard Template Choaser
[E] Relationship Map...
11 [ Weibull Plot...
[EZ Compare Subgroups
[E3 Regression Variable Plots
EfBar
[l 3-D Bar
[ Line..
[ Area...
B Pie...
[E# High-Low...
[ Boxplot -
[E Error Bar...
[ Population Pyramid...
[ Scatter/Dot
EH Histogram

2
22
23
<

Overview Data View Variable View
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STEP 2 : Select the Graph - Click Bar chart.

Edit View Data Transform Analyze Graphs  Utiities Extensions Window Help
=j O e v 24 =03 LY @*
Ha 0 BT HABEE WO Search sppcatio
80 Visible: & of & Variables
v v v var var

& A #B fc &0 S E var
50 0 40 100 80

#3 Bar Charts
Simple
Clustered

Stacked

Data in Chart Are

O Summaries for groups of cases
@ Summaries of separate variables
O Values of jndividual cases

2
22
23
<

| Ovenview ' DataView Variable View

Unicode:ON | Classic [

IBM SPSS Statistics Processor is readv

STEP 3 : Select variable(s) for analyze - Clicking on the right arrow to send

selected variable(s) into Variable(s) List.
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Edit View Data Transform Analyze Graphs Utiities Extensions Window Help

*
o p— . = ~ 3 Define Simple Bar: Summaries of Separate Variables
= =Ty = @ o n
= ssesd B AR el [nd
30 Bars Represent:

& MEAN([A])
& A #B fc &0 S E 2 veANE)
50 0 40 100 80

L
& MEAN([C])

L

I

(
(

& MEAN(D])
(

& MEAN(E])

Visible: & of & Variables

var
~

Panel by
Rows:

O

Columns:

O

Filter by:

Template
] Use chart specifications from:

<

Overview Data View Variable View

Save this document IBM SPSS Statistics Processor is readv Hf Unicode:ON | Classic =
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STEP 4 : Clicking the titles button and enter the Footnotes and Head notes.

Edit View Data Transform Analyze Graphs Utiities Extensions Window Help

He 0 FhHIl A BE elEl F—

30 & MEAN([A]) -OM“S |- 5 of & Variables
£ £8 £D £E v v v & MEAN([B]) =

var var

50 30 100 80 & MEAN(C])

& MEAN([D])

& MEAN(E])

R Titles

e Panel by

Line 1: ‘Total No. of Praduction|

Line 2- ‘

Subtitle: |

Rows:

O

Footnote Columns:

Line 1- [Production Units
Line 2: ‘
_ 1 L

[J Use chart specifications from:

2
22

<

Overview Data View Variable View

IBM SPSS Statistics Processor is readv Unicode:ON | Classic [

STEP 5 : Click OK, the table will appear in the Output Viewer.
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& *Output2 [Document 2] - BM SPSS Statistics Viewer

File Edit View Data Iransfom Inset Format Analyze Graphs Utilties Extensions Window Help

HER M e KT LD B HE ]

B [E] cutput =+ Graph
& Graph
+{[E) Title
i--Igh Notes
{3 Bar of Total No. of

Total No. of Production

o]

Production Units

IBM SPSS Statistics Processor is ready Unicode:ON | Classic
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GENERATING A PIE CHART

How to Produce a Pie chart?

SPSS Commandes:

Data Entered into a data file in SPSS - Click the button in Graphs
options.
Select pie Button - Click=> Choose value of individual cases—>
Click the Define button.
Select the Case Number.
Click OK; the table will appear in the Output Viwer
Double click above the pie chart and select the element.

Click the show data levels.

In a survey 43% People like the flower Rose and 18% People like Jasmine,
33% People like Sunflower and 6% People like Tulips. For this survey

information, Draw a pie chart.

Solution:
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STEP 1 : Data Entered into a data file in SPSS - Click the button in Graphs

options.

3 *Untitled? [DataSet0] - IBM SPSS Statistics Data Editor
File Edit View Data Transform Analyze Graphs Utiities Extensions Window Help

Ss g % Ii;hgharl Builder

Graphboard Template Chooser.
5 : Liking 1 Grap . Visible: 1 of 1 Variables

& Liking o ‘ , [E Relationship Map.__ . ‘ ‘ ‘ ‘ ‘ ; ; = -
1 43 [ Weibull Plot...
2 18 [EZ Compare Subgroups
3 33 [E3 Regression Variable Plots
f § [ Bar .
6 [l 3D Bar...
[ Line..
E [ Area...
f:.‘ B Pie..
1 [E# High-Low...
12 [ Boxplot -
13 [ Ermor Bar_
1: [ Population Pyramid...
18 [ Scatter/Dot
17 EH Histogram_
18
19
20
21
22
23
<

Overview Data View Variable View

Pie... IBM SPSS Statistics Processor is readv 4 Unicode:ON | Classic =
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STEP 2 : Select pie Button - Click-> Choose value of individual cases—>

Click the Define button.

|a

File Edit View Data Transform Analyze Graphs Utiities Extensions Window Help

Ha 0 =IT A EE
5 : Liking Visible: 1 of 1 Variables
& Liking var v var var var var v v v v ’ v v v var var
1 43
2 18
3 33
4 6

6

3 Pie Charts
8
) Data in Chart Are
10 O Summaries for groups of cases
1 O Summaries of separate variables
12 @ Values of jndividual cases i
13
r Lo [
15
16
17
18
19
20
21
22
23

<

Overview Data View Variable View

IBM SPSS Statistics Processor is readv Unicode:ON | Classic =

STEP 3 : Select the Case Number.
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@
File Edit View Data Transform Analyze Graphs Utiities Extensions Window Help
j o g — . PEm B MW i W] 1 —

HE& [ [a
Visible: 1 of 1 Variables

| 3 . & Liking =
| 18 Slice Labels
33 ® Case Number
6 © Variable:

-

R Titles
Panel by
Rows: Title

- Line 1 |F‘arcantaga of Flowers

Line 2 |

O

Columns: Subitle: |

Footnote

Line 1: [People liking Flawers

O Line 2: |

Filter by:

Template

[[] Use chart specifications from:

<

Overview Data View Variable View

IBM SPSS Statistics Processor is readv 4 Unicode:ON | Classic =
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STEP 4 : Click OK; the table will appear in the Output Viwer.

& *Output! [Document1] - IBM SPSS Statistics Viewer

File Edit View Data Iransfom Inset Format Analyze Graphs Utilities

HER M e~ RELHT 204

Jtput Graph
g] Graph P!

L Title
[l Notes
“»(;1| Pie of Percentage of Flowers

Percentage of Flowers

Case
Number

People liking Flowers
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STEP 5 : Double click above the pie chart and select the element.
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File Edit View Data Transform Inset Format Analyze Graphs Utilities Extensions Window  Help
= @ E‘ Q, Search application

o
HEeR A0 ey KE LS =

é‘lpg‘raph B Chart Editor
1) Title W .E.ile Edit View Options FElements Help
; O @ o B X Y [« g2 Data Label Mode L L e T‘EU”
) -z =@ Wik LEe L
ige of Flowers
Case

[l Notes
“»(;1| Pie of Percentage of Flowers k
Number

People liking Flowers

<
Double click to edit Chart

STEP 6 : Click the show data levels.
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g] Graph

HER AMwe v KFL 25 BRI |
Graph

L Title

i{gd Notes

“»(;1| Pie of Percentage of Flowers

File Edit View Data Iransfom Inset Format Analyze Graphs Utilties Extensions Window Help
stput

Percentage of Flowers

Case
Number

People liking Flowers
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ENERATING A HISTOGRAM
How to Produce a Histogram?

SPSS Commandes:

Data entered into a data File in SPSS - Click the button in Graphs.

Select the Button Histogram —> Click.

Select Variable(s) for analyse and click the right to send Selected
Variable(s) into variable(s) List.

Select the Display normal Curve.

Click ok ; the table will appear in the output viewer.

From the following data, Draw the Histogram.

AGE| 14 | 13 | 12 | 14 | 15 | 12 | 14

Solution :

STEP 1 : Data entered into a data File in SPSS - Click the button in Graphs.

STEP 2 : Select the Button Histogram - Click.
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3 *Untitled2 [DataSet1] - IBM SPSS Statistics Data Editor
File Edit View Data Transform Analyze Graphs Utiities Extensions Window Help
= [2] g P52 . il Chart Builder._.
Graphboard Template Choaser
= Frequenc . Relationship Map...
% ' ’ B Weibull Plot....
[EZ Compare Subgroups
[E3 Regression Variable Plots
EfBar
[l 3-D Bar
[ Line..
[ Area...
B Pie...
[E# High-Low...
[ Boxplot -
[E Error Bar...

Visible: 1 of 1 Variables

var var

[ Population Pyramid...
[ Scatter/Dot
EH Histogram

22
<

Overview Data View Variable View

Histoaram... IBM SPSS Statistics Processor is readv Unicode:ON | Classic

STEP 3 : Select Variable(s) for analyse and click the right to send Selected

Variable(s) into variable(s) List.
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Edit View Data Transform Analyze Graphs Utiities Extensions Window Help

.-_' L‘;] g e e ﬁ | % mj |‘A ¢:‘ Iz‘ Q, Search application

#2 Histogram

Visible: 1 of 1 Variables

var

Frequenc
& var v var var
y

Variable:
% # Frequency
[JDisplay normal curve
Panel by
Rows:

-»

9 O

10 Columns
"
12
13 Filter by:
14
15
16
17
18
9
:
21

22

Template
[ Use chart specifications from:

<

‘ Overiew Data View Variable View
| IBM SPSS Statistics Processor is readv Unicode:ON | Classic [

STEP 4 : Select the Display normal Curve.
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(@

‘Elle Edit View Data Transform Analyze Graphs Utilities Extensions Window Help

HE D e~ EhAP A BE JOEE

3 Histogram

& Frequenc
ar ar ar

a ar var ar ar
Variable: =

. ¥ & Frequency

12 Display normal curve,

14

Panel by
15

Rows:

-

O

Columns:

Filter by:

Template

[J Use chart specifications from:

<

‘ Overview Data View Variable View

Visible: 1 of 1 Variables

ar

IBM SPSS Statistics Processor is readv 4 Unicode:ON | Classic [

STEP 5 : Click ok ; the table will appear in the output viewer.
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& *0utput3 [Document 3] - 1BM SPSS Statistics Viewer
File Edit View Data Iransfom Inset Format Analyze Graphs Utiities Extensions Window Help

HSR M e~ KELI RS WE L ]

E+[E] Cutput = Graph
& Graph
+[E Title
i--Igh Notes
(i Histogram of Frequ

Frequency

14

Frequency
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GENERATING ARITHMETIC MEAN, MEDIAN,

TANDARD DEVITION AND RANGE

How to Produce the Mean, Median,
Standard Deviation and Range?

SPSS Commandes:

Data Entered into a data file in SPSS - Click the button Analyze.

Select Descriptive statistics = Explore [opens the explore dialog box].

Select variable(s) for analyse and clicking the right to send selected
variale(s) into variable(s) List.

Click OK, the table will appear in the Output Viewer.

Age of the 12 peoples are given. Calculate the arithmetic mean, median,

standard deviation, and range from the following data:

Solution :
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STEP 1 : Data Entered into a data file in SPSS - Click the button Analyze.

ile Edit View Data Transform Analyze Graphs Utilities

H = 0 Ea=T M

12 : AGE 18 Visible: 1 of 1 Variables
& nGE

9
10
"
12
13
14
15
16
17
18
19
20
2
22
23

<

Overview Data View Variable View

IBM SPSS Statistics Processor is readv
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STEP 2 : Select Descriptive statistics - Explore [opens the explore dialog

box].

#8 *Untitled1 [DataSet0] - IBM SPSS Statistics Data Editor

File Edit View Data Transform

i=§ &5

Hae 0
12 - AGE 18

& AGE var

20

21
30 Compare Means and Proportions

Power Analysis
Meta Analysis
Reports

Descriptive Statistics
Bayesian Statistics
Tables

35 General Linear Model
Generalized Linear Models
Mixed Models

Correlate

© o N ;W N s

Regression
Loglinear

Neural Networks
Classify

Dimension Reduction

B2 3

Mapping
Scale

o BT

Nonparametric Tests
Forecasting

Sunvival

Multiple Response

21 Missing Value Analysis.

1
1
1
1
1
1
1
17
18
19
20

22 Multiple Imputation
23

Window  Help
H Od @

Erequencies

Descriptives

[#] Population Descriptives

[Nl Percentiles

£ Explore...

EZ TURF Analysis

[ Crosstabs

Ratio

[ P Plots

[E2 Two-Variable or Group Q-Q Plot

[ Q-Q Plots

Visible: 1 of 1 Variables

ar

<

Complex Samples

B2 Simulation

Overview Data View Variable View

Exolore.

Quality Control
Spatial and Temporal Modeling.

IBM SPSS Statistics Processor is readv 4
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STEP 3 : Select variable(s) for analyse and clicking the right to send selected

variale(s) into variable(s) List.
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|
|a
File Edit View Data Transform Analyze Graphs Utiities Extensions Window Help

HE e ] ﬁ [ A % | ‘ Search applcation
Visible: 1 of 1 Variables

12 : AGE
var var

& AGE

~

Dependent List:
— 13 Explore: Plots

& AGE [AGE]
Boxplots Descriptive
Options P pt
@ Eactor levels together
© Dependents together
O None

Label Cases by:
[] Normality plots with tests

Display Spread vs Level with Levene Test
@ Both O Statistics O Plats

Overiew Data View Variable View
IBM SPSS Statistics Processor is readv Unicode:ON | Classic [

STEP 4 : Click OK, the table will appear in the Output Viewer.
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& *Output3 [Document3] - IBM SPSS Statistics Viewer

File Edit View Data Iransfom Inset Format Analyze Graphs Utilties Extensions Window Help

HE8R &M Kb RS MR

B [E] cutput Descriptives
& Explore

Statistic Std. Error
[ Mean 3367 3914

L8 Case Processing £ 95% Confidence Interval for - Lower Bound 25.05
i--L§ Descriptives Mean Upper Bound 42.28
&-[E] AGE 5% Trimmed Msan 3307

b Title

+-( Histagram Median 3250
i--L[ Stem-and-Lea Variance
(i) Boxplot Std. Deviation

Minimum

Maximum

Range
Interquartile Range
Skewness

Kurtosis

Histogram

Mean = 3367
Std.Dev. = 13.56
N=12

IBM SPSS Statistics Processor is ready 4 Unicode:ON | Classic

COMPUTER APPLICATIONS IN BUSINESS Page 262




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION
Manonmaniam Sundaranar University, Tirunelveli

ENERATIN Hi- ATE TEST AND

CORRELATION ANALYSIS

In order to generate a contingency table, along with a Chi-square test and

Correlation, the following procedure should be followed:

How to Generate a Contingency Table?(Chi-square and correlation)

SPSS Commandes:

Data Entered into a data file in SPSS - Click the button Analyze.
Select Descriptive statistics = crosstabs.....[opens the Crosstabs
dialog box.
Select variable(s) for analyse.
Click Statistics button and Select Chi-square and Correlation and
Continue
STEP 5 : Click OK, the table will appear in the Output Viewer.

Find the Chi-square and Correlation from the following data;

AGE 20 | 21 | 30 | 35 | 40 | 45 | 60 | 52

WEIGHT | 45 | 57 | 50 | 65 | 60 | 62 | 58 | 65
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Solution :

STEP 1 : Data Entered into a data file in SPSS - Click the button Analyze.

tP *Untitled2 [DataSet1] - IBM SPSS Statistics Data Editor
File Edit View Data Iransfom Analyze Graphs Utiities Extensions Window Help

== =] — 2 e e
He 0 =LF A BE (9

12 : WEIGHT 48 Visible: 2 of 2 Variables
& AGE & WEIGHT var var var var v v v var ar

IS

9
10
11
12
13
14
15
16
17
18
19
20
21
22
23

<

Overiew Data View Variable View

IBM SPSS Statistics Processor is ready & Unicode:ON | Classic
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STEP 2 : Select Descriptive statistics = crosstabs.....[opens the Crosstabs

dialog box.

tP *Untitled2 [DataSet1] - IBM SPSS Statistics Data Editor
Fil

le  Edit View Data Transform
Power Analysis

!
= = Meta Analysis

12 WEIGHT 48 Regorts

& AGE & WEIGHT Descriptive Statistics
20 45 Bayesian Statistics
2 48 Tables
30 50
35 65
40 60
45 62

60 58
52 65 Correlate

Compare Means and Praportians
General Linear Model
Generalized Linear Models
Mixed Models

36 68 Regression
25 62 Loglinear
2 58 Neural Networks
18 48 Classify
Dimension Reduction
Mapping
Scale
Nonparametric Tests
Forecasting
Sunval
Multiple Response
Missing Value Analysis...
Multiple Imputation
< Complex Samples
Ovenview Data View Varable View 5 Simulation..

Quality Control
Crosstabs...

Qnatinl and Tammnaral Madalinn

Window  Help

[E] Erequencies...

[ Descriptives...
Population Descriptives
[Nl Percentiles

B Explore..

[E3 TURF Analysis

5 Crosstabs

[ Ratio_...

|2l B-P Plats...

[E3 Two-Variable or Group Q-Q Plot
[ a-Q Plots...

STEP 3 : Select variable(s) for analyse.
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File Edit View Data Iransfom Analyze Graphs Utiities Extensions Window Help

P O le==c] o xx ey &
H&e 0@ LT A BE el
12 - WEIGHT 48 Visible: 2 of 2 Variables

& AGE & WEIGHT v var var var var v v v , v y y v var var
3 Crosstabs

IS

Row(s):
& Age [AGE]

Column(s):

Cells
Format

& Weoght [WEIGHT]
ot

Layer 1 of 1 Bootstrap.

O

[ Display clustered bar charts
[ Suppress tables

23
<

Qverview Data View Variable View
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STEP 4 : Click Statistics button and Select Chi-square and Correlation and

Continue.
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View Data Transfom Analyze Graphs Utiities Extensions Window Help

A o = 2y e oo &
Ha @ PR EE O
12 - WEIGHT 48 Visible: 2 of 2 Variables
& AGE £ WEIGHT v v v v v v v , v : v v v var var
20 @&
n
30
35 Chi-square
40

45
50 [ Contingency coefiicient  [[] Gamma

52 [C]Bhi and Cramer's V [ Somers' d
36 [Lambda [ Kendall's tau-b
2 [JUncertainty coefficient  [] Kendall's tau-c

2
P MNominal by Intenal [1Kappa

[Eta [1Risk
[ McNemar

#2 Crosstabs: Statistics

Nominal Ordinal

[] Cochran’s and Mantel-Haenszel statistics

[ Display clust

] Suppress tab
Paste || Reset ||Cancel || Help

<
Qverview Data View Variable View
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STEP 5 : Click OK, the table will appear in the Output Viewer.

& *Outputs [Documents] - 1BM SPSS Statistics Viewer
File Edit View Data Iransfom Inset Format Analyze Graphs Utiities Extensions Window Help

Hea®a a0 KEHE B [a] [

=] Output = Crosstabs
&-{&] Crosstabs
»

Case Processing Summary
Cases
valid Missing Total
N | Percent N | Percent N | Percent
Age * Weoght 12| 100.0% o] 00% 12 | 100.0%

ase Pr ing
iU Age * Weoght Cros
~-L g Chi-Square Tests

] Measur

Age “Weoght Crosstabulation

Weoght
58 50

Chi-Square Tests
| ‘ | Asymptotic

~
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ENERATING REGRESSION ANALYSI

SPSS Commandes:

STEP 1 : Data Entered into a data file in SPSS - Click the button Analyze.

STEP 2 : Click on Regression and followed by linear.

STEP 3 : Select a dependent variable clicking on the arrow leading to the
dependent box after highlighting the appropriate variable from the
list of variables on the left side.

STEP 4 : Select the independent variables to be included in the regression model
in the same way, transferring them from left side to the right side
box by clicking on the arrow leading to the box called independnt
variables.

STEP 5 : Select the METHOD in the same dialog box.

SETP 6 : Select OPTIONS, if need additional output options.

STEP 7 : Click OK from the main dialogue box to get the regression output.

Consider the data on the quantity demand and the price of a commodity

over a twelve-year period as in the given below:

Year 2000 | 2001 | 2002 | 2003 | 2004 | 2005 2009 | 2010
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80.0 | 65.0|70.0 | 75.0 | 60.0 | 65.0 | 90.0 |102.0 | 108.0

80 | 60 | 70 | 60 | 80 | 70 | 7.0 5.0 4.0

(a) Find out the correlation coefficient between the quantity demand and price
and interpret.

(b) Compute coefficient of determination (r?) and interpret.

(C) Estimate the linear regression equation of demand on price and

interpret.
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Data for SPSS Format:

Year Demand

2000 80.00

2001 65.00

2002 70.00

2003 75.00

2004 60.00

2005 65.00

2006 90.00

2007 102.00

2008 108.00

2009 50.00

2010 55.00

2011 75.00

Descriptive Statistics

std. Deviation

Demand 17.9416
Frice 1.7233

Correlation Matrix
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Demand

Pearson Correlation

Demand
Price

1.000
-.283

Sig. (1-tailed)

Demand
Price

1 BE

-l

Demand
Price

12

12

Model Summary

Model R

R Sguare

Adjusted R
sSquare

std. Error of
the Estimate

1 2838

080

-012

18.0467

a. Predictors: (Constant), Price

Model

sum of
Squares

Mean Square

1 Regression
Residual
Total

284.085
3256832
3540917

284.085
323683

a. Dependent Variahle: Demand

b, Predictors: (Constant), Price

a. Predictors: ( Constant ), Price

b. Dependent Variable: Demand
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Coefficient

Standardized
Unstandardized Coefficients | Coefficients

Model B St Emor Beta

1 (Constant) 43.260 20 65
Price -2.644 3158 - 283

3. DependentVariable: Demand

. Dependent Variable: Demand
From Table 7.2, the result indicates that the correlation between demand and
price is 283, which is same as when the problem is solved out manually. The p-
value for the correlation coefficient is 186 ( | —tailed ) and assume level of
significance.
From Table 7.3, the coefficient of determination (r2 ) is 0.082. This means that
8% of the variations in the quantity demand are explained by price.
From = 93.26 - -2.949 Price

The intercept and the slope term are93.26 and -2.949.
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Program -

ENERATING ANALYSIS OF VARIANCE (ANOVA) [ONE-WAY

SPSS Commandes:

STEP 1 : Data Entered into a data file in SPSS - Click the button Analyze.

STEP 2 : Click on compare means and then One-way ANOVA.

STEP 3 : Select the appropriate variable as the dependent variable and take it to
the right hand side box called DEPENDENT list, then select
another appropriate variable,i.e., independent variable appears
from the list of the variable on the left had side of the box and click
the arrow to the factor box.

STEP 4 : Then click OPTION followed by DESCRIPTIVES.

STEP 5 : Click CONTINUE to return to the main dialog box.

SETP 6 : Click OK to get output for One-way ANOVA.

The following data represents the numbers of units produced by three

operators durig three diferent sifts:

Shifts Operators

B

5
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Using 5% level of significance, perform one-way analysis of variance and interpret
the result.

Data for SPSS format:

SINO Operators

1 6

2 5

Results of One-way ANOVA
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OFPERATORS

Sum of
Sguares

Mean Square

Between Groups
Within Groups
Total

18.000
14.000
32.000

6.000
1.750

Interpretation: It could be noted that the results in the above table, the P-

Value for the problem is 0.073 which is less than the 0.05, the null hypothesis is

rejected. We conclude that there is no significance in the number of units

produced by three operators during three different sifts.
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Program - 9

GENERATING ANALYSIS OF VARIANCE (ANOVA) [TWO-WAY]

SPSS Commandes:

Data Entered into a data file in SPSS - Click the button Analyze.

Click on GENERAL LINEAR MODEL followed by UNIVERIATE.

Take the appropriate variable as the dependent variable box, and then
select another appropriate tow variables as FIXED FACTORS.
The independent variable is the first factor and the block variable
is the second factor.

Click MODEL, followed by CUSTOM.

. Take both the factors one by one to the right hand side box called

Click CONTIONUE to return to the main dialog box.

Click OK to get output for Two-way ANOVA.

The following table presents the number of the defective pieces produced by

three workmen operating in turn on three different machines:

Workmen Machines

A B
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27 34

29 32

22 30

Conduct a Two-way ANOVA to test at 5% Level of significance, Whether:

a) The difference among the means obtained for the three workmen can be
attributed to chance.

b) The difference among the means obtained for the three machines can be

attributed to chance.

Solution:
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Data for SPSS format:

SINO Operators

1 6

2 5

Results of One-way ANOVA

STEP 1 : Data Entered into a data file in SPSS - Click the button Analyze.
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v *Untitled2 [DataSet1] - IBM SPSS Statistics Data Editor

Eile Edit Yiew Data Transform Analyze DirectMarketing Graphs  Utilites  Add-gns

Window

Help

eI Tl T N EL DL

Name Type Width
X Numeric 12 0 None None
Machine
Workmen

Decimals Label Values

Numeric 12 0 None None
Numeric 12 0 None None

Missing

Measure Role

& Scale N Input
Right & MNominal N Input
= Right & Nominal N Input

Columns Align
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STEP 2 : Click on GENERAL LINEAR MODEL followed by UNIVERIATE.

v *Untitled2 [DataSet1] - IBM SPSS Statistics Data Editor
Eile Edit Yiew Data TIransform  Analyze DirectMarketing Graphs  Utilities Add-gns  Window  Help

SHe E e BHEEHFE H BE B o9

Name e Width Decimals Label Values Columns Align Role

X 12 0 Mone ane 12 = Right cale  Input
Machine Numeric 12 0 MNene Nene 12 = Right & Nominal N Input
Workmen Numeric 12 0 Mone None 12 = Right & Nominal N Input

3
2
3
4
5
5

8
10
"
12
13
14
15
16
17
18
19
20
21
22
23
24

[1

Data View variable View

1BM SPSS Stalistics Processor is ready Unicode:ON

"D "~ - v "omsaEE S AT e PRD 0%

STEP 3 : Take the appropriate variable as the dependent variable box, and then
select another appropriate tow variables as FIXED FACTORS.
The independent variable is the first factor and the block variable

is the second factor.
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@
Eile

Edit View Data  Transform Analyze DirectMarketing Graphs  Utilities Addons  Window  Help

SHE e B EAEE B B B2 .99

Name Type Width | Decimals Label Values Missing | Columns Align Measure Role
X Numeric 12 0 None None 12 = Right & Scale N Input
Machine Numeric 12 0 None None 12 = Right & Nominal N Input
Workmen | Numeric 12 0 1R Univariate x| N Input

Dependent Variable (_stoser
% [#x
Fixed Factor(s)

(] | wortmen
-

Come
Random Factor(s):
= Bootstrap.
Covariate(s):
hd |:|

WLS Weight

3
2
3
4
5
3
7
8

-

1B SPSS Statistics Processor is ready Unicode:ON
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SETP 6 : Click CONTIONUE to return to the main dialog box.

Eile Edit Yiew Data TIransform  Analyze DirectMarketing Graphs  Utilities Add-gns  Window  Help

Sl BELE HEY BLE 19

Name Type Width | Decimals Label Values Missing | Columns Align Measure Rale
X Numeric 12 0 Mone None 12 = Right & Scale N Input

Machine Numeric 12 0 . Mana Nana 12 Rinht £ MNaminal N Input
Workmen Numeric 12 0 18 Univariste: Model % out
Specify Model
© Full factorial ® Custom
Factors & Covariates: Model

[ Wachine Machine
[ workmen Workmen

3
2
3
4
5
5
7
8

Build Term(s)
Type:

10
1
12
13
14
15
16
17
18
19
= 1 : 1

Interaction v

Sum of squares: |Type lll ~ [¥ Include interceptin model

23
2

[1

Data View variable View

1BM SPSS Statistics Processor is ready Unicode:ON

"D " v "omsaEE S AT PRD 0

STEP 7 : Click OK to get output for Two-way ANOVA.
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i =
S #® *Output2 [Document2] - IBM SPSS Statistics Viewer
_!E\\e Edit View Data Transform [nsert Format Analyze  DirectMarketing Graphs  Utilities  Add-ons  Window  Help

BHER IO« JEBLA 00 &

= Univariate Analysis of Variance

[Datasetl]

- Between-Subjects
[ Tests of Between-| Between-Subjects Factors

N

Machine

Waorkmen

1
2
3
1
2
3

Tests of Between-Subjects Effects

Depandent Variable: X

Type 1 Sum
Source of Squares Mean Square
Corrected Model 1457787 36.444
Intercent 6615111 6615.111
Machine 118222 59111
Warkmen 27.556 13.778
Error man 2778
Total 6772.000
Corrected Total 156.889
a. R Squared = 929 (Adjusted R Squared = 858)

=2 4) O
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X = No.of defective pieces

Between Subject Factors

Machine

Workmen

Results for Two-way ANOVA Tests of Between Subjects Effects

Dependent Variable: X

Type I11 Sum of
Source Mean Square
Squares

Corrected 145.778 36.444 13.120

Model
6615.111 6615.111 5 381E3

Intercept
118.222 59.111 91280

Machine
27.556 13.778 4.960
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Workmen 11.111 2.778

Error 6772.000

Total 156.889

Corrected Total

a. R Squared =.929 (Adjusted R Squared = .858)
From the above table, the P- values corresponding to the hypothesis for the
machines and workmen are 0.007 and 0.083 respectively. The assumed level

of significance is 5%.

Interpretation:

a) As the p-value corresponding to the hypothesis for the machines is less
than the level of significance, the null hypothesis in such cases is rejected.
That means average number of defects for various machines is different.
As the p-value corresponding to the hypothesis for the workmen is more
than the level of significance, the null hypothesis in such cases is accepted.
We conclude that the average number of defectives items produced by the

three workmen does not vary significantly.
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UNIT IV
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UNIT IV Introduction to Tally Prime: Introduction — Starting Tally
Prime — Creation of a Company - Selecting company - Shutting a
company - Altering company- Creating Accounting groups and ledgers
— Vouchers — Practical problems for a new and existing business and
not-for profit organization. Accounting reports: Introduction -
Displaying Trial balance, Profit and Loss Account, Balance sheet, Day
book, Purchase register, Sales register, Cash flow /Funds flow and ratio

analysis — Practical problems.

Introduction to Tally Prime

Tally Prime is comprehensive business management software designed by
Tally Solutions, aimed at simplifying accounting, inventory, payroll, and
tax-related tasks for small to medium-sized businesses. As the latest version
of Tally's flagship product, Tally Prime builds upon the functionalities of
previous versions (like Tally.ERP 9) and introduces new features to enhance

usability, adaptability, and overall efficiency.

Tally Prime is well-suited for businesses looking to streamline their
accounting and financial operations. It provides features that simplify

complex business processes and ensure accuracy in financial records. From
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generating invoices to managing cash flow, tracking inventory, and filing
GST returns, Tally Prime is a powerful tool that handles a wide range of

business operations within a single platform.

Here are some core features of Tally Prime:

User-Friendly Interface

Tally Prime introduces a more intuitive, user-friendly interface, making it
easier for both beginners and experienced users to navigate. The interface
supports multi-tasking, allowing users to switch between tasks or access

multiple reports without losing progress on any open tasks.

Multi-Tasking Capabilities

Users can now handle multiple tasks in Tally Prime without having to close
windows or lose track of ongoing tasks. This new feature allows for
increased productivity and enables quick transitions between different

activities, like moving from an invoice to a report with minimal hassle.

Enhanced Reporting and Analytics

Tally Prime provides real-time insights and customizable reports, giving

business owners and accountants the tools to make data-driven decisions.
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The reports are designed to be easy to interpret, even for non-finance
professionals, and offer deeper insights into areas like sales, purchases, cash

flow, and profitability.

Inventory Management

With Tally Prime, businesses can efficiently manage their stock and
inventory. This feature provides insights into stock levels, helps reduce
wastage, and supports better demand forecasting, ultimately helping

businesses keep their inventory balanced and cost-effective.

GST and Tax Compliance

Tally Prime simplifies GST and other tax-related tasks, ensuring compliance
with local tax regulations. The software automatically updates to reflect
changes in tax laws and helps users generate GST-compliant invoices, file

returns, and maintain accurate records for audits.

Remote Access and Security

Tally Prime allows for secure remote access, enabling business owners and

employees to access business data from anywhere. This feature is especially

COMPUTER APPLICATIONS IN BUSINESS Page 289




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION
Manonmaniam Sundaranar University, Tirunelveli

useful for businesses that require flexible work arrangements. Data security

Is a priority in Tally Prime, ensuring that sensitive information is protected.

Scalability and Adaptability

Tally Prime can scale with growing businesses, accommodating new
features and add-ons as required. This adaptability makes it a suitable choice
for businesses that anticipate growth and the need for more advanced
functionalities over time. Overall, Tally Prime is a powerful, flexible, and
user-centric solution for managing key business functions. It combines ease
of use with robust capabilities, making it an ideal choice for companies
looking to optimize their operations and maintain compliance with financial
regulations. The latest upgrades in Tally Prime further simplify the
complexities of business management, making it an invaluable asset for

today’s fast-paced business environment.

Program — 10
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Creating a Company Ledger with Opening Balance and Viewing It in the

Trial Balance in Tally Prime

This guide explains how to create a company ledger with an opening balance in Tally
Prime and view it in the Trial Balance. Follow each step carefully for a smooth

workflow.

Procedure: Creating a Company Ledger with Opening Balance

1. Open Tally Prime Program
o Launch Tally Prime on your computer.
o Click on Continue in Educational Mode to proceed if using the free
version.
2. Create a Company
o Press ALT + K to open the Company Menu.
o Select Create (or press ALT + C) to start creating a new company.
3. Enter Company Details
o You’ll now see the Company Info menu.
o Enter all required company details, such as:
=  Company Name
Mailing Address
Contact Information
Financial Year Beginning Date

Books Beginning Date
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4. Save the Company
o Once all details are entered, press Ctrl + A to save and create the

company.

Step-by-Step Guide: Creating Ledgers

1. Access the Ledger Menu
o Go to the Gateway of Tally.
o Select Create under the Ledger Menu.
2. Choose Between Single Ledger or Multiple Ledgers
o To create a Single Ledger:
= Select Ledger from the Create menu.
= Enter the ledger details, including:
= Name of the Ledger
= Group (e.g., Sundry Debtors, Sundry Creditors)
= Opening Balance (if any)
= Press Ctrl + A to save the single ledger.
o To create Multiple Ledgers:
= Go to Chart of Accounts.
= Select Ledger under the Multi-Master Menu (press ALT + H).

= Choose Multi Create to create multiple ledgers.
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= Enter the details for each ledger, ensuring the correct opening
balance if applicable.

= Save all ledgers by pressing Ctrl + A.

Viewing the Trial Balance Report

1. Navigate to the Trial Balance
o Return to the Gateway of Tally.
o Select Display More Reports.
o Choose Trial Balance from the list of reports.
2. View Ledger and Trial Balance Report
o The Trial Balance report will display all created ledgers with their
respective balances.

o Review the report to ensure all ledgers and balances are correctly entered.

By following these steps, you’ve successfully created ledgers with opening balances and
viewed them in the Trial Balance report in Tally Prime. This process is essential for

maintaining accurate financial records and ensuring that all accounts are balanced.

Problem :

Prepare a Trial Balance from Bakya company

S.No. Particulars Amount
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Capital 50,000

Cash 15,760

Bank 12,000

Purchase 27,100

Sales 27,000

Furniture 15,000

Stock in hand 1,800

Brokerage paid 40

Typewriter

Rent paid

Salary

Return inward

Return outwards

Debtors

Travelling expenses

Sundry creditors

Discount allowed

Telephone charges

Interest allowed
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Ledger report on Bakya Company

-

¥:Data 8 0:Import E: Export M: E-mail P:Print Fi:Help
x

Under Group 4+ All items For 1-Apr-24
F3: Company

SN0, Name of Ledger Under Opening Balanee DriCr F4: Group

Bank Accounts 12,000.00 Dr

. Brokerage Paid Indirect Expenses 40.00 Dr

. Capital Capital Account 50,000.00 Cr

Cash Cash-in-Hand 15,760.00 Dr

Debtors Current Assets 4,400.00 Dr

. Discount Allowed Indirect Expenses 100.00 Dr

. Furniture Fixed Assels 15,000.00 Dr

. Interest Allowed Indirect Expenses 2,600.00 Dr

. Profit & Loss Alc + Primary

. Purchase Purchase Accounts 27,100.00 Dr

. RentPaid Indirect Expenses 1,000.00 Dr

. Return Inwards Sales Accounts 100.00 Dr

. Returns Outwards Purchase Accounts 1,100.00 ¢r  [:More Details
. Salary Paid Indirect Expenses 1,500.00 Dr

. Sales Sales Accounts 27,000.00 Cr

. Stock in Hand Stock-in-Hand 1,800.00 Dr | 5:Zero Opening
. Sundry Creditors Current Liabilties 420000 cr | Dalence

. Telephone Charges Indirect Expenses 500.00 Dr | i Change Parent
. Travelling Expenses Indirect Expenses 100.00 Dr Group

. Typewriter Fixed Assels 2,100.00 Dr

NI I TR S Y

F12: Configure

Trial balance on Bakya company
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TallyPrime wanAE
EDU I Company LR L:Exchange O:Import E: Export M:E-mail P:Print Fi:Help
Trial Balance - i
F2: Period
Bakya
For 1-Apr-24 F3: Company
Closing Balance
Debit Credit

Particulars
Fd: Group

50,000.00 | 5:Ledger-wise

(Capital Account
4,200.00

Current Liabilities

Fixed Assets 17,100.00

Current Assets 32,160.00
100.00 27,000.00
27,100.00 1,100.00

5,840.00

F6: Monthly

Sales Accounts
Purchase Accounts
Indirect Expenses

E:Basis of Values
H:Change View

J: Exception
Reports

L: Save View

C:New Column

A: Alter Column

N:Auto Column

Grand Total 82,300.00 §2,300.00

R:Remave Line F12: Configure
TCHE O 0N

Trial Balance Total amount is Rs.82,300.

Program — 11

Creating a Ledger and VVoucher in Tally Prime and Viewing Results in

Trading, Profit and Loss Account, and Balance Sheet

This guide provides a detailed process for creating ledgers and vouchers in Tally Prime

and displaying the results in the Trading Account, Profit and Loss Account, and Balance

Sheet.
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Aim

To create a ledger and voucher in Tally Prime and view the results in the Trading

Account, Profit and Loss Account, and Balance Sheet.

Procedure: Creating a Ledger and Voucher in Tally Prime

1. Open Tally Prime Program
o Start Tally Prime on your computer.
o Click on Continue in Educational Mode if using the free version.
2. Create a Company
o Press ALT + K to access the Company Menu.
o Select Create (or press ALT + C) to create a new company.
3. Enter Company Information
o The Company Info menu will open.
o Fill in the required details for the company, including:
=  Company Name
Mailing Address
Contact Information
Financial Year Beginning Date
Books Beginning Date
4. Save the Company

o Press Ctrl + A to save and create the company.
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Step-by-Step Guide: Creating Ledgers

1. Access the Ledger Menu
o Go to the Gateway of Tally.
o Choose Create under the Ledger Menu.
2. Create Ledgers
o To create a Single Ledger:
= Select Ledger from the Create menu.
= Enter the necessary ledger details, such as:
= Name of the Ledger
= Group (e.g., Purchases, Sales, Sundry Debtors, etc.)
= Opening Balance (if applicable)
= Press Ctrl + A to save the single ledger.
o To create Multiple Ledgers:
= Go to Chart of Accounts.
= Select Ledger under Multi-Master Menu (press ALT + H).
= Choose Multi Create to enter multiple ledgers at once.

= Fill in the ledger details and press Ctrl + A to save.
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Creating Vouchers for Adjustment Entries

1. Access Voucher Creation
o From the Gateway of Tally, go to Voucher Entry.
2. Create Different Types of Vouchers
o Use the following types of vouchers to record various transactions:
= Purchase Voucher: For recording purchases.
Sales VVoucher: For recording sales.
Payment Voucher: For recording expenses or payments.
Receipt Voucher: For recording income or received funds.
Journal Voucher: For recording adjustments and transfers.
3. Enter Adjustment Entries
o Fill in the required information for each voucher, such as the account,
amount, date, and narration.

o Press Ctrl + A to save each voucher entry.

Viewing the Profit and Loss Account and Balance Sheet

1. Display Profit and Loss Account
o From the Gateway of Tally, select Profit and Loss Account.
o This report will show the overall profit or loss of the company based on
the transactions recorded.

2. Display Balance Sheet
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o Return to the Gateway of Tally and select Balance Sheet.

o The Balance Sheet will show the company’s assets, liabilities, and equity.

3. Change Period (Optional)

o To view the report for a specific period, press F2 and enter the desired

date range.
4. Review Results in the Profit and Loss Account and Balance Sheet

o Analyze the Profit and Loss Account to see the company’s income and

expenses.

o Check the Balance Sheet to ensure assets and liabilities are balanced.

By following these steps, you’ve successfully created ledgers, entered vouchers, and
viewed the results in the Trading Account, Profit and Loss Account, and Balance Sheet in
Tally Prime. This process is essential for maintaining accurate financial records and

understanding the financial health of your business.

Problem:

Prepare a Trading, Profit and loss account and balance sheet of Bharathi

Company as on 31-03-2025.
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Particulars Amount

Opening stock as on 01.04.2024 70,000

Capital 80,000

Wages 14,000

Cash in hand 20,000

Purchase 27,500

Sales 89,000

Carriage inwards 2,000

Carriage outward 2,000

Brokerage paid 400

Printing and Stationery 2,000

Rent paid 3,000

Salary 13,000

Return inward 2,100

Return outwards 5,100

Discount received 4,400

Travelling expenses 100

Discount allowed 900

Telephone charges 800

Interest received 22,000

Bad debts 1,600

Furniture 20,000
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Plant and machinery 30,000

Unsecured loan 8,900

Additional information:-
Outstanding wages Rs.2000.
Prepaid salary Rs.1000.

Depreciation on furniture @ 10% and Plant and

machinery @ 5%

Closing stock as on 31-03-2025 Rs.40,000.

Trading and profit and loss account on Bharathi company as on 31-03-2025
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Bharathi
Particulars 1-Apr-24 to 31-Mar-25 Particulars

Opening Stock 50,000.00 Sales Accounts
Purchase Accounts 32,600.00 Closing Stock
Direct Expenses 18,000.00
Gross Profit c/o 26,300.00

1,26,900.00
Indirect Expenses 30.700.00 Gross Profit b
Nett Profit 17,600.00 Indirect Incomes

48,300.00 Total

Select |+

Balance sheet of Bharathi company as on 31-03-2025

O:Import E:Export M: E-mail P:Print Fl:Help

X F2:Period
Bharathi
1-Apr-24 to 31-Mar-25 F3: Company

86,900.00
40,000.00

1,26,900.00

26,300.00
22,000.00

B:Basis of Values
H: Change View

J: Exception
Reports

L:Save View

C:New Celumn

A: Alter Column

N: Auto Column

48,300.00

R:Remove Line F12: Configure
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Z:Exchange G: 0:import E: Expo! M: E-mail P:Print

Bharathi
as at 31-Mar-25

Capital Account 80,000.00 Fixed Assets 46,500.00
Loans (Liability) Current Assets 61,000.00
Current Liabilities 10,900.00 Difference in opening balances 1,000.00

Profit & Loss Alc 17,600.00
Opening Balance
Current Period 17,600.00

B: Basis of Values

Change View

Exception
Reports

L:Save View

C:New Column

A: Alter Column

: Auta Column

1.08,500.00 Total 1,08,500.00

Result:-

» Trading account balance on Gross Profit Rs.26,300
» Profit and loss account balance on Net Profit Rs.17,600

> Balance sheet Total Rs.1,08,500
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Program — 12

Creating an Income and Expenditure Account for a Non-Profit Organization

in Tally Prime

This guide provides step-by-step instructions for setting up an Income and Expenditure

Account for a non-profit organization in Tally Prime.

Aim

To create an Income and Expenditure Account for a non-profit organization.

Procedure: Setting Up the Income and Expenditure Account

1. Open Tally Prime Program
o Launch Tally Prime on your computer.
o Click on Continue in Educational Mode if using the free version.
2. Create a Company
o Press ALT + K to open the Company Menu.
o Select Create (or press ALT + C) to create a new company.
3. Enter Company Information
o Inthe Company Info menu, fill in the necessary details for the non-profit
organization, including:
= Organization Name

= Mailing Address
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= Contact Information
= Financial Year Beginning Date
= Books Beginning Date
4. Save the Company
o After entering all the required details, press Ctrl + A to save and create

the organization in Tally Prime.

Step-by-Step Guide: Creating Ledgers for Income and Expenditure

1. Access the Ledger Menu
o Go to the Gateway of Tally.
o Select Create under the Ledger Menu.
2. Create Ledgers for Income and Expenditure
o To create a Single Ledger:
= Select Ledger from the Create menu.
= Create ledgers for all income and expenditure accounts, such as:
= Income Ledgers: Donations, Grants, Membership Fees,
Event Income, etc.
Expenditure Ledgers: Salaries, Rent, Utilities, Stationery,
Event Expenses, etc.
= For each ledger, enter the following:

= Name of the Ledger
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= Group (e.g., Income or Expenditure)
= Opening Balance (if applicable)
= Press Ctrl + A to save each ledger.
o To create Multiple Ledgers at once:
= Go to Chart of Accounts.
Select Ledger under Multi-Master Menu (press ALT + H).
Choose Multi Create to enter multiple ledgers at once.
Fill in the ledger details, ensuring they are grouped correctly under
Income or Expenditure.

Save all ledgers by pressing Ctrl + A.

Viewing the Income and Expenditure Account

1. Display Profit and Loss Account as Income and Expenditure Account

o Go to the Gateway of Tally.
o Select Alter from the main menu.
o Choose Profit and Loss Account.
2. Configure Profit and Loss as Income and Expenditure Account
o When viewing the Profit and Loss Account, Tally Prime allows you to
configure it as an Income and Expenditure Account.

o Tally may prompt you to convert it—select Yes if prompted.

3. View Income and Expenditure Account
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o The Profit and Loss Account will now display as an Income and
Expenditure Account, showing all income and expenditure entries for the
non-profit organization.

4. Review the Income and Expenditure Report
o Analyze the report to understand the financial health of the organization,

showing total income, total expenditure, and net surplus or deficit.

By following these steps, you have successfully set up and displayed an Income and
Expenditure Account for a non-profit organization in Tally Prime. This process allows
the organization to track all income and expenditure transactions, ensuring accurate

financial records and clear financial reporting.

Problem:
From the following prepare an income and expenditure account for the year ended

31% March.

Particulars Amount Particulars Amount

To Subscription Received 30,000 | By salaries 36,000

To Subscription received in 2,000 | Byrent 6,000

advance

To Interest on investment By printing and stationery

To bank interest By postage
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To Sale proceeds of car 2,500

Income and Expenditure account

TallyPrime MANAGE
EDU K:Company Z:Exchange O:Import E:Export M: E-mail P:Print
Ineome and Expenditure Statement IE COMPANY x
F2:Period
IE COMPANY IE COMPANY
For 1-Apr-24 F3:Company

Particulars For 1-Apr-24 Particulars

43,700.00 Indirect Incomes 45,600.00

250.00 Bank Interest
Printing and Stationery 1,450.00 Interest on Inestment
Rent 6,000.00 Saleprocedds of Car
36,000.00 Subscription Received

Salaries
Excess of income over expenditure 1,900.00
F§:Valuation

100.00
15,000.00
2,500.00
28,000.00

Indirect Expenses
Postage

E:Basis of Values
H:Change View

J:Exception
Reports

L:Save View

C:New Column

A: Alter Column

N Auto Column

45,600.00

R:Remove Line F12: Configure

45,600.00 Total

Space: Select |»

Result:-

» To successfully created in income and expenditure account for non-profit

organization.
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Program —1

Creating a Voucher and Viewing the Report in the Day Book in Tally Prime

This guide explains the steps to create vouchers in Tally Prime and view them in the Day

Book, which provides a chronological summary of all daily transactions.

Aim

To create a voucher and display the report in the Day Book.

Procedure: Creating a Voucher and Viewing in the Day Book

1. Open Tally Prime Program

o Launch Tally Prime on your computer.

o Click on Continue in Educational Mode if using the free version.
2. Create a Company

o Press ALT + K to access the Company Menu.

o Select Create (or press ALT + C) to start creating a new company.
3. Enter Company Details

o Inthe Company Info menu, enter the required company details:

= Company Name
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Mailing Address
Contact Information
Financial Year Beginning Date
Books Beginning Date
4. Save the Company

o Once all details are filled in, press Ctrl + A to save the company.

Step-by-Step Guide: Creating Ledgers

1. Access the Ledger Menu
o Go to the Gateway of Tally.
o Select Create under the Ledger Menu.
2. Create Ledgers for Voucher Entries
o You can create Single Ledger or Multiple Ledgers:
= For a Single Ledger:
= Select Ledger from the Create menu.
= Enter the details such as:
= Ledger Name
= Group (e.g., Sales, Purchases, Expenses)
= Opening Balance (if applicable)
= Press Ctrl + A to save.

= For Multiple Ledgers:
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Go to Chart of Accounts.

Select Ledger under Multi-Master Menu (press ALT + H).
Choose Multi Create to enter multiple ledger details at
once.

Press Ctrl + A to save all ledgers.

Creating Vouchers for Transactions

1. Access Voucher Creation
o From the Gateway of Tally, select Voucher Entry.
2. Select Voucher Type
o Inthe Voucher Entry screen, press Ctrl + H to change the mode, then
select As Voucher.
3. Adjust Debit/Credit Display Mode (Optional)
o Totoggle between Dr/Cr and By/To display modes, press F12 for
Configuration options.
4. Enter Voucher Details
o Choose the voucher type based on the transaction:
= Sales Voucher: for sales transactions.
= Purchase Voucher: for purchase transactions.
= Payment VVoucher: for recording payments.

= Receipt Voucher: for recording receipts.
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o Enter the details such as:
= Date
= Ledger Account
=  Amount
= Narration

o Press Ctrl + A to save each voucher entry.

Viewing the Day Book

1. Open the Day Book
o From the Gateway of Tally, select Display More Reports.
o Click on Day Book to open the daily transactions report.
2. Change Period (Optional)
o To view a specific date range, press F2 and enter the desired period.
3. Review the Day Book Report
o The Day Book will display all transactions chronologically, showing all

vouchers recorded on each day.

By following these steps, you’ve successfully created vouchers and viewed them in the
Day Book in Tally Prime. The Day Book provides a detailed, chronological view of daily

transactions, essential for verifying and reviewing entries made each day.

COMPUTER APPLICATIONS IN BUSINESS Page 313




DIRECTORATE OF DISTANCE AND CONTINUING EDUCATION
Manonmaniam Sundaranar University, Tirunelveli

Problem :
Enter the following transaction in appropriate accounting vouchers
1. Mohan started business with cash Rs. 20,000
2. Bought goods for cash Rs.10,000
. Sold to Lal Rs.12,000
Bought goods from Arun Rs.5,000
. Sold goods for cashRs.8,000
Paid into BankRs.8,000
Received from Lal Rs.7,000
Paid to Arun Rs.3,000
Paid to stationery Rs.200
. Bought furniture for office use Rs.1,750
. Paid for postage Rs.20
. Paid for General expenses Rs.50
. Paid for salary Rs.2,500

. Paid for Rent Rs.750
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TallyPrime
O:Import E:Export M:E-mail P:Print

* F2:Date
Day Book For 1-Apr-24
F3:Company
Date Particulars Vch Type Debit Amount Credit Amount| -,
Inwards Qty  Outwards Qty Voucher Type

1-Apr-24 Arun Payment 3,000.00

1-Apr-24 Stationery Payment 200.00

1-Apr-24 Furniture Payment 1,750.00

1-Apr-24 Postage Payment 20.00

1-Apr-24 General Expenses Payment 50.00

1-Apr-24 Salary Payment 2,500.00

1-Apr-24 Rent Payment 750.00

1-Apr-24 Capital Receipt 20,000.00

1-Apr-24 Lal Receipt 7,000.00

1-Apr-24 Bank Journal 8,000.00

1-Apr-24 Lal Sales 12,000.00

1-Apr-24 Cash Purchase 10,000.00

1-Apr-24 Arun Purchase 5,000.00
E:Basis of Values

H:Change View

J:Exception
Reports

L:Save View

2:Duplicate Vieh I:Insert Vch D:Delete X:Cancel Veh R:Remove Line F12: Configure

M
Result:-

» The Day book is created in Tally Prime.
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Creating a Purchase Register and Sales Register in Tally Prime

This guide provides detailed steps to create a Purchase Register and Sales Register in

Tally Prime, allowing you to view all purchase and sales transactions in one place.

Aim

To create a Purchase Register and Sales Register for a company in Tally Prime.

Procedure: Creating Purchase and Sales Registers

1. Open Tally Prime Program

o Launch Tally Prime on your computer.

o Click on Continue in Educational Mode if using the free version.
2. Create a Company

o Press ALT + K to open the Company Menu.

o Select Create (or press ALT + C) to start creating a new company.
3. Enter Company Information

o Inthe Company Info menu, fill in all necessary company details:
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Company Name
Address and Contact Information
Financial Year Beginning Date
Books Beginning Date

4. Save the Company

o After entering the details, press Ctrl + A to save the company.

Step-by-Step Guide: Creating Purchase and Sales VVouchers

1. Create Purchase and Sales Vouchers
o Go to the Gateway of Tally.
o Select Voucher Entry to create purchase and sales vouchers for both cash
and credit transactions.
2. Create Purchase Vouchers
o InVoucher Entry, select Purchase Voucher from the list.
o Enter the following details for each purchase transaction:
= Date (press F2 to change the date as needed)
Supplier’s Ledger (e.g., under Sundry Creditors or Cash/Bank if
cash purchase)
Item details, Quantity, and Rate
Total Amount and applicable taxes (if any)

o Press Ctrl + A to save each purchase voucher.
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3. Create Sales VVouchers

o Go back to Voucher Entry and select Sales VVoucher.
o Enter details for each sales transaction, including:
= Date (use F2 to adjust)
Customer’s Ledger (e.g., under Sundry Debtors or Cash/Bank for
cash sales)
Item details, Quantity, and Rate
Total Amount and applicable taxes (if any)

o Press Ctrl + A to save each sales voucher.

Viewing the Purchase and Sales Registers

1. Access the Registers from Gateway of Tally
o From the Gateway of Tally, select Display More Reports.
2. View Purchase Register
o Under Display More Reports, go to Accounts Books.
Select Purchase Register to view all recorded purchase transactions.

The Purchase Register shows details of all purchases within the specified
period.

3. View Sales Register

o In Accounts Books, select Sales Register to see all recorded sales

transactions.
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o The Sales Register provides a summary of all sales entries for the chosen
period.
4. Adjust the Period (Optional)
o Press F2 to change the date range if you want to view transactions for a

specific period.

By following these steps, you have successfully created and displayed the Purchase
Register and Sales Register in Tally Prime. These registers provide an organized view of
all purchase and sales transactions, helping with transaction tracking and financial

analysis.

Problem :

Create in Purchase register/Sales register AS company
1. Sold goods to Anand Rs.10,000 as on 02.04.2024
2. Sold goods to Muthu Rs.30,000 as on 02.06.3024
. Sold goods to cash Rs.25000 as on 02.08.2024
Purchase goods from Ram Rs.20000 dated on 02.10.2024
Purchase goods from cash Rs.10000 as on 02.12.2024

Purchase goods from amutha Rs.30000 dated on 01.01.2025

Sales register from AS company
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O:Import

Particulars

Debit

Agpril

May

June

July
August
September
October
November
December
January
February
March

Grand Total

M:E-mail

Sales

AS
1-Apr-24 to 1-Aug-24
Transactions

Credit

10,000.00
30,000.00

25,000.00

65,000.00

30000
20000
10000

0 Apr May Jun Jul Aug

R 8

Select |+

O:Import

Particulars

Debit

April

May

June

July
August
September
October
November
December
January
February
WMarch

20.000.00

10,000.00
30,000.00

Grand Total 60,000.00
30000

20000

Jun

q Select |

Result:-

» To successfully create in Purchase register and sales register.
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Feb

Mar

E:Remove Line

M:E-mail

Purchase

1-Apr-24 to 1-Jan-25

Transactions

Credit

Oct Now Dec Jan Feb Mar

R:Remove Line

P:Print

Closing
Balance

10,000.00 Cr
10,000.00 Cr
40.000.00 Cr
40.000.00 Cr
65,000.00 Cr

65,000.00 Cr

P:Print

Closing
Balance

20.000.00 Dr
20.000.00 Dr
30,000.00 Dr
60,000.00 Dr

60,000.00 Dr
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Lo ==}

Exception
Reports

L: Save View
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N:Auto Column
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Period
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Basis of Values
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J: Exception
Reports
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Creating Cash Flow, Fund Flow, and Ratio Analysis Reports in Tally Prime

This guide provides step-by-step instructions for generating Cash Flow, Fund Flow, and

Ratio Analysis reports in Tally Prime, essential for financial analysis of a company.

Aim

To create Cash Flow, Fund Flow, and Ratio Analysis reports for CF company in Tally

Prime.

Procedure: Setting Up Cash Flow, Fund Flow, and Ratio Analysis

1. Open Tally Prime Program

o Start Tally Prime on your computer.

o Click on Continue in Educational Mode if using the free version.
2. Create a Company

o Press ALT + K to open the Company Menu.

o Select Create (or press ALT + C) to create a new company.

3. Enter Company Information
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o Inthe Company Info menu, fill in the required company details:
= Company Name
Mailing Address
Contact Information
Financial Year Beginning Date
Books Beginning Date
4. Save the Company

o After entering all details, press Ctrl + A to save the company.

Creating Vouchers for Cash Transactions

1. Create Cash Vouchers Only
o Go to the Gateway of Tally.
o Select Voucher Entry to create vouchers for cash transactions only, as
these will affect cash flow and fund flow.
2. Enter Details for Cash Transactions
o Choose Payment Voucher for cash payments or Receipt Voucher for
cash inflows.
o Enter the following for each transaction:
= Date (use F2 to adjust the date)
= Ledger Account (e.g., Expenses, Sales, etc.)

= Cash account details
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= Amount and any applicable narration

o Press Ctrl + A to save each cash transaction voucher.

Viewing the Cash Flow, Fund Flow, and Ratio Analysis Reports

1. Access Cash Flow and Fund Flow Reports
o From the Gateway of Tally, go to Display More Reports.
Under Accounts Books, select Cash Flow to view all cash-related
transactions for the period.
Similarly, select Fund Flow to see the fund movement, highlighting
sources and uses of funds.
2. Access Ratio Analysis
o From the Gateway of Tally, select Ratio Analysis.
o This report provides key financial ratios, including:
= Current Ratio: Measures liquidity.
Debt-to-Equity Ratio: Indicates the leverage level.
Net Profit Ratio: Shows profitability.
Return on Capital Employed (ROCE): Gauges efficiency of
capital use.
o These ratios give insights into the company’s financial health and
performance.

3. Adjust the Period (Optional)
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o Press F2 to change the date range for viewing reports within a specific

period.

By following these steps, you’ve successfully created and displayed the Cash Flow, Fund
Flow, and Ratio Analysis reports for CF company in Tally Prime. These reports provide
valuable insights for managing cash flow, tracking fund sources and uses, and evaluating

financial health through key ratios.

Problem :

. Starting in CF company into capital Rs.1,00,000 as on 01.04.2024
Purchas in plant and machinery as on 01.07.2024 Rs.20,000
Purchase in goods as on 02.04.2024 Rs.50,000

. Sales to goods as on 01.05.2024 Rs.20,000
Discount received as on 06.06.2024 Rs.20,000
Interest received as on 01.05.2024 Rs.10,000
Paid rent as on 02.04.2024 Rs.1000

8. Paid salary 02-04-2024 Rs.3000

9. Cash deposited into bank as on 01.08.2024 Rs.50,000

10. Cash withdraw from bank as on 01.10.2024 Rs.10000

11. Paid to general expenses as 31.03.2025 Rs.200
Output:-

Cash flow statement
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Particulars

April
May

June

July
August
September
October
November
December
January
February
March

Grand Total

100000

Particulars

April

May

June

July
August
September
Octaber
November
December
January
February
March

Grand Total

50000

{-)50000

O:Import

CF
1-Apr-24 to 31-Mar-25

M: E-mail

Cash Movement

Inflow

1.00,000.00
30,000.00
20,000.00

1,50,000.00

Qutflow

54,000.00

20,000.00

74,200.00

Feb

Mar

R:Remove Line

©O: Import

1-Apr-24 to 31-Mar-25

M: E-mail

CF

Working Capital

Opening

46,000.00
76,000.00
96,000.00
76,000.00
76,000.00
76,000.00
76,000.00
76,000.00
76,000.00
76,000.00
76,000.00

Clasing

46,000.00
76,000.00
96,000.00
76,000.00
76,000.00
76,000.00
76,000.00
76,000.00
76,000.00
76,000.00
76,000.00
75,800.00

75,800.00

Q:Quit

Feb

Mar

R:Remove Line

Ratio analysis
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F2: Period

F3: Company
Nett
Flow

46,000.00
30.000.00
20,000.00

(4120.000.00

()200.00 B:Basis of Values
c

H: Change View

Save View

75,800.00 < Mew Column

A: Alter Column

1: Aute Column

F12: Configure

P: Print
X F2:Period
F3:Company

Funds
Flow

46,000.00
30,000.00
20,000.00

{-)20.000.00

()200.00 B:Basis of Values
H:Change View

Save View

75,800.00 & Mew Column

A: Alter Column

N:Auto Column

F12: Configure
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CF
Principal Groups

Working Capital
(Current Assets-Current Liabilities)
Cash-in-Hand
Bank Accounts
Bank OD Alc

Sundry Debtors
(due till today)
Sundry Creditors
(due till today)

Sales Accounts
Purchase Accounts
Stock-in-Hand

Nett Loss

Wkg. Capital Turnover

(Sales Accounts / Working Capital)
Inventory Turnover

(Sales Accounts / Closing Stock])

Space:Select |~

Result:-
Cash Flow statement is created.

Fund Flow statement is created.

Ratio analysis is created in tally prime.

O:Import port

CF

1-Apr-24 to 31-Mar
-25

20,000.00 Cr
70.000.00 Dr Recv. Turnover in days

24.200.00 Dr

0.26

0.00
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Principal Ratios

75,800.00 Dr Current Ratio

(Current Assets : Gurrent Liabilities)

35.800.00 Dr Quick Ratio
40,000.00 Dr

(Current Assets-Stock-in-Hand : Current Liabilities)
Debt/Equity Ratio
(Loans {Liabilify) : Capital Account + Neft Profif]

Gross Profit %
Nett Profit %
Operating Cost %
(as percentage of Sales Accounts)

(payment performance of Debfors)

Return on Investment %

(Nett Profit / Capital Account + Nett Profit )
Return on Wkg. Capital %

(Nett Profit / Working Capital) %

R:Remove Line

M: E-mail

P: Print F1:Help

* F2:Period
CF
1-Apr-24 to 31-Mar | F3:Company
-25

0.00:1
0.00:1

0.00:1

(-)250.00 %
(12100 %
22100 %

days

()3193%

(43193 % H:Change View
- b

Save View

C:New Column

A: Alter Column

N Auto Column

F12:Configure
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UNIT V Inventory and GST in Tally Prime Inventory: Introduction to
Inventory Masters — Creation of stock group — Creation of Godown —
Creation of unit of measurement — Creation of stock item — Entering
inventory details in Accounting vouchers — Practical problems. GST:
Introduction — Enabling GST - Defining tax details — Entries in

Accounting vouchers — View invoice report — Practical problems.

Creating an Inventory Voucher and Displaying the Stock Summary Report in

Tally Prime

This guide provides the steps to create an inventory voucher in Tally Prime and view it in

the Stock Summary report, which shows the inventory details of items.

Aim

To create an inventory voucher and display it in the Stock Summary report in Tally

Prime.
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Procedure: Setting Up and Displaying Inventory in Tally Prime

1. Open Tally Prime Program
o Launch Tally Prime on your computer.
o Click on Continue in Educational Mode if using the free version.
2. Create a Company
o Press ALT + K to open the Company Menu.
o Select Create (or press ALT + C) to start creating a new company.
3. Enter Company Details
o Inthe Company Info menu, fill in all required details:
= Company Name
Address and Contact Information
Financial Year Beginning Date
Books Beginning Date
4. Save the Company

o After entering all details, press Ctrl + A to save the company.

Step-by-Step Guide: Setting Up Inventory in Tally Prime

1. Create Stock Group
o Go to the Gateway of Tally.

o Select Create and then Stock Group.
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o Enter the Stock Group name and relevant details, grouping similar items
under one category.
o Press Ctrl + A to save the Stock Group.
2. Create Stock Items
o From the Gateway of Tally, select Create and choose Stock Item.
o For each stock item, enter details like:
Item Name
Stock Group
Unit of Measure
Opening Quantity and Rate (if applicable)
o Press Ctrl + A to save each stock item.
3. Create Unit of Measure
Return to Gateway of Tally, select Create and then Unit.
Define units like "pcs"” (pieces), "kg" (kilogram), etc., based on inventory
requirements.

Press Ctrl + A to save the unit.

Creating an Inventory Voucher

1. Access Inventory Voucher Creation
o From the Gateway of Tally, go to Voucher Entry.

2. Change to Item Invoice Mode
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o Inthe Voucher Entry screen, press Ctrl + H to switch to Item Invoice
mode.
3. Enter Inventory Details in Voucher
o Select the appropriate voucher type (e.g., Purchase Voucher or Sales
Voucher).
o Enter details such as:
Date (use F2 to change as needed)
Stock Item Name
Quantity and Rate
Total Amount

o Press Ctrl + A to save the voucher.

Viewing the Stock Summary Report

1. Access Stock Summary
o From the Gateway of Tally, go to Stock Summary under Display More
Reports.
2. Review Stock Summary Report
o The Stock Summary report provides an overview of all stock items,
showing:
= Closing Stock

= Inward and Outward Quantities
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= Opening Balances (if any)
3. Adjust the Period (Optional)

o Press F2 to set a specific date range for the report.

By following these steps, you have successfully created an inventory voucher and viewed
the Stock Summary report in Tally Prime. This report helps you monitor stock levels,

view incoming and outgoing stock, and manage inventory efficiently.

Problem:

Enter the following transaction in appropriate inventory vouchers

1. Purchase shirt from Madura Coats Companies
a) Cotton shirt 15 nos @ Rs.130
b) Formal shirt 23 nos @ Rs.190
2. Purchase Saree from Lakshmi Mills
a) Punam saree 18 nos @ Rs.350
b) Silk sarees 18 nos @ Rs.2,500
3. Purchase kids wear from Mangal Deep Company
a) Frocks 15 nos @ Rs.370

b) Chudidhar 12 nos @ Rs.420
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4. Sold shirt to Jayachandran Textiles
a) Cotton shirt 12 nos @ Rs.170
b) Formal shirts 15 nos @ Rs.220
5. Sold saree to RMKYV silks
a) Punam sarees 14 nos @ Rs.430
b) Silk sarees 12 nos @ Rs. 3,800
6. Sold kids wear to life style
a) Focks 12 nos @ Rs.450

b) Chudidhars 10 nos @ Rs.540
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TallyPrime
Z:Exchange O:Import E:Export M: E-mail P:Print
* F2:Period
NS
For 1-Apr-24 F3:Company
Closing Balance
Quantity Rate Value

Particulars
F4: Stock Group

Chudidhars 2.00 nos 420.00 840,00 F5:Stock Group
Cotton Shirt 300n0s  130.00 390.00  -wise
Formal Shirt 3.00n0s  190.00 1,520.00
Frocks 300n0s  370.00 1,110.00
400nos  350.00 1,400.00) £7-Show Profit

Punam Saree
Silk Saree 6.00nos  2,500.00 15,000.00
F&:Valuation

F6: Monthly

B:Basis of Values
H:Change View

Exception
Reports

J
L:Save View

C:New Column

A Alter Column
N:Auto Column

26.00 nos 20,260.00

Grand Total
R:Remove Line F12: Configure

0: Quit Space: Select |»

Result:-

» The stock entries are successfully created.
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Creating an Inventory Voucher with Discount and Displaying in Trial

Balance in Tally Prime

This guide provides comprehensive steps to create an inventory voucher with discounts in
Tally Prime and view it in the Trial Balance report, which helps assess the financial

position of a company.

Aim

To create an inventory voucher using discount methods and display the resulting balances

in the Trial Balance report.

Procedure: Step-by-Step Guide

1. Open Tally Prime Program
o Start the Tally Prime software on your computer.
o Click on Continue in Educational Mode if you are using the free version
for practice.

2. Create a Company
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o Press ALT + K to open the Company Menu.
o Select Create (or press ALT + C) to initiate the creation of a new
company.
3. Enter Company Information
o Inthe Company Info menu, fill in all necessary company details:
= Company Name: Enter the name of the company.
Address: Input the mailing address.
Contact Information: Provide phone numbers or email.
Financial Year Beginning Date: Set the start date of the financial
year.
Books Beginning Date: Specify the date from which you want to
maintain the accounts.
4. Save the Company

o After entering all details, press Ctrl + A to save the company.

Setting Up Inventory

1. Create Stock Group
o From the Gateway of Tally, select Create and then Stock Group.
o Enter a name for the stock group (e.g., "Electronics").
o Press Ctrl + A to save the Stock Group.

2. Create Stock lItems
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o From the Gateway of Tally, go to Create and select Stock Item.

o For each stock item, fill in the following:
= Item Name: Enter the name of the stock item (e.g., "Laptop").
= Stock Group: Select the relevant stock group created earlier.
= Unit of Measure: Specify the unit (e.g., "nos" for number of

items).

= Opening Balance: Enter the quantity and rate if applicable.

o Press Ctrl + A to save each stock item.

3. Create Units of Measure
o Navigate to the Gateway of Tally, select Create, and then Unit.
o Define units such as "pcs"” (pieces), "kg" (kilograms), etc.

o Press Ctrl + A to save the unit.

Creating an Inventory Voucher with Discount

1. Access Voucher Entry
o From the Gateway of Tally, go to Voucher Entry.
2. Change to Item Invoice Mode
o Inthe Voucher Entry screen, press Ctrl + H to switch to Item Invoice
mode.
3. Configure Discount Settings

o Press F12 to open the Features Configuration.
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o Look for the option Use Discount Column in Invoice and set it to Yes.
This allows you to apply discounts directly in the invoice.
o Save changes and return to the voucher entry screen.
4. Enter Inventory Details in Voucher
o Choose the appropriate voucher type (e.g., Sales Voucher).
o Fill in the required details:
Date: Change the date if needed (use F2).
Stock Item: Select the stock item (e.g., "Laptop").
Quantity: Enter the number of items sold or purchased.
Rate: Input the rate per item.
Discount: Enter the discount percentage or amount as applicable.

o Press Ctrl + A to save the voucher.

Viewing the Trial Balance Report

1. Access the Trial Balance Report
o From the Gateway of Tally, select Display More Reports.
o Choose Trial Balance from the list.
2. View Trial Balance
o The Trial Balance report will display all ledgers along with their debit and

credit balances.
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o Toview in ledger-wise format, press Ctrl + H to toggle the report format
and select Ledger-wise or press F5 for detailed view.

3. Adjust the Period (Optional)

o Use F2 to change the date range for the report, allowing you to see

transactions for a specific period.

By following these steps, you have successfully created an inventory voucher with a
discount and displayed it in the Trial Balance report in Tally Prime. This process helps

you keep track of inventory transactions and assess the overall financial position of the

company through the Trial Balance.

Problem:

Enter the transaction in inventory voucher and display the result in trial balance

report.
1. Purchase goods from Samsung Company
a) Samsung TV 11 nos @ Rs.11,000 @ discount 10%
2. Purchase goods from videocon Company
a) Videocon Washing Machine 4 nos @ Rs.6,000 discount 5%
b) Videocon TV 14 nos @ Rs.7,000 discount 2%
3. Sold goods to Mr. Ram

a) Samsung TV 5 nos @ Rs.13,000 discount 5%
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b) Videocon TV 6 nos @ Rs.9,000 discount 4 %

¢) Videocon Washing Machine 2 nos @ Rs.8,000 discount 10%
4. Sold Goods from Arun

a) Samsung TV 1 nos @ Rs.14,000 discount 10%

b) Videocon TV 2 nos @ Rs.10,000 discount 10%
5. Purchase Return to Videocon Company

a) Videocon Washing Machine 1 nos @ Rs.8,000
6. Sales Return from Mr. Ram

a) Samsung TV 1 nos @ Rs.10,000
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TallyPrime
Z:Exchange O:Import E:Export M: E-mail P:Print
F2:Period ‘
Samsung Company
Particulars For 1-Apr-24 F3:Company ‘
Closing Balance

Debit Credit F4: Group

F5: Group-wise "

Opening Stock

Arun 30,600.00 £

Cash 108,900 oo | * ¥ Menthly
Mr.Ram 1,17,990.00

Purchase 2,19,740.00

Sales 1,48.590.00

Vediocon Company 1.10.840.00

E:Basis of Values
H:Change View

J:Exception
Reports

L:Save View

C:New Column

A: Alter Column

N Auto Column

3,68,330.00 3,68,330.00

Grand Total
R:Remove Line F12: Configure

Space: Select |»

Result:-

»  Successfully created inventory voucher and display trial balance report.
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Creating a Purchase Invoice Bill with GST in Tally Prime

This guide outlines the steps to create a purchase invoice with GST in Tally Prime,

ensuring that all GST details are accurately captured for compliance and reporting.

Aim

To create a purchase invoice bill that includes GST.

Procedure: Step-by-Step Instructions

1. Open Tally Prime Program
o Launch the Tally Prime software on your computer.
o Click on Continue in Educational Mode if you're using the educational
version.
2. Create a Company
o Press ALT + K to access the Company Menu.
o Select Create (or press ALT + C) to start creating a new company.

3. Enter Company Information
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o Inthe Company Info menu, fill in the necessary company details:
= Company Name: Enter the name of your business.
Address: Input the full mailing address.
Contact Information: Provide phone numbers and email if
needed.
Financial Year Beginning Date: Set the starting date of your
financial year.
Books Beginning Date: Specify the date from which you want to
maintain your books of accounts.
4. Save the Company

o After entering all details, press Ctrl + A to save the company.

Setting Up Ledgers for GST

1. Alter Menu to Create Ledgers

o Go to the Gateway of Tally and select Alter.

o Click on Ledger to create or modify existing ledgers.
2. Create Necessary Ledgers

o Create ledgers required for purchases, including:

= Purchase Account: This will capture the total purchase amount.
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=  GST Input (CGST/SGST/IGST): Create separate ledgers for
input GST, categorized based on applicable rates (e.g., 5%, 12%,
18%, 28%).
o While creating ledgers, ensure to select the correct group:
= Purchases Account under Purchase Accounts for the purchase
account.
= Duties & Taxes for GST input ledgers.

o Press Ctrl + A to save each ledger.

Setting Up Stock for Purchases

1. Create Stock Group
o From the Gateway of Tally, select Create and then Stock Group.
o Enter the name of the stock group (e.g., "Electronics™).
o Press Ctrl + A to save the Stock Group.
2. Create Stock Items
o Select Create and choose Stock Item from the Gateway of Tally.
o For each stock item, enter the following:
= Item Name: Specify the name of the stock item (e.g., "Laptop").
= Stock Group: Select the relevant stock group created earlier.
= Unit of Measure: Specify the unit (e.g., "nos" for number of

items).
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= Opening Balance: If applicable, input the opening balance.
o Press Ctrl + A to save each stock item.
3. Create Units of Measure
o From the Gateway of Tally, select Create and then Unit.
o Define the unit of measure such as "pcs"” (pieces), "kg" (kilograms), etc.

o Press Ctrl + A to save the unit.

Creating a Purchase Invoice with GST

1. Access Purchase Voucher Entry
o From the Gateway of Tally, navigate to Voucher Entry.
2. Change to Item Invoice Mode
o Inthe Voucher Entry screen, press Ctrl + H to switch to Item Invoice
mode.
3. Enter Purchase Invoice Details
o Select Purchase Voucher.
o Fill in the following details:
= Date: Adjust the date as needed (use F2).
Party Name: Select or create the ledger for the supplier from
whom you are purchasing.
Item Details:

= Select the stock item (e.g., "Laptop™).
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= Enter the Quantity.
= Enter the Rate.
= The system will automatically calculate the Amount.
= GST Details: Ensure to enter the applicable GST percentage
(CGST/SGST/IGST) in the appropriate columns. The system will
compute the GST amount automatically.
4. Save the Purchase Voucher
o After entering all necessary details, press Ctrl + A to save the purchase

invoice.

Viewing the Purchase Invoice Bill

1. Access the Day Book
o From the Gateway of Tally, select Display More Reports.
o Choose Day Book to view all transactions, including the purchase invoice.
2. Show the Purchase Invoice Bill
o Inthe Day Book, use Ctrl + P to print or view the purchase invoice
details.

o You can filter the date range if necessary to display the specific invoice.
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By following these steps, you have successfully created a purchase invoice bill with GST
in Tally Prime. This process helps in maintaining accurate records for GST compliance

and provides a detailed view of purchases for better financial management.

Problem:

1. Purchased on 10 Tv @ Rs.15,000

2. Purchased on12 Radio @ Rs.1000
. Purchase on2 Fan @ Rs.875
. Purchased on 1 Washing machine @Rs.18,000
. Purchased on 1 Fridge @ Rs.15,000
. Purchased on2 Sealing fan @ Rs.2,500
. Purchased on 2 cooker @ Rs.1,200

8. Purchased on 2 cuttle @ Rs.18,000

9. Purchase on 1Bed @Rs.1000

You are required prepare for purchase invoice bill with GST
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Ledger Report for Ram company

TallyPrime
Z:Exchange O:Import E: Export M: E-mail P:Print Fi:Help
* F2:Date
Purchase MNo_ 1Apr2d
Supplier Invoice No.: 1234 B 1-Apr-24 Monday | "~ Company

Party Alc name - Ram
Current balance

F4:Contra
Purchase ledger - Purchase

Current balance F5: Payment
Name of Item Quantity Rate per Amount . Receipt

. 10.00 nos 15,000.00 nos  1,50,000.00 "/ */oumal

12.00 nos  1,000.00 nos 12,000.00
Fan 2.00 nos 875.00 nos 1,750.00
Washing Machine 1.00 nos 18,000.00 nos 18,000.00 F10: Other Vouchers
Fridge 1.00 nos 15,000.00 nos 15,000.00
Sealing Fan 2.00 nos  2,500.00 nos 5,000.00
Cooker 2.00 nos  1,200.00 nos 2,400.00 ' H: Change Mode
Cuttle 2.00 nos 18,000.00 nos 36,000.00 |: More Details
Bed 1.00 nos  1,000.00 nos 1,000.00 .
2,41,150.00
9% 3,996.00 L Optional

9% E.996.00]

1:Post-Dated

O:Related Reports

Provide GST/e-Way Bill details

Narration: 33.00 nos 2,49,142.00

X:Cancel Vch F12: Configure

Purchase invoice bill for Ram Company
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CK) Tz — mermms o Grmtom o

Ram
GSTINIUIN : 33ARUPIE415H2ZM
Timte Name ; Tamil Nadu, Code: 33
INVOICE

Party : Purchase with GST

ZA1.15000

2,996.00
2,396.00

EES

Tom| B0 nos ¥ 249, 142.@
“Bmount Chargesbiz (7 viords] =3-ToX
INR Twa Lakh Forty Nine Thousand One Hundred Forty Two Only

for Ram

Result:-

»  To successfully generated in purchase invoice bill.
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Creating a Sales Invoice Bill with GST in Tally Prime

This guide outlines the steps to create a sales invoice with GST in Tally Prime, ensuring

that all GST details are correctly captured for compliance and reporting.

Aim

To create a sales invoice bill that includes GST.

Procedure: Step-by-Step Instructions

1. Open Tally Prime Program
o Launch the Tally Prime software on your computer.
o Click on Continue in Educational Mode if you are using the educational
version.
2. Create a Company
o Press ALT + K to access the Company Menu.
o Select Create (or press ALT + C) to start creating a new company.

3. Enter Company Information
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o Inthe Company Info menu, fill in the necessary company details:
= Company Name: Enter the name of your business.
Address: Input the full mailing address.
Contact Information: Provide phone numbers and email if
needed.
Financial Year Beginning Date: Set the starting date of your
financial year.
Books Beginning Date: Specify the date from which you want to
maintain your books of accounts.
4. Save the Company

o After entering all details, press Ctrl + A to save the company.

Setting Up Ledgers for GST

1. Alter Menu to Create Ledgers

o Go to the Gateway of Tally and select Alter.

o Click on Ledger to create or modify existing ledgers.
2. Create Necessary Ledgers

o Create ledgers required for sales, including:

= Sales Account: This will capture the total sales amount.
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=  GST Output (CGST/SGST/IGST): Create separate ledgers for
output GST, categorized based on applicable rates (e.g., 5%, 12%,
18%, 28%).
o While creating ledgers, ensure to select the correct group:
= Sales Account under Sales Accounts for the sales account.
= Duties & Taxes for GST output ledgers.

o Press Ctrl + A to save each ledger.

Setting Up Stock for Sales

1. Create Stock Group

o From the Gateway of Tally, select Create and then Stock Group.

o Enter the name of the stock group (e.g., "Electronics").

o Press Ctrl + A to save the Stock Group.

2. Create Stock Items
o Select Create and choose Stock Item from the Gateway of Tally.
o For each stock item, enter the following:
= Item Name: Specify the name of the stock item (e.g., "Laptop").

Stock Group: Select the relevant stock group created earlier.
Unit of Measure: Specify the unit (e.g., "nos" for number of
items).

Opening Balance: If applicable, input the opening balance.
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o Press Ctrl + A to save each stock item.
3. Create Units of Measure
o From the Gateway of Tally, select Create and then Unit.
o Define the unit of measure such as "pcs" (pieces), "kg" (kilograms), etc.

o Press Ctrl + A to save the unit.

Creating a Sales Invoice with GST

1. Access Sales Voucher Entry
o From the Gateway of Tally, navigate to Voucher Entry.
2. Change to Item Invoice Mode
o Inthe Voucher Entry screen, press Ctrl + H to switch to Item Invoice
mode.
3. Enter Sales Invoice Details
o Select Sales Voucher.
o Fill in the following details:
= Date: Adjust the date as needed (use F2).
= Party Name: Select or create the ledger for the customer to whom
you are selling.
= |tem Details:
= Select the stock item (e.g., "Laptop™).

= Enter the Quantity.
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= Enter the Rate.
= The system will automatically calculate the Amount.
= GST Details: Ensure to enter the applicable GST percentage
(CGST/SGST/IGST) in the appropriate columns. The system will
compute the GST amount automatically.
4. Save the Sales Voucher
o After entering all necessary details, press Ctrl + A to save the sales

invoice.

Viewing the Sales Invoice Bill

1. Access the Day Book

o From the Gateway of Tally, select Display More Reports.

o Choose Day Book to view all transactions, including the sales invoice.
2. Show the Sales Invoice Bill

o Inthe Day Book, use Ctrl + P to print or view the sales invoice details.

o You can filter the date range if necessary to display the specific invoice.

By following these steps, you have successfully created a sales invoice bill with GST in
Tally Prime. This process helps in maintaining accurate records for GST compliance and

provides a detailed view of sales for better financial management.
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Problem:

1. Sales for 5 Tv @ Rs.20,000

2. Sales for 6 Radio @ Rs.1200
. Sales for 1 Fan @ Rs.900
. Sales for 1 Washing machine @ Rs.19,000
. Sales for 1 Fridge @ Rs.16,000
. Sales for 1 Sealing fan @ Rs.3000
. Sales for 1 cooker @ Rs.1,500
. Sales for 2 cuttle @ Rs.20,000
. Sales for 1 Bed @ Rs.1,200

You are required prepare for Sales invoice bill with GST
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Ledger Report for Ram company

TallyPrime MANAGE
Z:Exchange 0:Import E:Export M:E-mail P:Print Fi:Help
* F2:Date
1-Apr24,
Monday| F3:Company

Party Afc name

Current balance F4:Contra
Sales ledger

Current balance F9:Payment
Name of ltem Quantity Rate per Amount F6:Receipt

5.00 nos 20,000.00 nos  1,00,000,00| " Joumal

6.00 nos  1,200.00 nos 7,200.00
1.00nos  900.00 nos 900.00 F9:Furchase
Washing Machine 1.00 nos 19,000.00 nos 19,000.00 F10:Other Vouchers
Fridge 1.00 nos 16,000.00 nos 16,000.00
Sealing Fan 1.00 nos 3,000.00 nos 3,000.00
Cooker 1.00 nos  1,500.00 nos 1.500.00| H:Change Mode
Cuttle 2.00 nos 20,000.00 nos 40,000.00 1: More Details
Bed 1.00 nos 1,200.00 nos 120000, (. Related Reports
1,88,800.00
9% 4,113.00

9% 4,113.00]

L:Qptional
T:Post-Dated

Provide GST/e-Way Bill details

Narration: 19.00 nos 1,97,026.00

Q:Quit X:Cancel Veh

Sales invoice bill with GST
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